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Chapter 1  

As host, your responsibilities include overall management of the meeting. The 

meeting window provides a forum for you to manage all aspects of the meeting and 

enable participants to chat, send video, share information and interact with each other 

via documents, presentations, whiteboards, applications, and more. 

Some of the most common tasks that you can perform as host are described below: 

  

 

 Edit your welcome message 

(on page 17)  

 Record the meeting (on page 

4) 

 Invite more people  (on page 

5) 

 Remind invitees to join (on 

page 10) 

 Change presenters  (on page 

11) 

 Make someone else the host 

(on page 14) 

 Send a transcript (on page 

19)  

 End the meeting (on page 

20). 

A host can often be a presenter. 

For instructions on presenting 

information, see Sharing Files and 

Whiteboards (on page 217) and 

Sharing Software (on page 243). 

Hosting and Managing a 
Meeting 
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Note: For a more in-depth understanding of how to navigate the meeting window, go to A quick 

tour of the meeting window (on page 21). 

 
 

Interacting with other participants 
After you start or join a meeting, the meeting window opens and on the right side, you 

can see all participants who are in the meeting. As other people join, you will see their 

names appear in the list.  

You can interact with other participants in the meeting in different ways, depending 

on your role: 

  

Role  Task description: 

host Windows  

 

1) View who's in the meeting 

2) Use video to see others and 

have them see you (on page 

181)  

3) Make someone else the 

presenter (on page 12) 

4) Chat with a specific participant 

5) Invite someone else (on page 

5) or remind an invitee (on 

page 10) to join the meeting. 
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Role  Task description: 

participant 

Mac 

 

1) View who's in the meeting 

2) Use video to see others and 

have them see you (on page 

181)  

3) Chat with a specific participant 

  

Note: You can set preferences that assign specific sounds to participant actions, for example, 

when a participant joins or leaves a meeting. To change preferences: 

 Windows: On the Edit menu, choose Preferences. 

 Mac: On the Meeting Center menu, choose Preferences. 

Chatting with Participants in Video Theater Mode 
You can chat with participants from a video thumbnail when you are in full screen 

mode. This feature allows users to chat with participants without navigating to the 

Floating Icon Tray or meeting window. 

To chat with participants from the video theater mode, follow these steps: 

1 Navigate to the attendee's Video you wish to start a chat session.  

2 Select the Chat Icon below the video to start the chat session. 
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Recording your meeting 
Recording a meeting is a great way to share meeting content with invitees who could 

not make the meeting or other interested people. 

To record your meeting: 

  

 

In your meeting window select 

Record located at the top right of 

the meeting window. 

Recording begins immediately. At the end of your meeting the recording is saved to a 

file. For information on accessing and managing your meeting recordings, see 

Managing Meeting Recordings (on page 207). 
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Note: You can stop and restart recording during your meeting, but if you do so, you create 

multiple recording files. To avoid creating multiple files, simply pause and resume the recording 

as necessary. 

 

Inviting more people to your in-progress meeting 
After you start your meeting, you may find that you forgot to invite a stakeholder or 

someone else who should be in the meeting. 

To invite someone after you start your meeting: 

  

 

Select Invite & Remind on the Quick 

Start page. 

The Invite and Remind dialog box appears.  

  

 

You can invite someone to the 

meeting by  

 Email: invite by WebEx or your 

own email. More (on page 8) 

 Phone: Enter the invitee name 

and phone number and select 

Call. More (on page 8)  

 Text message (SMS): Enter 

the invitee mobile number and 

select Send. More (on page 9) 

 IM: Invite by WebEx or your 

own IM. More (on page 6) 
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Inviting people by instant message to a meeting in progress 

You can invite more people to your in-progress meeting by WebEx IM or another 

instant messenger. 

To invite more people using WebEx IM: 

  

Note: Start your WebEx IM if it is not currently running. 

  

 

1) From the Quick Start page, 

open the Invite and Remind 

dialog box. 

2) On the IM tab, select Invite. 

The Invite More dialog box appears. 

  

 

1) Type a screen or domain name for the 

participant 

2) Click the Plus button to add the name to the list 

of participants. 
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To quickly find screen names: 

1 Click the Address Book button to open your address book. 

2 In the Method drop-down list, select IM. 

If the participant is not currently available, you can send an email invitation 

instead. Simple select Email in the drop-down list. 

3 Click Invite. 

Each participant receives an IM message, which includes: 

 A link that the participant can click to join the meeting 

 Meeting topic 

 Meeting start time 

  

Tip: If you invite participants by instant messenger, and your meeting requires a password, 

remember to provide the password to participants. 

To invite more people using another IM: 

  

 

1) Open the Invite and Remind 

dialog box from the QuickStart 

page. 

2) Select Copy at the bottom of 

the dialog box, then paste the 

URL into your own IM and send 

it. 
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Inviting people by email to a meeting in progress 

Each person that you invite receives an invitation email message, which provides 

information about the meeting-including the password, if any-and a link that the 

participantcan click to join the meeting. 

To send an email invitation: 

  

 

1) From the Quick Start page, Open 

the Invite and Remind dialog box. 

2) On the Email tab do one of the 

following: 

 Enter one or more email 

addresses and select Send to 

have WebEx send the 

invitation emails.  

 Click the link to send 

invitations using your own 

email program (MS Outlook 

or Lotus Notes only). 

 

Inviting people by phone to a meeting in progress 

You can invite people by phone to a meeting in progress. 



 Chapter 1: Hosting and Managing a Meeting 

 

9 

 

To invite people by phone: 

  

 

1) From the Quick Start page, 

open the Invite and Remind 

dialog box 

2) On the Phone tab, enter the 

invitee name and phone 

number. 

If the internal call-back 

feature is available and 

enabled for your site, you can 

check the Use an internal 

number check box to enter a 

number that is internal to your 

organization. 

3) Select Call. 

You can speak to the invitee privately, then add the invitee to the general meeting. 

If you are not yet connected to the audio conference, the invitee receives a phone call 

to join the audio conference.  
 

Inviting people by text message (SMS) to a meeting in 
progress 

You can invite people by text message (SMS) to a meeting in progress. This feature 

must be enabled by your site administrator. 
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To invite a person by text message from the meeting: 

  

 

1) From the Quick Start page, open the 

Invite and Remind dialog box.  

2) On the SMS tab, enter the invitee 

mobile phone number. 

3) Select Send. 

Each invitee receives a text message, which includes: 

 A number the invitee can call to join the meeting 

 The account code 

 Meeting topic 

 Meeting start time 

 The host name 

 A reply code to receive a call from the meeting. 
 

Reminding invitees to join your meeting 
After the meeting starts, and you see that some invitees have not yet joined, you can 

send an email reminder. 
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To remind someone to join your meeting: 

  

 

Select Invite & Remind on the 

Quick Start page. 

The Invite and Remind dialog box appears.  

  

 

Select the Remind tab. All invitees 

who are not in the meeting are 

automatically chosen to receive the 

reminder. 

1) Uncheck the box beside any 

person you don't want to 

remind. 

2) Select Send Reminder. 

An email reminder is sent to each person selected. 
 

Changing presenters 
Depending on your site settings, a participant can become the presenter in a number 

of ways: 

 The first person to join automatically becomes the presenter. 

 As host, you can make a participant the presenter before sharing (on page 12) or 

during sharing (on page 13) 
 



Chapter 1: Hosting and Managing a Meeting 

 

12 

 

Making a participant the presenter when you are in the 
meeting window 

During a meeting, you can make any meeting participant the presenter - also referred 

to as passing the ball. Any presenter can also pass the ball to make another meeting 

participant the presenter. 

There are numerous ways to make someone the presenter depending on how you are 

viewing participants. 

Here are a couple of quick ways to make another participant the presenter: 

  

 

If you are viewing a list of participants, do either 

of the following: 

 Drag the ball from the last presenter to the 

next presenter. 

 Choose a name and select Make 

Presenter. 
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If you are viewing participant 
thumbnails, do either of the 
following: 

 Mouse over a thumbnail and select Make 

Presenter. 

 Choose a thumbnail, then select Make 

Presenter. 

 

The participant becomes the presenter with all associated rights and privileges for 

sharing information. 

  

Note: Use the docked tray at the top of your screen to change presenters when you are sharing. 

 

 

Making a participant the presenter when you are sharing 

When you are sharing your desktop, an application, or files in full screen mode, the 

docked tray at the top of your screen provides an easy way to change presenters. 

To make someone else the presenter using the docked tray: 

  

 

 Mouse over the bottom of 

the docked tray to expose 

it. 

 Select Assign, then Make 
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Presenter. 

 Select a participant.  

The participant becomes the presenter with all associated rights and privileges for 

sharing information. 

  

Note: You can make someone else the presenter from the participant list when you are in the 

meeting window. 

 

 

Making someone else the host 
As a meeting host, you can transfer the host role - and thus control of the meeting - to 

a participant at any time. This option can be useful if you need to leave a meeting for 

any reason.  

To make another participant the host: 

1 Do one of the following: 

  

 

 

 Right-click on a participant 

name or thumbnail. 

 Select the Participant menu 

2 Select Host from the Change Role To menu. The selected participant is now the 

host. 

The word (host) appears to the right of the attendee's name in the participant list. 
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Transferring the host role 
As a meeting host, you can transfer the host role - and thus control of the meeting - to 

a participant at any time. This option can be useful if you need to leave a meeting for 

any reason.  

To transfer the host role to a participant: 

1 Optional. If you plan to reclaim the host role later, write down the host key that 

appears on the Info tab in the content viewer in the Meeting window. 

2 In the participant list, select the name of the person to whom you want to transfer 

the host role. 

3 On the Participant menu, choose Change Role To> Host. 

A confirmation message appears, in which you can verify that you want to 

transfer control of the meeting to the participant whom you selected. 

4 Click OK. 

The word (host) appears to the right of the participant's name in the participant list. 
 

Reclaiming the host role 

To take over the role of meeting host: 

If a participant has control of a meeting, you can assume control of the meeting by 

reclaiming the host role. 

  

Important: If you leave a meeting—whether intentionally or inadvertently—and then log back in 

to your meeting service Web site, you automatically become the meeting host once you rejoin the 

meeting. You can rejoin a meeting using either the public meeting calendar or your private 

meeting calendar. 

To reclaim the host role: 

1 In the participant list, select your own name. 

2 On the Participant menu, choose Reclaim Host Role. 

The Reclaim Host Role dialog box appears. 

3 Type the host key in the Host key box. 
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4 Click OK. 

In the participant list, the word (host) appears to the right of your name. 

  

Tip: If you did not write down the host key before transferring the host role to another participant, 

you can ask the current host to send you the host key in a private chat message. The host key 

appears on the current host's Info tab in the content viewer. 

 

Obtaining information about a meeting after it 
starts 

To obtain information about a meeting in progress: 

In the Meeting window, on the Meeting menu, choose Information. 

The Meeting Information dialog box appears, listing general information about the 

meeting, including the: 

 Meeting name or topic 

 Location, or URL, of the Web site where the meeting is taking place 

 Meeting number 

 Teleconferencing information 

 Current host 

 Current presenter 

 Current user-that is, your name 

 Current number of participants 
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Editing a message or greeting during a meeting 
When scheduling a meeting, you can create a message or greeting for participants, and 

optionally specify that the message or greeting automatically appears in participant 

windows once they join the meeting. During a meeting, you can edit the message or 

greeting that you created, or edit the default greeting. 

In your message or greeting, you can welcome the participant to the meeting, provide 

important information about the meeting, or provide special instructions. 

To edit a message or greeting during a meeting: 

1 In the meeting window, on the Meeting menu, choose Welcome Message. 

The Create an Attendee Greeting page appears. 

  

 

 

 

2 Optional. Select the Display this message when attendees join the meeting 

check box. 

The message or greeting automatically appears once the participant joins the 

meeting. 

3 Type a message or greeting in the Message box. 

A message or greeting can contain a maximum of 255 characters. 

4 Click OK. 

  

Note: Participants can view the message or greeting at any time by choosing Welcome Message 

on the Meeting menu. 
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Restricting access to a meeting 
Once a host starts a meeting, the host can restrict access to it at any time. This option 

prevents anyone from joining the meeting, including participants who have been 

invited to the meeting but have not yet joined it. 

To restrict access to a meeting: 

1 In the Meeting window, on the Meeting menu, choose Restrict Access. 

Participants can no longer join the meeting. 

2 Optional. To restore access to the meeting, on the Meeting menu, choose Restore 

Access. 
 

Removing a participant from a meeting 
The meeting host can remove a participant from a meeting at any time. 

To remove a participant from a meeting: 

1 In the Meeting window, open the Participants panel. 

2 Select the name of the participant whom you want to remove from the meeting. 

3 On the Participant menu, choose Expel. 

A confirmation message appears, in which you can verify that you want to remove 

the participant from the meeting. 

4 Click Yes. 

The participant is removed from the meeting. 

  

Tip: To prevent an expelled participant from rejoining a meeting, you can restrict access to the 

meeting. For details, see Restricting access to a meeting (on page 18). 

 

Leaving a meeting 
You can leave a meeting at any time. If you are participating in WebEx audio, or an 

integrated voice conference, Meeting Manager disconnects you from the audio after 

you leave the meeting. 
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To leave a meeting: 

1 In the Meeting window, on the File menu, choose Leave Meeting. 

A confirmation message appears in which you can verify that you want to leave 

the meeting. 

2 Click Yes. 

The Meeting window closes. 

  

Note: If you are the meeting host, first transfer the host role to another participant before leaving 

the meeting. For more information, see Transferring the host role to a participant (on page 15). 

 

Sending a meeting transcript to participants 
You can send a transcript of a meeting to all participants at any time during the 

meeting. The transcript is an email message that contains the following general 

information: 

 Meeting topic 

 Meeting number 

 Meeting starting and ending times 

 URL for the Meeting Information page for the meeting on your meeting service 

Web site 

 List of participants who have joined the meeting (audio-only participants are not 

listed) 

 Meeting agenda 

 Any public notes that you took during the meeting 

You can optionally attach any of the following files to the transcript, if you saved 

them during the meeting: 

 Shared documents 

 Chat 
 

 Poll questionnaire 

 Poll results 
 

 Public notes or closed captions  that you took or that the note taker or closed 

captionist published during the meeting 
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To send a meeting transcript to participants: 

1 In the Meeting window, on the File menu, choose Send Transcript. 

If you have saved any files during the meeting, the Send Transcript dialog box 

appears, allowing you to attach the files to the transcript email message. 

If you have not saved any files during the meeting, a transcript email message 

opens. 

2 If the Send Transcript dialog box appears, select the check box for each file that 

you want to attach to the transcript, and then click OK. 

The transcript email message opens. 

3 Review the email message and make any changes that you want. 

4 Send the email message. 

  

Note: The transcript is sent to all participants who provided their email addresses when joining 

the meeting, whether or not they are still attending the meeting when you send the transcript. 

Audio-only participants will not be listed on the transcript. 

 

For security purposes, a participant who receives a transcript email message cannot see the email 

addresses for the other participants. 

 

The transcript contains notes only if you are the meeting host, the public note taker, or the closed 

captionist, and you have saved the notes to a file. If all participants can take private notes, the 

transcript email message does not include your private notes, and the option to attach your notes 

in a file is not available. 

 

If you saved notes or closed captions to a file, the transcript email message and the attached notes 

file contain the latest version of notes that you saved. 

 

If you are the meeting host and end the meeting-and you have not sent a transcript-a message 

appears, asking you if you want to send a transcript. 

 

Ending a meeting 
Once you end a meeting, the meeting window closes for all participants. If the 

meeting includes WebEx audio, or an integrated voice conference, the audio also 

ends. 

To end a meeting: 

1 In the Meeting window, on the File menu, choose End Meeting. 
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A confirmation message appears, in which you can verify that you want to end the 

meeting. 

2 Optional. If there is any meeting information that you have not yet saved, you can 

save it now - including shared files, chat messages, poll questionnaires, poll 

results, or notes. 

3 Select Yes. 

The Meeting window closes. 

  

Tip: Alternatively, as the meeting host, you can leave a meeting without ending it. Before you 

leave a meeting, you should first transfer the host role to another participant. For more 

information, see Transferring the host role to a participant (on page 15). 

 

A Quick Tour of the Meeting Window 
The Meeting window provides a forum for you to share information and interact with 

participants via documents, presentations, whiteboards, applications, and more. 

You share or view content using the tools in the Meeting window. You can use panels 

to chat, take notes, and perform other tasks. 

When you start or join a meeting, your meeting window opens with the Quick Start 

area on the left and a panel area on the right. Nearly everything you want to 

accomplish in a meeting can be done from these areas:  

  

 

 

Choose an audio device (on 

page 161) for listening and 

speaking 

 
Invite (on page 5) or remind 

(on page 10) people 

 

Share your application (on 

page 244) or desktop (on page 

247) 

 

Share a file (on page 217) or 

browser (on page 249) 

window.  

 
Share a whiteboard (on page 

223) 

 
Record the meeting (on page 

4) 
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Interact with other participants 

(on page 23) 

  

  

  

Note: If you are hosting a meeting that includes TelePresence systems, the following WebEx 

features are unavailable: 

 Recording 

 Polling 

 File Transfer 

 Chat (with TelePresence room participants) 

 

Working with panels 

When your meeting window opens, the area on the right displays some default panels. 

Other panels are available from an icon tray at the top of the panels area.  

  

Windows 

 

 Select the down arrow on the icon 

tray to display the Panels menu.  

 Select an icon from the icon tray to 

open or close a panel. 

 In this example, the Notes and 

Polling panels are collapsed. Select 

the arrow on the title bar to expand or 

collapse the panel.  

Tip: To access panel options, right-

click in the panel title bar.  

  

Mac 

 Select the options icon on the icon 

tray to display the Panels menu. 

 Select an icon from the icon tray to 

open or close a panel. 

 In this example, the Notes  panel is 



 Chapter 1: Hosting and Managing a Meeting 

 

23 

 

 

collapsed. Select the arrow on the title 

bar to expand or collapse the panel.  

Tip: To access panel options, right-

click in the panel title bar.  

 

 

Using panels to interact with other participants 

After you start or join a meeting, the meeting window opens and on the right side, you 

can see all participants who are in the meeting. As other people join, you will see their 

names appear in the list.  

You can interact with other participants in the meeting in different ways, depending 

on your role: 
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Role 

 

What you can do 

Host 

Windows 

 

1) View the list of meeting 

participants 

2) Use video to see others and 

have them see you. 

3) Make someone else the 

presenter 

4) Chat with a specific participant 

or with everyone. 

5) Invite someone else or remind 

an invitee to join the meeting. 

 

Participant 

Mac 

 

 

1) View who is in the meeting 

2) Use video to see others and 

have them see you 

3) Chat with other participants. 
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Managing panels 

You can determine which panels are displayed in the meeting window, and in which 

order they will be displayed: 

To manage the display of panels: 

1 Click this button. 

  

 
 

for Windows 

  

 
 for the Mac 

2 Choose Manage Panels from the menu. 

  

 

 

 Use the Add or Remove buttons 

to specify which panels should 

display in your meeting window. 

 Use the Move Up or Move Down 

buttons to specify the order of the 

panel display. 

 Click the Reset button to restore 

the panel view to the default 

layout. 

 Clear the check box beside Allow 

participants to change the 

sequence of panels if you want 

to permit attendees to manage 

their own display of panels. 

 

 

 

Restoring the panel layout 

If you have closed, expanded or collapsed panels, you can restore the display to the 

layout 
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 you specified in the Manage Panels dialog box. 

 that existed when you first joined the meeting (if you did not specify a layout via 

the Manage Panels dialog box) 

To restore the panel layout: 

1 Click this button. 

  

 
 

for Windows 

  

 
 for the Mac 

2 Choose Restore Layout. 
 

Accessing panel options 

Each panel provides a menu of commands related to the panel. For example, Expand 

Panel and Close Panel are two common commands for all the panels. 

Depending on what operating system you are using, access the commands for a panel 

by following these steps: 

 Windows—Right-click the panel title bar to see a menu of commands related to 

the panel.  

 Mac—Select ctrl and then click to see a menu of commands related to the panel. 

  

Panels with 
options Options 

Participants Sound Alerts: Lets you choose a sound to play when a participant: 

 Joins a meeting 

 Leaves a meeting 

 Selects the Raise Hand icon on the Participants panel. 

Assign Privileges: Displays the Participant Privileges dialog box.  

Chat Sound Alerts: Lets you choose the kinds of chat messages for which you want 

a sound to play. Select a sound from the drop-down list or click Browse to find a 

sound in a different location on your computer. 

Assign Privileges: Displays the Participant Privileges dialog box.  
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Panels with 
options Options 

Notes Notes: Displays the Meeting Options dialog box, where you can set note-taking 

options as well as other options 

 Allow all participants to make notes: Lets all participants take their own 

notes during the meeting, and save them to their computers. 

 Single note taker: Lets only one participant take notes during the meeting. 

By default, the host is the note-taker, but can designate another participant 

as the note-taker during the meeting. A note-taker can publish notes to all 

attendees at any time during the meeting. The host can send a transcript of 

the notes to participants at any time. 

 Enable Closed Captioning: Lets only one participant-the closed captionist-

take notes during the meeting. 

 

 

 

Resizing the content viewer and panels area 

When you are sharing a document or presentation, you can control the size of the 

content viewer by making the panel area narrower or wider. 

  

Note: This feature is unavailable when you are sharing your desktop, an application, or a Web 

browser. 

To change the size of the content viewer and panels: 

Click the dividing line between the content viewer and the panels. 

 Drag the line to the left to make the area devoted to the panels wider. 

 Drag the line to the right to make the content viewer larger. 
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For details about hiding, minimizing, and closing the panels, see Accessing panels in 

full-screen view. 
 

Accessing panels from the Meeting Controls Panel 

While you are sharing a document in full-screen view, or sharing an application, 

desktop, or Web browser, you can access panels from the Meeting Controls Panel:  

  

 

  

Control  

 Displays icons for working with attendees 

 
Displays a maximum of 4 panel icons. You can open any remaining panels from the 

menu that appears when you select the down arrow. 

 
Stops sharing and returns to the Meeting window 

 

Provides access to meeting controls and panels that are not usually displayed on 

the Meeting Controls Panel, such as Polling and Notes.  

 
Displays the Participants panel 
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Control  

 
Displays the Chat panel 

 
Displays the Annotation Tools panel 

 
Displays the Recorder panel 

 

Viewing Panel alerts 

You will see an orange alert if a panel is collapsed or closed and requires your 

attention. 

Some reasons for seeing alerts: 

 A participant arrives or leaves a meeting 

 A participant starts or stops sending video 

 A Raise Hand indicator appears in the Participants list 

 The note taker publishes notes 

 An participant sends a chat message 

 A poll opens or closes 

 Poll answers are received 

For example, if a participant joins or leaves your meeting, and you have collapsed or 

closed the participant panel, the following table shows you different ways you can be 

alerted.  

  

Participants panel alerts ways to see alerts 

Windows 

 

 

Meeting window-panel is closed 
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Participants panel alerts ways to see alerts 

Mac 

 

 

Windows 

 

Mac 

 

Meeting window-panel is collapsed 

Windows 

 

Mac 

 

Meeting Controls Panel (during sharing)-

panel is closed  

The panel remains in the alert status until you open and view the change. 
 

Renaming a call-in user 

When call-in users join a meeting, their names may appear in the Participants panel as 

numbered callers (for example, Call-in User_3). 

  

Note: Participants can rename a call-in user in their own Participants panels. However, when the 

host renames a call-in user, the change will propagate to all participants automatically. 

To rename a call-in user within the Participants panel: 

1 Right-click the call-in user's assigned name and select Rename. 
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2 Enter the participant's name. 

  

 

 

3 Select Enter to change the name in the Participants panel. 
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Chapter 2  

Accessing the Meeting window using the 
keyboard 

Windows operating system participants who have special needs, or who are power 

users, can navigate around the Meeting window using keyboard shortcuts. Some of 

these shortcuts are standard in the Windows environment. 

  

Press to 

F6 Switch between Meeting window areas (on page 34) 

Ctrl+Tab  Switch between open documents (on page 34) in the content area 

 Navigate within the panels area (on page 35) 

 Switch between tabs in the Invite and Remind dialog box and the 

Preferences dialog box (on page 37) 

Shift+F10  Use right-click menus (on page 36) 

 Work with the participant list (on page 37) 

 Copy text from the Chat panel (on page 41) 

Tab Switch between elements (on page 38), such as buttons, fields, and 

check boxes within a dialog or panel 

Arrow keys Switch between options in dialog boxes (on page 39) 

Alt+F4 Close any dialog box (on page 43) 

Spacebar  Check or uncheck an option box (on page 41) 

 Enter text in an input box (on page 42) 

Enter Carry out the command for the active button (on page 44) (usually 

replaces a mouse click) 

Ctrl+A Copy text from the Chat panel (on page 41) 

Ctrl+Alt+Shift Show the Meeting Controls Panel (on page 45) in full-screen mode 

Ctrl+Alt+Shift+H Hiding the Meeting controls, panels, and notifications (on page 46) 
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Navigating between Meeting window areas 

Select F6 to switch between the content area and the panels area. 

  

 

 

 

 

Navigating between open documents 

Select Ctrl+Tab to switch between open documents in the content area of the 

Meeting window. 
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Navigating the panels area 

The panels area contains: 

 the panel icon tray from which you can select panels to open or close 

 any panels that are currently open 
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Select Ctrl+Tab to switch between the panels 

icon tray and any open panels. 

To navigate within the panels icon tray: 

  

 

 Select Tab to navigate from one icon to 

the next. 

 Using the spacebar and Enter keys open 

and close a panel. 

 When focused on the drop-down menu 

arrow, use the spacebar or down arrow 

keys to open the drop-down menu. 

 Select Esc to dismiss the drop-down list. 

 

Using right-click menus 

Currently you can use the shortcut keys Shift+F10 to open the right-click menu in the 

following panels and elements: 

 Participant panel 

 Chat panel 

 Notes panel 

 Closed Captions panel 

 File Transfer window 
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 Shared whiteboard and file tabs 
 

Working with the participant list 

The participant panel provides a right-click menu that allows you to act upon a 

participant depending on your role in the meeting.  

 If you are the host or presenter, you can perform actions such as making someone 

else the presenter; or muting another participant's microphone if it is too noisy. 

 If you are not the host or presenter, you can perform actions such as asking to 

become the presenter or muting your own microphone. 

  

 

 Use the up and down 

arrow keys to navigate 

between participants. 

 Select Shift+F10 to 

open the right-click 

menu on a specific 

participant. 

 

Switching between tabs in dialog boxes 

Currently you can use the shortcut keys Ctrl+Tab to switch between tabs in the 

following dialog boxes: 

 Invite and Remind 

 Preferences 

 Meeting Options 

 Participant Privileges 

  

Note: You can also use Ctrl+Tab to navigate between open documents (on page 34) in file 

sharing and navigate between panels (on page 35) in the meeting window. 
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Switching between elements in dialog boxes or panels 

When you open a dialog box or a panel, you can switch between the elements using 

the Tab key. Each dialog box or panel will have an initial focus area from which you 

can begin navigating. 

For example, if you open the Audio Conference dialog box, here is how the Tab key 

guides you through the elements: 

  

 

 The first time the Audio Conference 

dialog box opens, the initial focus is 

on Use Phone. 

 Continually selecting Tab moves the 

focus through the elements, and 

eventually back to Use Phone. 

When the focus is on an element that can be expanded, or a drop-down box, select 

Enter to expand and view the information. 

  

 

 If you have expanded a drop-down 

box, use the down arrow key to 

move the focus through the drop-

down list of options. 

 Select Esc to dismiss the drop-

down list. 



 Chapter 2: Hosting and Managing a Meeting 

 

39 

 

Tab order 

For dialog boxes with multiple sections, use Tab key to navigate through the options. 

The order of navigation is through one section at a time, going from top-to-bottom 

and then left-to-right. 

  

 

 

 

Note: If you focus on a button, and then want to click it, simply select Enter. 

 
 

Switching between options in dialog boxes 

When you open a dialog box or a panel, you can switch between options using the 

Arrow keys. Each dialog box or panel will have an initial focus area from which you 

can begin navigating. 

Here are some examples. 
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Use the Up and Down 

Arrows to move between 

the options. 

Within an option, use the 

Tab key. 

  

 

Use the Up and Down 

Arrows to navigate file 

types when sharing web 

content. 

  

 

Use the Left and Right 

Arrows to adjust volume 

when using your computer 

for audio. 
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Note: If you focus on a button, and then want to click it, simply select Enter. 

 

 

Checking and unchecking option boxes 

Use the spacebar to check and uncheck option boxes.  

In the following example, the option Remember phone numbers on this computer 

is checked.  

  

 

if you don't want this 
option checked: 

1) Navigate to the check box 

using the Tab and down arrow 

keys as required. 

2) Select the spacebar to  

uncheck the box. 

 

Copying text from the Chat panel 

The Chat panel provides a right-click menu that allows you to copy text from the Chat 

history area.  
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 With the focus on the 

Chat history area, select 

Shift+F10 to open the 

right-click menu. Use 

this function to copy text 

or to select all text. 

Alternatively, you can 

use Ctrl+A to select all 

the chat text. 

 To select only a portion 

of the text, move your 

cursor with the arrow 

keys and then use 

Shift-[Arrow] to 

highlight text.  

 
 

Entering text in an input box 

Want to enter text in an input box? Here is how you would answer questions in a poll. 
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 Navigate between questions 

using the Tab key. 

 Move between answers using 

the Up and Down Arrow keys. 

 Move the cursor to focus on the 

text input area and use the 

Spacebar or Enter key so you 

can type your answer. Click 

Enter or Esc to finish editing. 

 
 

Closing dialog boxes 

Select Alt+F4 to close a dialog box. 
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Selecting Alt+F4 is just like 

selecting the "x" on any dialog 

box. 

 

Activating an option or button 

When the focus is on an active option or button, select Enter to activate it. 



 Chapter 2: Hosting and Managing a Meeting 

 

45 

 

  

 

Selecting Enter is 

the same as using 

a mouse click. 

 

Accessing the Meeting Controls Panel during sharing 

During sharing the Meeting Controls Panel is partially hidden at the top of your 

screen: 

  

 
 

Enter Ctrl+Alt+Shift to show the panel. 

  

 

 

After the panel is displayed, the initial focus is on the Participants icon.  

 Use Tab to change focus  

 Use Enter to activate a feature 

To return to the sharing area from the Meeting Controls Panel, select the Alt+Tab 

keys as you would in any Windows application to switch between items:  

 If you are sharing a file, select the WebEx ball to return to the sharing area. 

 If you are sharing an application, select the application to return focus to it. 

 If you are sharing your desktop, select the application you want to share. 
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Note: To switch from the Meeting Controls Panel to another open panel, such as the participant 

list, enter F6. 

 

 

Hiding the Meeting controls, panels, and notifications 

Select Ctrl+Alt+Shift+H to open the dialog box from which you can hide the 

Meeting Controls Panel, all other panels, and all notifications. 

  

 

Available to all 

participants during 

Desktop Share and 

Application Share, 

and in Full Screen 

mode. 

 

Screen reader support 
Cisco WebEx supports JAWS screen reading software for the following elements: 

  

 Application menus and drop-down menus 

 Shared file titles and tab titles 

 Quick Start page buttons, button titles, and tooltips 

 Panel and Panels tray buttons, button titles, and tooltips 
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Annotation panel and toolbars 

 

Shared Meeting window content 

area toolbars 
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Meeting Controls Panel buttons, 

button titles, and tooltips 
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Chapter 3  

  

If you want to... See... 

get an overview of joining a meeting About joining a meeting 

join a meeting from an instant message Joining a meeting from an instant message 

(on page 50) 

join a meeting from an email invitation Joining a meeting from an email invitation (on 

page 51) 

join a meeting from the meeting calendar Joining a meeting from the meeting calendar 

(on page 52) 

join a meeting from the host's personal 

meeting page 

Joining a meeting from the host's personal 

page (on page 53) 

join a meeting if the meeting is not listed on 

the calendar or on the host's personal 

meeting page 

Joining a meeting using the meeting number 

(on page 53) 

obtain information about a meeting, such as 

its agenda and meeting number 

Obtaining information about a scheduled 

meeting (on page 59) 

add a scheduled to your calendar program, 

such as Microsoft Outlook 

Adding a meeting to your calendar program 

(on page 62) 

register for a meeting Registering for a meeting (on page 56) 

 

About joining 
You can join a meeting in a number of ways. The simplest and quickest is by clicking 

the meeting URL, which the host can send you via an invitation email message or an 

instant message. 

Joining a Meeting 
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If the host has given you just the meeting number, you have a couple of ways to join 

the meeting. For details, see Joining a meeting using the meeting number (on page 

53). 

  

Notes:  

 The meeting host may choose to record the meeting. 

 If you are the host but you inadvertently land on the page for participants to join the a meeting, 

click If you are the host, start your meeting. 

 If you are the participant but you inadvertently land on the page for the host to start the a 

meeting, click If you are not the host, join as a participant.  

 

About the Join Meeting page 

To access this page: Click the meeting link in your invitation email message, and then 

click Join Now. 

When joining a meeting, you may need to enter some details on the Join Meeting 

page: 

 Your name: Enter the name you want attendees to use to identify you during the 

meeting. 

 Email address: Enter your email address, in this format: name@your_company. 

For example, msmith@company.com. 

 Meeting password: Enter the meeting password. The meeting host may have 

included the password in the email invitation or, for security reasons, provided it 

to you in another way. If the meeting does not require a password, the text box 

does not appear on this page. 
 

Joining a meeting from an instant message 

1 From the instant message window, click the link to join the meeting. 
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2 On the Meeting Information page, enter the requested information. 

For instance, you may be asked to enter the meeting password. 

3 Click Join Now. 

The Meeting window appears. 
 

Joining from an email invitation 

If you received an email invitation to a meeting, you can join the meeting by clicking 

a link in the invitation. 

  

Note: As you fill in the information requested, you may also be asked to type your username and 

password. This page appears only if the meeting host requires that you have a user account to 

attend the meeting. 

To join a listed meeting from an invitation email message: 

1 Open your email invitation, and then click the link. 

2 On the Meeting Information page, enter any requested information. 

For details, see About the Join Meeting page (on page 50). 

3 Click Join Now. 

The Meeting window appears. 
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Note: If you did not receive an email invitation to a meeting, you can also join a meeting directly 

from your Meeting Center Web site or from the host's Personal Meeting Room page. For details, 

see Joining a meeting from the meeting calendar (on page 52) or Joining a meeting from the 

host's personal page (on page 53) 

 

Joining from the Meeting Center calendar 

If you do not have an email invitation for a meeting, you can join it from the meeting 

calendar, if the meeting host has listed it there. 

To join a meeting listed on the meeting calendar: 

1 On the navigation bar, expand Attend a meeting, and then click Browse 

Meetings. 

The Browse Meetings page appears. 

2 On the meeting calendar, locate the meeting that you want to attend. 

Tips for quickly finding a meeting: 

 Select a view of the meeting calendar by clicking one of the following tabs: 

Today, Daily, Weekly, or Monthly. For more information about calendar 

views, see Viewing the meeting calendar. (on page 66) 

 Sort a meeting list by clicking the column headings. For details, see Sorting 

the meeting calendar. (on page 69) 

 View a meeting list for another date. For details, see Selecting a date on the 

meeting calendar (on page 67) 

 Search for a meeting. For details, see Searching for a meeting on the meeting 

calendar (on page 69). 

3 Under Status, click Join. 

4 On the Meeting Information page, enter any requested information. 

5 Click Join Now. 

The Meeting window appears. 

  

Tip:  

 You can obtain detailed information about a selected meeting or its agenda before joining it. 

For details, see Obtaining information about a scheduled meeting (on page 59). 

 You can display all meeting times in another time zone. 
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 You can refresh the meeting calendar to ensure that you are viewing the most recent 

information. 

 

Joining a meeting from the host's personal page 

You can join a meeting from the host's Personal Meeting Room page if the host has 

listed it there. 

To join a listed meeting from the host's Personal Meeting Room page: 

1 Go to the URL, or Web address, for the host's Personal Meeting Room page. The 

host must provide you with this URL. 

2 On the Meetings tab and under Meetings in Progress, locate the meeting that you 

want to join. 

3 Under Status, click Join. 

4 On the Meeting Information page, enter any requested information 

5 Click OK. 

The Meeting window appears. 

  

Tip: If the meeting is not in progress, you cannot join the meeting. To check whether the host has 

started the meeting, you can periodically click the Refresh button on the page. 

 

 

Joining a meeting using the meeting number 

If the meeting host has not included a link to the meeting on the meeting calendar or 

on his or her Personal Meeting page, you can still join that meeting. You need to 

obtain the meeting number from the meeting host. 

You can join a meeting by providing the meeting number on either: 

 Your Meeting Center Web site, see Joining a meeting from your Meeting Center 

Web site using the meeting number (on page 54). 

 The host's Personal Meeting page on your Meeting Center Web site, if the host 

gave you the URL (Web address) for the page, see Joining a meeting from the 

host's personal page using the meeting number (on page 54).  
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Joining a meeting from the host's personal page using the 
meeting number 

If you want to attend a meeting that is not on the host's Personal Meeting Room page, 

you can still join that meeting. Simply ask the host for the meeting number. 

To join a meeting from the host's Personal Meeting Room page: 

1 Go to the URL, or Web address, for the host's Personal Meeting Room page. The 

host must provide you with this URL. 

2 On the Meetings tab and under Join an Unlisted Meeting, type the meeting 

number that the host gave to you in the Meeting number box. 

3 Click Join Now. 

4 On the Meeting Information page, enter the requested information. 

For details, see About the Join Meeting page (on page 50). 

5 Click Join Now. 

The Meeting window appears. 
 

Joining a meeting from your Meeting Center Web site using 
the meeting number 

If the meeting you want to attend is not listed on the meeting calendar, you can still 

join the meeting. You just need to know the meeting number, which the meeting host 

can give you. 

To join an unlisted meeting from your Meeting Center Web site: 

1 On the navigation bar, expand Attend a meeting, and then click Unlisted 

Meeting. 

The Join an Unlisted Meeting page appears. 

2 In the Meeting number box, type the meeting number that the host gave to you. 

3 Click Join Now. 

4 On the Meeting Information page enter any requested information. 

5 Click Join Now. 

The Meeting window appears. 
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Joining a meeting from your iPhone 

If you receive an invitation to a meeting on your iPhone, you can join the meeting by 

tapping the link in the invitation or from the Meet icon on your iPhone's home page.  

To join a meeting from an email invitation link:  

In your email invitation, tap the meeting link. 

The WebEx Meeting Center application launches. 

To join a meeting from your Meet icon: 

Open your home page, and tap the Meet icon. 

The WebEx Meeting Center application launches. 

  

Note: If you have a WebEx account, we recommend that you sign in and save your account 

settings so you can join meetings quickly in the future.  

For detailed information about all aspects of using your iPhone to start or attend 

meetings, visit our website http://www.webex.com/apple/. 

  
 

Joining a meeting from your BlackBerry device 

If you have no WebEx account, join a meeting in one of these ways: 

 Start the WebEx Meeting Center application and then select Join Now on the 

welcome screen. 

 Select the appropriate link in your email invitation or the meeting item on your 

calendar. 

If you have a WebEx account, follow these steps to join a meeting: 

1 Start the WebEx Meeting Center application. 

2 Sign in to your WebEx account if you have not signed in or saved your account 

settings. 

We recommend that you save your account settings to join meetings quickly in 

the future. 

3 Select the meeting on the My Meetings page. 

http://www.webex.com/apple/
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4 Select Join Meeting on the menu. 
 

Registering for a meeting 
  

If you want to... See... 

get an overview of registering for a meeting About registering for a meeting (on page 56) 

register for a meeting from an invitation email 

message 

Registering from an email message (on page 

56) 

register for a meeting from the meeting 

calendar on your Meeting Center Web site 

Registering from the meeting calendar (on 

page 57) 

register for a meeting from the host's 

Personal Meeting Room page 

Registering from the host's personal page (on 

page 58) 

 

About registering for a meeting 

If a meeting host invites you to a meeting that requires registration, you receive an 

invitation email message. The email message contains a link that you can click to 

register for the meeting. 

If you did not receive an email invitation to a meeting that requires registration, you 

can register for the meeting on either: 

 The meeting calendar on your Meeting Center Web site 

 The host's Personal Meeting Room page on your Meeting Center Web site, if the 

host gave you the URL, or Web address, for the page 

 Registering from an email message 

 Registering from the meeting calendar 

 Registering from the host’s personal page 

 Obtaining information about a scheduled meeting 
 

Registering from an email message 

If you received an invitation email message for a meeting that requires registration, 

you can register for the meeting from the message. 
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To register for a meeting from an invitation email message: 

1 Open your invitation email, and then click the link to register for the meeting. 

2 On the Meeting Information: [Topic] page that appears, click Register. 

The Register for [Topic] page appears. 

3 Provide the required information. 

4 Click Register Now. 

Once the host approves your registration, you receive a registration confirmation 

email message. You can then join the meeting once it starts. 

If the meeting is already in progress, and the host has chosen to approve all 

registration requests automatically, you join the meeting immediately. 
 

Registering from the meeting calendar 

If you did not receive an invitation email message for a meeting that requires 

registration, you can register for it from the meeting calendar on your Meeting Center 

Web site. 

To register for a meeting from the meeting calendar: 

1 On the navigation bar, expand Attend a meeting, and then click Register. 

The Register for a meeting page appears, showing the meeting calendar. This 

calendar lists each meeting that requires registration for the current date.  

2 On the meeting calendar, locate the meeting for which you want to register. 

To locate a meeting quickly, you can: 

 Sort the meeting list by clicking the column headings. For details, see Sorting 

the meeting calendar (on page 69). 

 Display the meeting list for another date. For details, see Selecting a date on 

the meeting calendar (on page 67).  

 Find a a meeting. For details, see Searching for a meeting on the training 

meeting (on page 69). 

3 Under Topic, select the option button for the meeting for which you want to 

register. 

4 Click Register. 

5 On the Register for [Topic] page that appears, provide the required information. 
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6 Click Register Now. 

Once the host approves your registration, you receive a registration confirmation 

email message. You can then join the meeting once it starts. 

If the meeting is already in progress, and the host has chosen to approve all 

registration requests automatically, you join the meeting immediately. 

  

Tip:  

 You can obtain detailed information about a selected meeting or its agenda before registering 

for it. For details, see Obtaining information about a scheduled meeting (on page 59). 

 You can display all meeting times in another time zone. 

 You can refresh the meeting calendar to ensure that you are viewing the most recent 

information. 

 

 

 

Registering from the host's personal page 

You can register for a meeting from the host's Personal Meeting Room page on your 

Meeting Center Web site. 

To register for a meeting from the host's Personal Meeting Room page: 

1 Go to the URL, or Web address, for the host's Personal Meeting Room page. The 

host must provide you with this URL. 

2 On the Meetings tab, do one of the following: 

 If the meeting is not currently in progress, under Scheduled Meetings, click 

Register. 

 If the meeting is currently in progress, under Meetings in Progress, click 

Join Now. On the Join Meeting: [Topic] page that appears, click Register. 

3 If the Log In page appears, provide your user name and password, and then click 

Log In. 

The Log In page appears only if the meeting host requires that you have a user 

account to join the meeting. In this case, you must provide your user name and 

password before you can register for the meeting. 

4 On the Register for [Topic] page that appears, provide the required information. 

5 Click Register Now. 
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Once the host approves your registration, you receive a registration confirmation 

email message. You can then join the meeting once it starts. 

If the meeting is already in progress, and the host has chosen to approve all 

registration requests automatically, you join the meeting immediately. 
 

Obtaining information about a scheduled 
meeting 

  

If you want to... See... 

get an overview of obtaining information 

about a scheduled meeting 

About obtaining meeting information (on page 

59) 

obtain meeting information from an invitation 

email message 

Obtaining information from an email message 

(on page 60) 

obtain meeting information from the host's 

Personal Meeting Center Room page 

Obtaining information from the host's 

personal page (on page 61) 

 

About obtaining meeting information 

Before joining a meeting, you can obtain information about it from the Meeting 

Information page. The information you can view includes the host's name and email 

address, meeting number, and agenda.If you received an email invitation to a meeting, 

you can click a link in the message to view the meeting information. 

If you did not receive an email invitation from the host, you can view the meeting 

information from either: 

 The meeting calendar on your Meeting Center Web site 

 The host's Personal Meeting Room page on your Meeting Center Web site, if the 

host gave you the URL, or Web address, for the page. 
 

About the Meeting Information page 

To access this page: In your invitation email message, click the appropriate link. 

The Meeting Information: [Topic] page provides information about a selected 

meeting. The following is a description of the information you can view from that 

page. 
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Term Details 

Status Status of the meeting can be: Not Started, Join 

Now, or Registration (Meeting Center only). 

Date Date of the meeting—for example, July 28, 2009. 

Starting time Starting time for the meeting, including the time 

zone—for example, 10:00 am, Pacific Standard 

Time. 

Duration Length of the meeting in hours or minutes—for 

example, 1 hour or 30 minutes. 

Meeting number Number that the meeting server assigns to a 

meeting automatically. 

Meeting password Meeting password that the host specified. 

Teleconference Instructions for joining the teleconference, if the 

host included one for the meeting. 

Host Meeting host’s full name. 

Alternate host Appears only if the host designated one or more 

participants as alternate hosts. 

Host’s email address Host's email address. 

Agenda Agenda:  Displays the Agenda page, 

where you can view the meeting's detailed 

agenda provided by the host. 

Add to My Calendar Adds the meeting to your calendar program, such 

as Microsoft Outlook. Your calendar program 

must support the iCalendar standard, a common 

format for exchanging calendaring and scheduling 

information across the Internet. 

 

 

 

Obtaining information from an email message 

If you receive an email invitation for a meeting, you can view the meeting 

information from the email message. 
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To obtain information about a meeting from an invitation email message: 

1 Open your invitation email message, and then click the link. 

The Meeting Information appears. 

2 Optional. To view the meeting agenda, click View Agenda. 
 

Obtaining information from the meeting calendar 

If you did not receive an email invitation, you can obtain meeting information from 

the meeting calendar on your Meeting Center Web site. 

To obtain information about a meeting from the meeting calendar: 

1 From the navigation bar on your Meeting Center Web site, expand Attend a 

meeting. 

2 Click Browse Meetings. 

3 On the meeting calendar, locate the meeting about which you want to obtain 

information. 

4 Under Topic, click the link for the meeting. 

If the meeting requires a password, the Get Info page appears. 

If the meeting does not require a password, the Meeting Information page appears. 

You can skip to step 6. 

5 If the Get Info page appears, type the password that the meeting host gave to you 

in the Meeting password box, and then click OK. 

6 Optional. To view the meeting's agenda, click View Agenda. 

The Agenda page appears. 
 

Obtaining information from the host's personal page 

You can obtain meeting information from the host's Personal Meeting Room page on 

your Meeting Center Web site. 

To obtain meeting information from the host's Personal Meeting Room page: 

1 Go to the URL, or Web address, for the host's Personal Meeting Room page. The 

host must provide you with this URL. 
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2 On the Meetings tab, locate the meeting about which you want to obtain 

information. 

3 Under Topic, click the link for the meeting. 

If the meeting requires a password, the Get Info page appears. 

If the meeting does not require a password, the Meeting Information page appears 

4 If the Get Info page appears, type the password that the meeting host gave to you 

in the Meeting password box, and then click OK. 

5 Optional. To view the meeting's agenda, click View Agenda. 
 

Adding a meeting to your calendar program 
  

If you want to... See... 

get an overview of adding a scheduled 

meeting to your calendar program 

About adding a meeting to your calendar 

program (on page 62) 

add a scheduled meeting to your calendar 

program 

Adding a meeting to your calendar program 

(on page 62) 

 

About adding a meeting to your calendar program 

You can add a scheduled meeting to your calendar program, such as Microsoft 

Outlook. This option is applicable only if your calendar program supports the 

iCalendar standard, a common format for exchanging calendaring and scheduling 

information across the Internet. 

You can add a meeting to your calendar from either: 

 The invitation email message that you receive from the host 

 The Meeting Information page for the meeting, which you can access by clicking 

the link for the meeting on the meeting calendar or on the host's Personal Meeting 

Room page 
 

Adding a meeting to your calendar program 

You can add a scheduled meeting to your calendar program if your calendar program 

supports the iCalendar standard. 
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To add a scheduled meeting to your calendar: 

1 Do one of the following, as appropriate: 

 In the invitation email message that you receive, click the link to add the 

meeting to your calendar. 

 On the Meeting Information page for the meeting, click Add to My 

Calendar. 

A meeting item opens in your calendar program. 

2 Accept the meeting request. For example, in Outlook, click Accept to add the 

meeting item to your calendar. 

  

Note: If the host cancels the meeting, the cancellation email message that you receive contains an 

option that lets you remove the meeting from your calendar program. 

 

 





 

4 
 

 

65 

 

Chapter 4  

  

If you want to... See... 

get an overview of using the calendar About the meeting calendar (on page 65) 

view the meeting calendar Viewing the meeting calendar (on page 66) 

select a date on the meeting calendar Selecting a date on the meeting calendar (on 

page 67) 

search for a Meeting on the meeting 

calendar 

Searching for a meeting on the meeting 

calendar (on page 69) 

sort the meeting calendar Sorting the meeting calendar (on page 69) 

refresh the meeting calendar Refreshing the meeting calendar (on page 70) 

select a language and time zone on the 

meeting calendar 

Selecting a language and time zone on the 

meeting calendar (on page 70) 

register for a meeting from the meeting 

calendar 

Registering for a meeting from the meeting 

calendar (on page 71) 

 

About the meeting calendar 
The public meeting calendar on your Meeting Center Web site provides information 

about each listed meeting that is either scheduled or in progress. However, the 

meeting calendar does not provide information about any unlisted meeting. 

You can navigate the meeting calendar to quickly find a listed meeting - either on the 

current date or any date - using one of several calendar views. For example, you can 

view a meeting list for today's date only or for an entire month. 

Using the Calendar 
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When viewing a meeting list, you can sort the list and refresh it at any time. 
 

You can view a list of meetings that require registration. 
 

 

Viewing the meeting calendar 
You can open one of the following calendar views of all listed meetings: 

  

Today Contains a list of meetings occurring on the current date, including 

all meetings currently in progress and all scheduled meetings that 

are not yet in progress. 

Daily Contains a single list of all meetings occurring on the current date, 

or on another date to which you have navigated. 

Weekly Contains a list of scheduled meetings for each day of the selected 

week. 

Monthly Indicates on which dates meetings are scheduled for the selected 

month. 
 

To open a calendar view of all scheduled meetings: 

1 On the navigation bar, expand Attend a meeting to view a list of links. 

2 Click Browse Meetings. 

The meeting calendar appears. 

3 Click the tabs to navigate to different views of the meeting calendar. 

You can also view a list that includes past meetings. 
 

You can view a list of meetings that require registration. 
 

To include past meetings in your list of meetings: 

1 Select the Today or Daily tab. 

2 Select the Show past meetings check box. 

The list of meetings displays accordingly for the tab. 
 

To display a list of only meetings that require registration: 

1 Select the Today, Upcoming, Daily, or Weekly tab. 

2 Select the Show only meetings that require registration check box. 
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The list of meetings that require registration displays accordingly for the tab. 
 

 

Selecting a date on the meeting calendar 
You can view a list of scheduled meetings for any date on the meeting calendar. 

 

To display a list of scheduled meetings for the previous or next day: 

1 If you have not already done so, open the meeting calendar. For details, see 

Viewing the meeting calendar (on page 66). 

2 On the Daily view of the calendar page, click the forward or backward arrow to 

navigate to the list of meetings for the next or previous day. 

  

 
 

 

 

For details about the options on the Daily view, see About the Daily view (on page 

74). 
 

  

Note: You can use this procedure on the Register for a Meeting page as well.  

 
 

To display a list of meetings for a specific date: 

1 If you have not already done so, open the meeting calendar. For details, see 

Viewing the meeting calendar (on page 66). 

On the Today, Upcoming, Daily, or Weekly tab on the calendar page, click the 

Calendar icon. 

  

 
 

 

The Calendar window appears, showing the calendar for the current month. 

2 Optional. Do any of the following: 

 To view the calendar for the previous month, click the forward arrow. 

 To view the calendar for the next month, click the backward arrow. 

 To view the calendar for a specific month, in the drop-down list, select a 

month. 

 To view the calendar for a specific year, in the drop-down list, select a year. 
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3 Click the date for which you want to view a list of meetings. 

The Daily view for the date that you selected appears. 

For details about the options on the view tabs, see the following: 

 About the Today view (on page 72) 

 About the Daily view (on page 74) 

 About the Weekly view (on page 76) 
 

  

Note: You can use this procedure on the Register for a Meeting page as well.  

 
 

To display a list of meetings for a specific date using the Monthly view: 

1 If you have not already done so, open the meeting calendar. For details, see 

Viewing the meeting calendar (on page 66). 

2 Click the Monthly tab. 

3 Click the forward or backward arrow to navigate to the list of meetings for the 

next or previous month. 

  

 
 

 

 

4 Click a date for which you want to view a list of scheduled meetings. 

The Daily view appears for the date that you selected. 

  

Note: Only dates on which an icon appears have at least one scheduled meeting.  
 

For details about the options on the Monthly view, see About the Monthly view (on 

page 77). 
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Searching for a meeting on the meeting calendar 
On the meeting calendar, you can locate a meeting by searching for text in the name 

of the host or presenter, meeting topic, or meeting agenda.  You cannot search for a 

meeting number. 
 

To search for a meeting: 

1 If you have not already done so, open the meeting calendar. For details, see 

Viewing the meeting calendar (on page 66). 

2 Type the text for which you want to search in the Search for box. 

3 Click Search. 

The Search Results page appears, listing all meetings that contain the search text. 
 

Sorting the meeting calendar 
By default, meeting lists on the meeting calendar are sorted by hours, in ascending 

order. However, you can sort the meeting lists by any column: 

  

Time Sorts the meeting list by hours, in ascending or descending order. 

Topic Sorts the meeting list alphabetically by topic, in ascending or 

descending order. 

Host or Presenter Sorts the meeting list alphabetically by host or presenter name, in 

ascending or descending order. 

Duration Sorts the meeting list by duration, in ascending or descending 

order. 
 

To sort the public meeting calendar: 

1 If you have not already done so, open the meeting calendar. For details, see 

Viewing the meeting calendar. 

2 In a list of meetings on the Today, Upcoming, Daily, or Weekly tab on the 

calendar page, click the column heading by which you want to sort the meetings. 

An ascending or descending sort indicator appears and the meetings are sorted 

accordingly. 
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Note: You can use this procedure on the Register for a Meeting page as well.  

 
 

 

Refreshing the meeting calendar 
Information about meetings on the public Meeting Center calendar can change at any 

time. Thus, to ensure that you are viewing the most current Meeting Center 

information, you can refresh the Meeting Center calendar at any time. 
 

To refresh the public Meeting Center calendar: 

1 If you have not already done so, open the meeting calendar. For details, see 

Viewing the meeting calendar (on page 66). 

2 Click the Refresh button. 

  

   

 

 

Selecting a language and time zone on the 
meeting calendar 

On the meeting calendar, you can access your Preferences page to select the language 

and time zone in which you want to view meeting times. Your site administrator 

specifies the default language and time zone that appears on the meeting calendar. 

You may need to change the time zone, for example, if you are travelling and 

temporarily in another time zone. 
 

To select a language on the public meeting calendar: 

1 If you have not already done so, open the meeting calendar. For details, see 

Viewing the meeting calendar (on page 66). 

2 Click the language link on the right side of the page. 

The Preferences page appears. 

3 In the Language drop-down list, select another language. 

4 Click OK. 
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To select a time zone on the public meeting calendar: 

1 If you have not already done so, open the meeting calendar. For details, see 

Viewing the meeting calendar (on page 66). 

2 Click the time zone link on the right side of the page. 

The Preferences page appears. 

3 In the Time zone drop-down list, select another time zone. 

4 Click OK. 
 

  

Note:   

 Your time zone selection affects only your view of your Meeting Center Web site, not 

other users' views. 

 If you have a user account, all meeting invitations that you send automatically specify 

the meeting starting time in the time zone that you selected. 

 If you select a time zone for which daylight saving time (DST) is in effect, your 

Meeting Center Web site automatically adjusts its clock for daylight saving time. 

 

 
 

 

Registering for a meeting from the meeting 
calendar 

If you did not receive an invitation email message for a meeting that requires 

registration, you can register for it from the meeting calendar on your Meeting Center 

Web site. 
 

About the Register for a Meeting page 

The Register for a Meeting page lists each meeting that requires registration. Each 

page of the meeting calendar displays each meeting occurring on a given day that 

requires registration, unless it is unlisted. 

To select a scheduled meeting, click the option button to the left of its topic. Once you 

have selected a meeting, you can click one of the following buttons on the button bar: 

  

Click this button... To... 

 
Register for the meeting. 
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Click this button... To... 

 

 

Join the meeting, if the meeting is currently in progress. 

 

 

View detailed information about the meeting. 

 

 

View the agenda for the meeting. 

 

Registering for a meeting 

If you find the meeting you want to register for, you can easily complete the 

registration form and send it to the meeting host. 
 

To register for a meeting: 

1 Select a meeting for which the status is Registration. 

2 Click Register. 

3 Enter your information and click Register Now. 

Once the host approves your registration, you receive a registration confirmation 

email message. You can then join the meeting once it starts. 

If the meeting is already in progress, and the host has chosen to approve all 

registration requests automatically, you join the meeting immediately. 
 

About the Today view 

How to access this page 

On your Meeting Center Web site, click Attend a Meeting > Browse Meetings > 

Today tab. 

What you can do here 

The Today view lists the live meetings that are scheduled for the present day, 

including those in process, those concluded, and those that have not yet begun. 
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The meeting information displayed in the list can be sorted by clicking the column 

headings. For details, see Sorting the meeting calendar (on page 69). 
 

Options on this page 

  

Option Description 

 
Click the Refresh icon at any time to display the most current list of 

meetings. 

Language link 

Click to open the Preferences page, where you can select the 

language setting for your Meeting Center Web site. 

Time zone link 
Click to open the Preferences page, where you can select the time 

zone setting for your Meeting Center Web site. 

Show past meetings Select to include concluded meetings in the list of meetings. 

Show only meetings that 

require registration check 

box 

Select to display only those meetings that require registration 

in the list of meetings. 

 

The Ascending Sort indicator appears next to a column 

heading, and the meetings are sorted by the column, in 

ascending order. 

 

The Descending Sort indicator appears next to a column 

heading, and the meetings are sorted by the column, in 

descending order. 

Time Lists the starting time for each scheduled meeting. 

Topic 
Lists the scheduled meetings by name. Click the topic name to 

get meeting information. 

Host or Presenter Lists the host or presenter for the meeting. 

Duration Lists the scheduled length of the meeting. 

 Indicates that the live meeting is in process. 

Join link 

 

Click the link to join the Meeting Center from the Meeting 

Information page. 

Register link 

 

Click to open the Register for page, where you can enter the 

required information to register for the meeting. 

 Indicates that this is a Personal Conference meeting. 
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Option Description 

Start link 

 

(Host only) Click to start your meeting. 

End link 

 

(Host only) Click to end your meeting. 

 

About the Daily view 

How to access this page 

On your Meeting Center Web site, click Attend a Meeting > Browse Meetings > 

Daily tab. 

What you can do here 

The Daily view lists the live meetings that are scheduled for the present day. From the 

Daily view you can navigate to the previous or next day, or use the calendar to view 

the schedule for another day. 
 

The meeting information displayed in the list can be sorted by clicking the column 

headings. For details, see Sorting the meeting calendar (on page 69). 
 

Options on this page 

  

Option Description 

 
Click the Refresh icon at any time to display the most current list of 

meetings. 

Language link 

Click to open the Preferences page, where you can select the 

language setting for your Meeting Center Web site. 

Time zone link 
Click to open the Preferences page, where you can select the time 

zone setting for your Meeting Center Web site. 

 
Click the Previous Day icon to display a list of meetings for 

the previous day. 

 
Click the Next Day icon to display a list of meetings for the 

next day. 
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Option Description 

 
Click the Calendar icon to open the Calendar window for the 

current month. Click on any date to open its schedule. 

Show past meetings Select to include concluded meetings in the list of meetings. 

Show only meetings that 

require registration check 

box 

Select to display only those meetings that require registration 

in the list of meetings. 

 

The Ascending Sort indicator appears next to a column 

heading, and the meetings are sorted by the column, in 

ascending order. 

 

The Descending Sort indicator appears next to a column 

heading, and the meetings are sorted by the column, in 

descending order. 

Time Lists the starting time for each scheduled meeting. 

Topic 
Lists the scheduled meetings by name. Click the topic name to 

get meeting information. 

Host or Presenter Lists the host or presenter for the meeting. 

Duration Lists the scheduled length of the meeting. 

 Indicates that the live meeting is in process. 

Join link 

 

Click the link to join the Meeting Center from the Meeting 

Information page. 

Register link 

 

Click to open the Register for page, where you can enter the 

required information to register for the meeting. 

 Indicates that this is a Personal Conference meeting. 

Start link 

 

(Host only) Click to start your meeting. 

End link 

 

(Host only) Click to end your meeting. 
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About the Weekly view 

How to access this page 

On your Meeting Center Web site, click Attend a Meeting > Browse Meetings > 

Weekly tab. 

What you can do here 

The Weekly view lists the live meetings that are scheduled, but not ended for the 

selected week. 
 

The meeting information displayed in the list can be sorted by clicking the column 

headings. For details, see Sorting the meeting calendar (on page 69). 
 

Options on this page 

  

Option Description 

 
Click the Refresh icon at any time to display the most current list of 

meetings. 

Language link 

Click to open the Preferences page, where you can select the 

language setting for your Meeting Center Web site. 

Time zone link 
Click to open the Preferences page, where you can select the time 

zone setting for your Meeting Center Web site. 

 
Click the Previous Week icon to display a list of meetings for 

the previous week. 

 
Click the Next Week icon to display a list of meetings for the 

next week. 

 
Click the Calendar icon to open the Calendar window for the 

current month. Click on any date to open its schedule. 

Show only meetings that 

require registration check 

box 

Select to display only those meetings that require registration 

in the list of meetings. 

Day link 

 

Opens the Daily view, which shows the scheduled meetings for 

the selected day. 
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Option Description 

 

The Ascending Sort indicator appears next to a column 

heading, and the meetings are sorted by the column, in 

ascending order. 

 

The Descending Sort indicator appears next to a column 

heading, and the meetings are sorted by the column, in 

descending order. 

Time Lists the starting time for each scheduled meeting. 
 

 

Topic 
Lists the scheduled meetings by name. Click the topic name to 

get meeting information. 

Host or Presenter Lists the host or presenter for the meeting. 

Duration Lists the scheduled length of the meeting. 

 Indicates that the live meeting is in process. 

Join link 

 

Click the link to join the Meeting Center from the Meeting 

Information page. 

Register link 

 

Click to open the Register for page, where you can enter the 

required information to register for the meeting. 

 Indicates that this is a Personal Conference meeting. 

Start link 

 

(Host only) Click to start your meeting. 

End link 

 

(Host only) Click to end your meeting. 

 

About the Monthly view 

How to access this page 

On your Meeting Center Web site, click Attend a Meeting > Browse Meetings > 

Monthly tab. 
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What you can do here 

The Monthly view shows when the live meetings are scheduled in a monthly calendar 

view. You can navigate to a specific day or week within the current month, or 

navigate to the previous or next month. 
 

Options on this page 

  

Option Description 

 
Click the Previous Month icon to display a list of meetings for 

the previous month. 

 
Click the Next Month icon to display a list of meetings for the 

next month. 

 
Click the Refresh icon at any time to display the most current list of 

meetings. 

Language link 

Click to open the Preferences page, where you can select the 

language setting for your Meeting Center Web site. 

Time zone link 
Click to open the Preferences page, where you can select the time 

zone setting for your Meeting Center Web site. 

Week link 

 

Opens the Weekly view, which shows the scheduled meetings 

for each day of the selected week. 

Day link 

 

Opens the Daily view, which shows the scheduled meetings for 

the selected day. 

 
Appears on the calendar to indicate that one or more meetings 

are scheduled on that day. 

 

About the Search Results page 

What you can do here 

 Find a meeting on your Meeting Center Web site. 

 Display past meetings. 

 Sort the search results. 

 Select a language for your Meeting Center Web site. 
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 Select a time zone for your Meeting Center Web site. 

 Display meetings that require registration. 
 

The meeting information displayed in the list can be sorted by clicking the column 

headings. For details, see Sorting the meeting calendar (on page 69). 
 

Options on this page 

  

Option Description 

Search for... 

text box 

Enter a host name, meeting topic, or any text that may appear 

in the agenda, and click Search. 

Note: You cannot search for a meeting number. 

 
Click the Refresh icon at any time to display the most current list of 

meetings. 

Language link 

Click to open the Preferences page, where you can select the 

language setting for your Meeting Center Web site. 

Time zone link 
Click to open the Preferences page, where you can select the time 

zone setting for your Meeting Center Web site. 

Show past meetings Select to include concluded meetings in the list of meetings. 

Show only meetings that 

require registration check 

box 

Select to display only those meetings that require registration 

in the list of meetings. 

Navigation links 
Click the page numbers or next to navigate through the search 

results. 

 

The Ascending Sort indicator appears next to a column 

heading, and the meetings are sorted by the column, in 

ascending order. 

 

The Descending Sort indicator appears next to a column 

heading, and the meetings are sorted by the column, in 

descending order. 

Date & Time Lists the date and starting time of the  meeting. 

Topic 
Lists the scheduled meetings by name. Click the topic name to 

get meeting information. 

Host or Presenter Lists the host or presenter for the meeting. 

Duration Lists the scheduled length of the meeting. 
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Option Description 

 Indicates that the live meeting is in process. 

Join link 

 

Click the link to join the Meeting Center from the Meeting 

Information page. 

Register link 

 

Click to open the Register for page, where you can enter the 

required information to register for the meeting. 

 Indicates that this is a Personal Conference meeting. 

Start link 

 

(Host only) Click to start your meeting. 

End link 

 

(Host only) Click to end your meeting. 
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Chapter 5  

  

If you want to... See... 

get an overview of scheduling a meeting Choosing the scheduler that works for you (on 

page 81) 

allow another user to schedule a meeting for 

you 

Allowing another user to schedule meetings for 

you (on page 138) 

use the Quick Scheduler to start a meeting 

quickly 

Using the Quick Scheduler (on page 91) 

use the Advanced Scheduler to include an 

agenda and other options in your meeting 

About the Advanced Scheduler (on page 91) 

set up a meeting that recurs on a regular 

basis 

Setting up a recurring meeting (on page 137) 

start a scheduled meeting Starting a scheduled meeting (on page 130) 

edit details for a scheduled meeting Editing a scheduled meeting (on page 129) 

cancel a scheduled meeting Canceling a scheduled meeting (on page 132) 

 

Choosing the scheduler that works for you 
Meeting Center provides several ways to set up meetings. Review the details about 

the different means of scheduling a meeting and then pick the one that meets your 

needs. 

Scheduling a Meeting 



Chapter 5: Scheduling a Meeting 

 

82 

 

Short on time? 

Use the one-page Quick Scheduler. Simply enter a few details and you are ready to 

host your meeting. For details, see Using the Quick Scheduler (on page 91). 

Looking for more meeting options, such as adding additional security? 

Use the Advanced Scheduler. Enter the level of detail you need. You can schedule or 

start the meeting from any page in the wizard. For details, see Using the Advanced 

Scheduler . 

Want to reuse the information you saved in the scheduler? 

You do not have to type in the same information every time you set up a meeting. If 

the meeting recurs on a regular basis, with the same attendees, you can set up a whole 

series of meetings. If the meeting details (such as attendees, meeting options) are 

constant, you can save those details in a template, which you can apply to any 

meeting you schedule. For details, see: 

 Setting up a recurring meeting (on page 137) 

 Using meeting templates (on page 133) 

  

Note: If you decide to switch from the Advanced Scheduler to the Quick Scheduler (or from the 

Quick Scheduler to the Advanced Scheduler) any information you have typed is saved and 

available in the other scheduler. 

 

About the Quick Scheduler 
Use this one-page scheduler to set up a meeting with just a few mouse clicks. 

Your site administrator decides whether your site displays the Quick Scheduler or the 

Advanced Scheduler, a wizard that helps you step through the process of selecting 

meeting options. 

If your site displays the Advanced Scheduler automatically, you can easily switch to 

the Quick Scheduler. Simply click the Return to Quick Scheduler link at the top of the 

Required Information page. 
 

About the Quick Scheduler page 

How to access this page 

On the navigation bar, click Host a Meeting > Schedule a Meeting 
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If you see the Advanced Scheduler, click the link to display the Quick Scheduler. 
 

  

 
 

What you can do on this page 

Set up a meeting quickly, using this one-page scheduler. 

Options on this page 

  

Use this option... To... 

Set options using template Select a template and use the settings saved in that 

template for this meeting. 

You can save time by using a template that includes the list 

of attendees you want to invite, a presentation you want to 

show before the meeting starts, and other options you have 

used in a previous meetings and saved as a template. 

For more details about creating and editing templates, see 

Using meeting templates (on page 133). 

Meeting Topic Enter the topic or a name for the meeting. 
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Tracking codes Identify your department, project, or other information 

that your organization wants to associate with your 

meetings. Tracking codes can be optional or required, 

depending on how your site administrator set them up. 

If your site administrator requires you to select a code 

from a predefined list, a list of codes appears. Select a 

code from the list on the left. Then do one of the 

following in the box on the right: 

 If a list of codes appears, select a code from the list. 

 Type a code in the box. 

Password 

Confirm password 

Require participants to enter the password you set to 

join your meeting. 

Your site may require that all passwords comply with 

security criteria, such as a minimum length and a 

minimum number of letters, numbers or special 

characters. A password: 

 Can contain a maximum of 16 characters. 

 Cannot contain spaces or any of the following 

characters: \ ` “ / & < > == [ ] 

Each participant that you invite to your meeting receives 

an invitation email message that includes the password, 

unless you request that passwords do not appear in 

email invitations. 

Date Set the date you want the meeting to occur. Select the 

month, day, and year in the drop-down lists. Or, you can 

click the Calendar icon, and then select a date. 

Time Set the meeting's starting time and the time zone. To 

select another time zone, click the time zone link. 

Important The time zone you select does not affect 

the time zone setting for the meeting calendar on the 

Browse Meetings page. You and each attendee can 

select the time zone for your view of the calendar 

independently, using the Your time zone option on 

the Preferences page. To access this page, on the 

navigation bar, click Set Up > Preferences. 

Duration Enter the length of time you estimate that the meeting 

will continue. The meeting does not end automatically 

after the duration that you set. 

Attendees  Enter the email addresses of the attendees you want to invite to 

your meeting. 

You can type the addresses, separating them with a comma or 

semicolon or you can click Select Attendees to choose attendees 

from your address book. 
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Use this option... To... 

Allow external attendees  Allow attendees located on the public internet to join your 

meeting. If unchecked, only attendees within the same internal 

network can join. 

Note: This option is available for Cisco Unified MeetingPlace 

users only. 

Send a copy of the invitation 

email to me 

 

Receive a copy of the invitation you are sending to attendees. 

Later, if you decide to invite additional attendees, you can simply 

forward this email message to them. 

Audio conference The default audio conference settings appear. To select 

a different options, click Change audio conference. 

CUVC Meeting ID  Enter a custom URL to create a virtual meeting room in which 

you can use Cisco Unified Video (CUVC) in your meeting.  

If you leave this box empty, the WebEx Meeting ID is used by 

default.  

When you start your WebEx meeting, the CUVC Video panel 

displays automatically. 

This is an optional feature that must be enabled by your site 

administrator. 

 

About the Change Tracking Code page 

How to access this page 

On the navigation bar, click Host a Meeting > Schedule a Meeting  

If you see the Advanced Scheduler, click the link to display the Quick Scheduler. 

Then click Select tracking code. 

What you can do on this page 

Add or remove tracking codes assigned to this meeting. 

Options on this page 

  

Use this option... To... 

Tracking Code Assign a tracking code to this meeting. 
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Use this option... To... 

Your site administrator provides the group name, 

such as "Division," or "Department" or other 

identifier. Depending on how your site is set up, 

you have one of these options: 

 Select the tracking codes from a list 

 Enter the tracking codes in the boxes 

provided, 

 Both options (either select codes from a list or 

type it) 

 

About the Time Zone page 

How to access this page 

On the navigation bar, click Host a Meeting > Schedule a Meeting  

If you see the Advanced Scheduler, click the link to display the Quick Scheduler. 

Then click the current time zone link (for example, Pacific ST). 

What you can do on this page 

Select a different time zone for the meeting you are scheduling.  

  

Important: The time zone you select does not affect the time zone setting for the meeting 

calendar on the Browse Meetings page. You and each attendee can select the time hzone for your 

view of the calendar independently, using the Your time zone option on the Preferences page. To 

access this page, on the navigation bar, click Set Up > Preferences. 

 

About the Select Attendees page 

How to access this page 

On the navigation bar, click Host a Meeting> Schedule a Meeting  

You can select attendees from the Quick Scheduler or the Advanced Scheduler>Invite 

Attendees page. 
 

Then click the Use Address book link. 
 

What you can do on this page 

 Select contacts in your personal address book and invite them to the meeting. 



 Chapter 5: Scheduling a Meeting 

 

87 

 

 Add new contacts to your personal address book and invite them to the meeting. 
 

 Designate one or more invited attendees as alternate hosts 
 

Options on this page 

  

Use this option... To... 

Address book Select the address book from which you want to 

select attendees. The contacts in the address 

book that you select appear in the box. These 

address books are available: 

 Personal contacts: Includes any individual 

contacts that you have added to your 

personal address book. If you use Microsoft 

Outlook, you can import the personal 

contacts that you keep in an Outlook address 

book or folder to this list of contacts. 

 Company address book: Your 

organization's address book, which includes 

any contacts that your site administrator has 

added to it. If your organization uses a 

Microsoft Exchange Global Address List, your 

site administrator can import its contacts to 

this address book. 

 List: Includes any distribution lists that you 

have created for your personal address book. 

New Contact Add a new contact. Enter the requested 

information about the new contact you want to 

invite to the meeting. You can also add the new 

contact to your personal address book. 

Search Search for text in the selected address book. For 

example, you can search for all or part of a 

contact name or email address 
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Invite as Add the selected contacts to the list of attendees 

Attendee: Adds the selected contacts to the list of 

attendees. 

Alternate Host: Adds the selected contacts as 

alternate hosts to the list of attendees. An 

alternate host receives an invitation email 

message that provides information about acting 

as the alternate host. An alternate host can start 

the meeting and act as the host. If you join the 

meeting after an alternate host has started or 

joined it, you do not automatically assume the 

host role. 

An alternate host must have a user account on 

your meeting service Web site. 

 

Remove Remove the selected contacts from the list of 

attendees. 

 
 

About the Audio Conference Settings page 

How to access this page 

On the navigation bar, click Host a Meeting > Schedule a Meeting  

If you see the Advanced Scheduler, click the link to display the Quick Scheduler. 

Then click Change audio conference. 

What you can do on this page 

Change the preset audio options, such as the teleconferencing service you plan to use. 

Options on this page 

  

Use this option... To... 

Select conference type 

 

 

 

Select the type of audio conference you would like to use: 

WebEx Audio: Specifies that the meeting includes an integrated 

audio conference. If you select this option, choose one of the 

following types of teleconferences: 

 Display toll-free number: If participants call in to the 

conference, they can call a toll-free number. 

 Display global call-in numbers: This option provides a list 
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Use this option... To... 

of numbers—such as toll-free or local numbers—that 

participants in other countries can call to join the audio 

conference. 

 Enable teleconference CLI authentication when 

participants call in  

CLI (caller line identification) is a form of caller ID, a 

telephony intelligent service that transmits a caller’s 

telephone number before the call is answered. If you use 

WebEx audio conferencing, you can help participants join 

the meeting more quickly, if participants have: 

 a WebEx host account  

 saved their phone numbers in their WebEx profiles 

This option is not available for Cisco Unified MeetingPlace 

users. 

 Personal Conference number: Displays the personal audio 

conference accounts you have set up in the Personal 

Conferencing area of My WebEx. Select the account you want to 

use for your meeting. You can create up to three accounts.  

Click Edit to make changes, such as updating the subscriber or 

attendee access code. 

If you have not yet set up any accounts, select Create Personal 

Conference account to get started. This option is not available 

for Cisco Unified MeetingPlace users. 

 Other teleconference service: Specifies that the meeting 

includes a teleconference that another service provides.  

Instructions: Provides space for you to type instructions for 

joining the teleconference. 

Instructions for any teleconference option that you select 

automatically appear: 

 On the Meeting Information page on your site, which 

participants can view before you start the meeting 

 In invitation email messages, if you invite participants using 

the Schedule a Meeting page options 

 On the Info tab, which appears in the content viewer in the 

Meeting window 

 In the Join Teleconference dialog box, which appears in 

participants' Meeting windows once they join the meeting 
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Use this option... To... 

 Cisco Unified MeetingPlace Audio Conferencing: Specifies 

that the meeting include an integrated audio conference with 

your Cisco Unified MeetingPlace audio conferencing account. If 

you select this option, choose the type of conference: 

 Attendees call in: Select if you want customers to dial a 

number to join 

 Attendees receive call back: Select if you want customers 

to type in a phone number and receive a call back from the 

conferencing service. 

A participant must have a direct phone line to receive a call from 

the conferencing service. However, a participant without a direct 

phone line can join an audio conference by dialing a call-in 

number, which is always available in the meeting window. 

 Use VoIP only: Specifies that you want to set up an Integrated 

VoIP conference for the meeting. If selected, you can still set up 

a traditional teleconference for the meeting. 

 You must start VoIP after you start the meeting.  

 Only participants whose computers meet the system 

requirements for integrated VoIP session can participate in 

the conference. 

 None: Specifies that the meeting does not include a 

teleconference, or the meeting includes a teleconference for 

which you will provide information for participants using a method 

other than your meeting service. 

Entry & exit tone  Select the sound you would like all participants to hear when an 

attendee joins or leaves the meeting: 

 Beep: A simple tone plays 

 Announce name: Upon joining the teleconference, a 

participant records his or her name, which is then played in 

the teleconference. 

 No Tone: No alert plays  
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Using the Quick Scheduler 
1 Log in to your Meeting Center Web site. 

2 On the navigation bar, expand Host a meeting to view a list of links. 

3 Click Schedule a meeting. 

The Required Information page appears. 

4 Check whether you are viewing the Advanced Scheduler. Click the Return to 

Quick Scheduler link to display the Quick Scheduler. 

The Advanced Scheduler consists of several pages, with the links to them on the 

right side of the page. The Quick Scheduler is one page. 

5 Enter the details about your meeting. For information about the fields on this 

page, see About the Quick Scheduler page (on page 82). 

6 Start or schedule the meeting: 

 If the meeting's starting time is the current time, click Start to start the 

meeting. 

 If the meeting's starting time is after the current time, click Schedule. 

The Meeting Scheduled page appears, confirming that the meeting is scheduled. You 

also receive a confirmation email message that includes information about the 

scheduled meeting. 
 

About the Advanced Scheduler 
When scheduling a meeting, use the Schedule a meeting wizard to set several options 

for your meeting. These options allow you to customize your meeting for your 

specific needs, such as additional security. Once you schedule a meeting, you can 

change its options at any time, or cancel the meeting. 

If another user has granted scheduling permission to you in his or her user profile, you 

can schedule a meeting on behalf of that user. For details about granting scheduling 

permission to another user, see Allowing another user to schedule meetings for you 

(on page 138). 

  

Note: If you use Microsoft Outlook 2000 or a later version, you can schedule, start, and join an 

online meeting using Outlook. For instructions on using Integration to Outlook, refer the 

Integration to Outlook User's Guide, which is available on your Meeting Center Web site. 
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Choosing a level of security for a scheduled 
meeting 

When scheduling a meeting, you can provide security for the meeting using these 

means: 

 Require a password: Attendees must provide the password you set before 

joining the meeting. For more information, see About the Required Information 

page. 

 Decline to list this meeting on the meeting calendar: An unlisted meeting does 

not appear in the meeting calendar on the Browse Meetings page or on your 

Personal Meetings page. To join an unlisted meeting, attendees must provide a 

unique meeting number. For more information, see About the Required 

Information page. 

 Exclude the meeting password from email invitations: If you invite attendees 

to a meeting, you can prevent the password from appearing in the email 

invitations that your Meeting Center Web site sends automatically to attendees. 

For details, see About the Required Information page. 
 

 Require attendees to log in: You can require attendees to have a user account on 

your Meeting Center Web site to join the meeting. Thus, attendees must log in to 

your site before they can attend the meeting. For more information, see About the 

Invite Attendees page. 

 Require attendees to register for the meeting: If you require each attendee to 

send a registration request to you before joining a meeting, you can accept or 

reject each registration request. For more information, see About the Registration 

page (on page 113). 
 

  

Tip: Choose a level of security based on the meeting's purpose. For example, if you schedule a 

meeting to discuss your company picnic, you probably need to set only a password for the 

meeting. On the other hand, if you schedule a meeting in which you will discuss sensitive 

financial data, you may not want to list the meeting on the meeting calendar. You may also 

choose to restrict access to the meeting once all attendees have joined it. 
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Using the Advanced Scheduler 
When scheduling a meeting, you must provide a meeting topic and a starting time. 

You can also set options to customize your meeting and enhance its security. 

Using the Advanced Scheduler, you can schedule a meeting quickly. You can click 

the Start button at any time to start your meeting. If you have questions about the 

information requested on a page, click the Help button, which is located in the upper 

right corner of each wizard page. 

To start the Advanced Scheduler: 

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, expand Host a meeting to view a list of links. 

3 Click Schedule a meeting. 

The Advanced Scheduler appears, showing the Required Information page. 

To schedule a meeting: 

1 Click Required Information. 

Enter the requested information, such as the meeting topic, meeting password, 

tracking codes, and whether you want to display this meeting on your meeting list. 

For details, see About the Required Information page. 

2 Click Date & Time. 

Set the date and time for the meeting. You also set the meeting duration, how 

many minutes in advance you will allow participants to join the meeting, whether 

the meeting recurs and how often and other information related to meeting times. 

For details, see About the Date & Time page (on page 99). 

3 Click Audio Conference. 

Set up a voice conference for the meeting. Select the type of voice conference 

(call back or call in). Also, you can include VoIP as well as the traditional 

teleconference. 

For details, see About the Audio Conference page (on page 103). 

4 Click Invite Attendees. 

Enter the email addresses of the attendees you want to invite or you can select 

them from your contact list. You can also make your meeting more secure by: 
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 Selecting the option not to send the meeting password in the meeting 

invitation 

 Requiring attendees to have an account on your Web site before they can join 

a meeting. 

For details, see About the Invite Attendees page. 

5 Click Registration. 

If you want to have participants register for the meeting, select information to be 

requested on registration page. 

For details, see About the Registration page (on page 113). 

6 Click Agenda & Welcome. 

Type an agenda for the meeting or a welcome message for attendees, which they 

can view before the meeting starts. Select a file that you want to open 

automatically in each attendee's Meeting window once he or she joins the 

meeting.  

For details, see About the Agenda & Welcome page (on page 116) 

7 Click Meeting Options. 

Select the meeting options you want to be available to all participants during the 

meeting. You can also choose an alert to play once a participant either joins or 

leaves the teleconference.  

For details, see About the Meeting Options page (on page 121) 

8 Click Review. 

You view all the information you've entered on each page of the Advanced 

Scheduler. If you need to make a change, return to that page in the wizard and edit 

the information. 

For details, see About the Review page (on page 127). 

9 Optional. Save your meeting settings in a template. 

If you may need to use these same meeting settings (for example, with the same 

attendees, telephony options, and other meeting details), you can save the settings 

in a meeting template. 

For more details about using meeting templates, see Using meeting templates (on 

page 133). 

10 Start or schedule the meeting: 

 If the meeting's starting time is the current time, click Start to start the 

meeting. 
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 If the meeting's starting time is after the current time, click Schedule. 

The Meeting Scheduled page appears, confirming that the meeting is scheduled. 

You also receive a confirmation email message that includes information about 

the scheduled meeting. 
 

Page-by-page guide to the Advanced Scheduler 
Scheduling a meeting can be done in one click, or you can take a bit of time and set 

up audio conferencing options, invite attendees, assign privileges, and select other 

options in advance of the meeting. If you have questions about any options or how to 

complete the information requested on any page in the Advanced Scheduler, refer to 

these topics: 

  

If you want to... See... 

learn about meeting types, listed and 

unlisted meetings, meeting passwords 

About the Required Information page 

set the day and time for a meeting or set up 

a recurring meeting 

About the Date & Time page (on page 99) 

set up audio conference with VoIP or voice 

audio conferencing or both 

About the Audio Conference page (on page 

103) 

invite attendees to a meeting About the Invite Attendees page (on page 

108) 

select contacts to invite to a meeting About the Select Attendees page (on page 

112) 

require attendees to register for a meeting About the Registration page (on page 113) 

create an agenda and select a presentation 

to share while attendees wait for the 

meeting to start 

About the Agenda & Welcome page (on 

page 116) 

set options for participants, such as allowing 

them to chat, transfer files, and take notes 

About the Meeting Options page (on page 

121) 

set privileges for attendees, such as 

allowing them to view a list of meeting 

participants, control another computer or a 

Web browser remotely 

About the Attendee Privileges Page (on 

page 124) 

review all meeting details About the Review page (on page 127) 

 



Chapter 5: Scheduling a Meeting 

 

96 

 

About the Required Information page 

How to access this page 

On the navigation bar, click Host a meeting > Schedule a meeting > Required 

Information 

  

 

What you can do on this page 

 Set up a meeting on behalf of someone else 

You can select the hosts you want to include in the Schedule for drop-down list 

from the list of hosts available in the Profiles area of My WebEx. 

 Select the type of meeting you are setting up. 

 Define a topic for the meeting. 

 Indicate whether the meeting is listed on the meeting calendar. For information 

about a listed or unlisted meeting, see About joining a meeting. 

 Decide whether the meeting is deleted from My Meetings on My WebEx after it is 

over. 

 Set the meeting password, if required. 

 Select tracking codes, if your administrator has set them up. 
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Options on this page 

  

Use this option... To... 

Set options using template  Select a template and use the settings saved in that template for 

this meeting. 

You can save time by using a template that includes the list of 

attendees you want to invite, a presentation you want to show 

before the meeting starts, and other options you have used in a 

previous meetings and saved as a template. 

For more details about creating and editing templates, see Using 

meeting templates (on page 133). 

Meeting type  Select the type of meeting you want to schedule. 

The list includes the meeting types that are available for your 

service website.  

In addition to the standard meeting types, the list may include 

one or more of the following options, depending on your site 

settings: 

 Personal Conference: Allows you to schedule a Personal 

Conference meeting that begins with an audio portion and 

automatically includes an online portion you can join later. 

You must have at least one Personal Conference number 

account specified in the My WebEx > Personal Conferencing 

page in order to use this meeting type. 

 MeetingPlace Personal Conference: Allows you to specify 

a Cisco Unified MeetingPlace Personal Conference that 

uses your Cisco Unified MeetingPlace Audio Conferencing 

account for the audio conference.  

Meeting topic  Enter the topic or a name for the meeting. 

Listed on calendar  List this meeting on the meeting calendar. 

To enhance meeting security, you can opt not to list the meeting 

on the meeting calendar. Just remove the check mark from this 

option to: 

 Hide information about the meeting, such as its host, topic, 

and starting time. 

 Help prevent unauthorized access to the meeting. 

Delete from My Meetings 

when completed  

Remove this meeting from your list of meetings in the My 

Meetings area of My WebEx after the meeting ends. 

If you do not select this option, you must delete this meeting from 

My Meetings to remove it from the list. 
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Use this option... To... 

Meeting password  

Confirm password 

Require participants to enter the password you set to join your 

meeting. 

Your site may require that all passwords comply with security 

criteria, such as a minimum length and a minimum number of 

letters, numbers or special characters. A password: 

 Can contain a maximum of 16 characters. 

 Cannot contain spaces or any of the following characters: \ ` 

“ / & < > == [ ] 

Each participant that you invite to your meeting receives an 

invitation email message that includes the password, unless you 

request that passwords do not appear in email invitations. 

If you have selected Personal Conference as the meeting type, 

the default password is the attendee access code in your 

Personal Conference number account that is specified for the 

meeting. 

Tracking codes  Identify your department, project, or other information that your 

organization wants to associate with your meetings. Tracking 

codes can be optional or required, depending on how your site 

administrator set them up. 

If your site administrator requires you to select a code from a 

predefined list, a list of codes appears. Select a code from the list 

on the left. Then do one of the following in the box on the right: 

 If a list of codes appears, select a code from the list. 

 Type a code in the box. 

CUVC Meeting ID  Enter a custom URL to create a virtual meeting room in which 

you can use Cisco Unified Video (CUVC) in your meeting.  

If you leave this box empty, the WebEx Meeting ID is used by 

default.  

When you start your WebEx meeting, the CUVC Video panel 

displays automatically. 

This is an optional feature that must be enabled by your site 

administrator. 
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Questions about required information for setting up a meeting 

Why set up an unlisted meeting? 

You can prevent a scheduled meeting from appearing on the meeting calendar and any 

other publicly accessible pages on your Meeting Center Web site, by setting up an 

unlisted meeting. If a meeting is unlisted, the meeting details, such as its host, topic, 

and starting time are not available on the calendar and other places. This additional 

security may help prevent unauthorized access to the meeting. 

To join an unlisted meeting, a participant must provide a unique meeting number. 

If you invite a participant to an unlisted meeting, the participant receives an invitation 

email message that includes complete instructions for joining the meeting-including 

the meeting number-and a URL that links directly to a Web page on which the 

participant can join the meeting. 

What are tracking codes? 

Your site administrator can include tracking codes in the Advanced Scheduler. 

Tracking codes may identify your department, project, or other information that your 

organization wants to associate with your meeting. Tracking codes can be optional or 

required, depending on how your site administrator sets them up. 

How can I learn more about the fields on the Required Information page? 

Click the Help link in the top right corner of the Required Information page, or review 

About the Required Information page. 
 

About the Date & Time page 

How to access this page 

On the navigation bar, click Host a meeting > Schedule a meeting > Date & Time. 
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What you can do on this page 

 Set the date and time for the meeting 

 Set the duration for the meeting 

 Select the number of minutes before the meeting's starting time during which 

attendees can join the meeting 

 Select the number of minutes before the meeting you want to receive a reminder 

email message 

 Set a recurrence pattern for the meeting 

Options on this page 

  

Use this option... To... 

Set options using template  Select a template and use the settings saved in that template for 

this meeting. 

You can save time by using a template that includes the list of 

attendees you want to invite, a presentation you want to show 

before the meeting starts, and other options you have used in a 

previous meetings and saved as a template. 

For more details about creating and editing templates, see Using 

meeting templates (on page 133). 
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Use this option... To... 

Meeting date  Set the date you want the meeting to occur. Select the month, 

day, and year in the drop-down lists. Or, you can click the 

Calendar icon, and then select a date. 

Meeting time  Set the meeting's starting time and the time zone. To select 

another time zone, click the time zone link. 

Important The time zone you select does not affect the time 

zone setting for the meeting calendar on the Browse Meetings 

page. You and each attendee can select the time zone for your 

view of the calendar independently, using the Your time zone 

option on the Preferences page. To access this page, on the 

navigation bar, click Set Up > Preferences 

Attendees can join [x] 

minutes before the starting 

time  

Allow attendees to join the meeting within a set number of 

minutes before the meeting's starting time. 

Note: If you clear this check box or set this option to 0 minutes, 

you must start the meeting before attendees can join it 

For more information about starting a meeting, see Starting a 

scheduled meeting (on page 130). 

The first attendee to join will 

be the presenter  

If you allow attendees to join the meeting before the scheduled 

starting time, and you check this box, the very first attendee to 

join the meeting will become the presenter.  

Attendees can also connect 

to audio conference  

If you allow attendees to join the meeting before the scheduled 

starting time, you can also allow attendees to join the WebEx 

Audio conference before the meeting starts. 

You set up the WebEx Audio conference on the next page. 

Estimated duration  Enter the length of time you estimate that the meeting will 

continue. The meeting does not end automatically after the 

duration that you set. 

Email reminder  Set the number of minutes before the meeting's scheduled 

starting time at which you want to receive a reminder email 

message. If you do not want to receive a reminder, in the drop-

down list, select None. 

Recurrence  Set the recurrence pattern for this meeting. 

 None: Specifies that the meeting does not recur. 
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Use this option... To... 

 Daily: Repeats the meeting every day until the ending date that 

you select. 

 Every [x] Days: Repeats the meeting after the specified 

number of days pass.  

 Every weekday: Repeats the meeting each day, from 

Monday to Friday. 

 Weekly: Repeats the meeting after a specified number of weeks 

until the ending date that you select. 

 Every [x] week(s) on: Specifies the day of the week on 

which to repeat the meeting and the number of weeks that 

must pass before the meeting repeats. 

 Sunday - Saturday: Specifies the day on which the meeting 

repeats. You can select one or more days.  

 Monthly: Repeats the meeting every month until the ending date 

that you select. 

 Day [x] of every [x] month(s): Specifies the specific day of 

the month on which to repeat the meeting, and the number 

of months that pass before the meeting repeats. 

 [x] [x] of every [x] month(s): Specifies the specific week 

and day of the week on which to repeat the meeting, and the 

number of months that pass before the meeting repeats. 

 Yearly: Repeats the meeting every year until the ending date 

that you select. 

 Every [month] [date]: Specifies the specific month and date 

on which to repeat the meeting each year. 

 [x] [day] of [month]: Specifies the specific week, day of the 

week, and month on which to repeat the meeting each year 

Ending  No end date: Repeats the meeting indefinitely. That is, the 

meeting recurs until you cancel it. 

 Ending: Specifies the last day on which the meeting recurs. 

You can select the month, day, and year in the drop-down 

lists. Or, you can click Calendar icon, and then select a date. 

 After [x] meetings: Specifies the number of meetings after 

which the meeting stops recurring. 
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Questions about setting the date and time for a meeting 

Does the meeting end automatically at the time I set? 

You can set the time a scheduled meeting starts and the meeting's estimated duration. 

This information allows attendees to reserve the appropriate length of time in their 

schedules. The meeting does not end automatically after the duration you set. 

What happens if I allow participants to join the meeting before the start time? 

Participants can see the agenda and other details about the meeting. You can also set 

up a presentation to inform or entertain the participants while they wait for the 

meeting to start. You set up this option on the Agenda & Welcome page. 

The option to let participants join the meeting before the host is available only if the 

administrator for your meeting service has turned the option on for your site and you 

schedule the meeting for a time in the future. 

How can I learn about the fields on the Date & Time page? 

Click the Help link in the top right corner of the Date & Time page, or review About 

the Date & Time page (on page 99). 
 

About the Audio Conference page 

How to access this page: 

On the navigation bar, click Host a Meeting > Schedule a Meeting >Audio 

Conference. 
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What you can do on this page 

 Include a VoIP (voice over Internet Protocol) session 

 Choose the telephony service you want to use in the meeting you are scheduling 

If you choose WebEx teleconferencing, you can set other options, such as whether 

meeting participants call in to the meeting or receive a call back and if the 

participants use a toll or toll-free number. 

 Choose the sound that plays when participants enter or leave the meeting. 

For instance, you can hear a “beep” or have the name of the participant 

announced. 

Options on this page 

  

Use this option... To... 

Set options using template  Select a template and use the settings saved in that template for 

this meeting. 

You can save time by using a template that includes the list of 

attendees you want to invite, a presentation you want to show 

before the meeting starts, and other options you have used in a 

previous meetings and saved as a template. 

For more details about creating and editing templates, see Using 

meeting templates (on page 133). 

Select conference type 

 

 

 

Select the type of audio conference you would like to use: 

WebEx Audio: Specifies that the meeting includes an integrated 

audio conference. If you select this option, choose one of the 

following types of teleconferences: 

 Display toll-free number: If participants call in to the 

conference, they can call a toll-free number. 

 Display global call-in numbers: This option provides a list 

of numbers—such as toll-free or local numbers—that 

participants in other countries can call to join the audio 

conference. 

 Enable teleconference CLI authentication when 

participants call in  

CLI (caller line identification) is a form of caller ID, a 

telephony intelligent service that transmits a caller’s 

telephone number before the call is answered. If you use 

WebEx audio conferencing, you can help participants join 

the meeting more quickly, if participants have: 

 a WebEx host account  

 saved their phone numbers in their WebEx profiles 
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Use this option... To... 

This option is not available for Cisco Unified MeetingPlace 

users. 

 Personal Conference number: Displays the personal audio 

conference accounts you have set up in the Personal 

Conferencing area of My WebEx. Select the account you want to 

use for your meeting. You can create up to three accounts.  

Click Edit to make changes, such as updating the subscriber or 

attendee access code. 

If you have not yet set up any accounts, select Create Personal 

Conference account to get started. This option is not available 

for Cisco Unified MeetingPlace users. 

 Other teleconference service: Specifies that the meeting 

includes a teleconference that another service provides.  

Instructions: Provides space for you to type instructions for 

joining the teleconference. 

Instructions for any teleconference option that you select 

automatically appear: 

 On the Meeting Information page on your site, which 

participants can view before you start the meeting 

 In invitation email messages, if you invite participants using 

the Schedule a Meeting page options 

 On the Info tab, which appears in the content viewer in the 

Meeting window 

 In the Join Teleconference dialog box, which appears in 

participants' Meeting windows once they join the meeting 

 Cisco Unified MeetingPlace Audio Conferencing: Specifies 

that the meeting include an integrated audio conference with 

your Cisco Unified MeetingPlace audio conferencing account. If 

you select this option, choose the type of conference: 

 Attendees call in: Select if you want customers to dial a 

number to join 

 Attendees receive call back: Select if you want customers 

to type in a phone number and receive a call back from the 

conferencing service. 

A participant must have a direct phone line to receive a call from 

the conferencing service. However, a participant without a direct 

phone line can join an audio conference by dialing a call-in 

number, which is always available in the meeting window. 

 Use VoIP only: Specifies that you want to set up an Integrated 
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Use this option... To... 

VoIP conference for the meeting. If selected, you can still set up 

a traditional teleconference for the meeting. 

 You must start VoIP after you start the meeting.  

 Only participants whose computers meet the system 

requirements for integrated VoIP session can participate in 

the conference. 

 None: Specifies that the meeting does not include a 

teleconference, or the meeting includes a teleconference for 

which you will provide information for participants using a method 

other than your meeting service. 

Entry & exit tone  Select the sound you would like all participants to hear when an 

attendee joins or leaves the meeting: 

 Beep: A simple tone plays 

 Announce name: Upon joining the teleconference, a 

participant records his or her name, which is then played in 

the teleconference. 

 No Tone: No alert plays  

 

 

 

Questions about setting up an audio conference 

What kinds of audio conferences are available? 

To provide audio during a meeting, you can use one of the following voice 

conferencing services: 

 Integrated call-in teleconference-A teleconference that a participant can join by 

calling a phone number. The number to call automatically appears in a message 

box when a participant joins a meeting. If your meeting service provides toll-free 

call-in teleconferencing, both a toll-free number and a toll number are available. 

The global call-in option provides a list of numbers-such as toll-free or local 

numbers-that attendees in other countries can call to join the teleconference. 

 Integrated call-back teleconference-A teleconference that a participant can join 

by providing his or her phone number when joining a meeting. The participant 

enters his or her number in a dialog box that appears when he or she joins the 

meeting. The teleconferencing service calls the participant at the number he or she 

provided. 
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 If your site includes the international call-back option, participants in other 

countries can receive a call back. For more information about this option, ask your 

meeting service site administrator. 

 Third-party or internal teleconference-Any teleconferencing service other than 

the integrated teleconferencing service. You can use any third-party 

teleconferencing service or internal teleconferencing system, and provide 

instructions for joining teleconference when setting up a meeting. Your 

instructions automatically appear in a message box when a participant joins the 

meeting. 

What are the system requirements for VoIP? 

To use VoIP, ensure that your computer meets the following system requirements: 

 A supported sound card 

For a current list of supported sound cards, refer to the Frequently Asked 

Questions page on your Meeting Center Web site. You can access this page from 

your site's Support page. 

 Speakers or headphones 

 Microphone, if you want to speak during the conference 

  

Tip: For better audio quality and greater convenience, use a computer headset with a high-quality 

microphone. 

When should I include VoIP? 

 Your meeting includes remote attendees who do not want to be charged for long-

distance phone calls. 

 Your meeting will not involve much interaction-for example, attendees will listen 

to a presentation instead of engage in a discussion. 

 You want to minimize the voice conferencing costs for the meeting. 

Check that your computer has the minimum system requirements for VoIP. For 

details, see About the Audio Conference Settings page  (on page 103). 

What is a dual-mode voice conference and when should I use it? 

You can set up a dual-mode voice conference for a scheduled or instant meeting-that 

is, a voice conference that includes both a teleconference and VoIP. In a dual-mode 

voice conference, participants can use either type of service. 
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In a dual-mode voice conference, a participant can listen to audio using either a phone 

or speakers attached to his or her computer. To speak, a participant can use either a 

phone or microphone attached to his or her computer. 

  

Note:  

 Participants in a teleconference can speak to and hear only other participants in the 

teleconference. Similarly, participants using VoIP can speak to and hear only other 

participants using VoIP. Thus, the dual-mode conference option is usually appropriate for a 

meeting in which participants will listen to a presentation only and not interact in the voice 

conference. 

 All participants can listen to a presentation if the presenter speaks into both a phone and a 

microphone. 

How can I learn about the fields on the Audio Conference Settings page? 

Click the Help link in the top right corner of the Audio Conference Settings page or 

review About the Audio Conference Settings page (on page 103). 

 
 

About the Invite Attendees page 

How to access this page 

On the navigation bar, click Host  a meeting > Schedule a meeting > Invite 

Attendees. 

  

 

 

  

What you can do on this page 

Invite attendees to your meeting, by entering their email addresses or selecting them 

from your address book. 
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Options on this page 

  

Use this option... To... 

Set options using template  Select a template and use the settings saved in that template for 

this meeting. 

You can save time by using a template that includes the list of 

attendees you want to invite, a presentation you want to show 

before the meeting starts, and other options you have used in a 

previous meetings and saved as a template. 

For more details about creating and editing templates, see Using 

meeting templates (on page 133). 

Attendees Enter the email addresses of the attendees you want to invite to 

your meeting. 

You can type the addresses, separating them with a comma or 

semicolon or you can click Select Attendees to choose attendees 

from your address book. 

Allow external attendees  Allow attendees located on the public internet to join your meeting. 

If unchecked, only attendees within the same internal network can 

join. 

Note: This option is available for Cisco Unified MeetingPlace 

users only. 

Request that attendees 

verify rich media players 

before joining meeting  

Add a request to invitation email messages for attendees to verify 

that these components are installed on their computers for playing 

a UCF media file: 

 Flash Player, for playing a Flash movie or interactive Flash 

files 

 Windows Media Player for playing audio or video files 

This option is useful if you or another presenter plans to share a 

UCF multimedia presentation or standalone UCF media files 

during the meeting. 

Send a copy of the invitation 

email to me  

Receive a copy of the invitation you are sending to attendees. 

Later, if you decide to invite additional attendees, you can simply 

forward this email message to them. 

Select Attendees/Edit 

Attendees button 

Opens the Select Attendees page. You can select contacts in your 

personal address book to invite to the meeting. 

You can also add a new contact to your address book and then 

invite that contact to your meeting. 

Security  Exclude password from email invitations: If you invite 

attendees to a meeting, the meeting password does not appear in 

the email invitations that attendees receive. You must provide the 
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Use this option... To... 

password to attendees by another means, such as by phone. 

Require attendees to have an account on this Web site to join 

this meeting: All attendees must have a user account on your 

site to attend the meeting.  

For information about how attendees can obtain a user account, 

ask your site administrator. 

 

 

Questions about inviting attendees 

What is an alternate host? 

When inviting attendees to a scheduled meeting, you can designate one or more 

attendees as alternate hosts for the meeting. An alternate host can start the meeting 

and act as the host. Thus, an alternate host must have a user account on your Meeting 

Center Web site. 

Once you invite an attendee to a meeting as an alternate host, the attendee receives an 

invitation email message that provides information about acting as the alternate host. 

Your scheduled meeting appears on the alternate host's My WebEx Meetings page. 

Can I invite people using my online address book? 

You do not have to type the email address of each person you want to invite to your 

meeting. You can select attendees and sales team members (for Sales Center 

meetings) from your address book. 

You can access your address book from the Invite Attendees page (for Meeting 

Center meetings) or the Invite Participants page (for WebEx Sales Center meetings) in 

the Advanced Scheduler. 

Which information is included in the email invitation to my meeting? 

Each attendee that you invited receives an invitation email message, which includes: 

 A link that the attendee can click to join the meeting or obtain more information 

about it 

 The meeting password, if you specified one 

 Teleconferencing information, if your meeting includes an integrated 

teleconference 

 The meeting number, which the attendee must provide if your meeting is unlisted 
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After you start a scheduled meeting, you can invite additional attendees. For details, 

see Inviting more people to your in-progress meeting (on page 5). 

Why should I request that attendees check their systems for UCF compatibility? 

When scheduling a meeting, you can add a request to invitation email messages for 

attendees to verify that the following components are installed on their computers for 

playing Universal Communications Format (UCF) media files: 

 Flash Player, for playing a Flash movie or interactive Flash files 

 Windows Media Player for playing audio or video files 

This option is useful if you or another presenter plans to share a UCF multimedia 

presentation or standalone UCF media files during the meeting. 

Your request automatically appears in any invitation email messages that you send to 

attendees using the Advanced Scheduler invitation options. Your request also includes 

a link that attendees can click to access the Verify Rich Media Players page on your 

Meeting Center Web site. This page allows attendees to automatically verify that the 

required players are installed on their computers. 

  

Note: If you intend to allow attendees to share to share UCF multimedia presentations or 

standalone UCF media files, ensure that the Enable UCF rich media for attendees check box is 

selected on the Meeting Options page in the Advanced Scheduler. 

How can I learn about the fields on the Invite Attendees page? 

Click the Help link in the top right corner of the Invite Attendees page, or review 

About the Invite Attendees page. 

Can I use my online address book to invite attendees? 

You do not have to type the email address of each person you want to invite to your 

meeting. You can select  attendees from your address book. 

You can access your address book from the Invite Attendees page in the Advanced 

Scheduler. 

How can I enhance meeting security? 

When scheduling a meeting, you can require all attendees to have a user account on 

your site. If you include this requirement (an option on the Invite Attendees page), 

attendees must log in to your Meeting Center Web site to attend the meeting, which 

enhances meeting security. 
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Each invited attendee automatically receives an invitation email message. To help 

increase the security for your meeting, you can prevent the meeting password from 

appearing in these invitations by selecting the Exclude password from email 

invitation option on the Invite Attendees page. If you exclude the password in email 

invitations, however, you must provide the password to attendees using another 

method-for example, by phone. 
 

About the Select Attendees page 

How to access this page 

On the navigation bar, click Host a Meeting> Schedule a Meeting > Invite 

Attendees > Select Attendees. 

What you can do on this page: 

 Select contacts in your personal address book and invite them to the meeting. 

 Add new contacts to your personal address book and invite them to the meeting. 

 Designate one or more invited attendees as alternate hosts. 

Options on this page 

  

Use this option... To... 

Address book  Lets you select the address book from which you want to select 

attendees. The contacts in the address book that you select appear in 

the box. The following address books are available: 

Personal contacts: Includes any individual contacts that you have 

added to your personal address book. If you use Microsoft Outlook, you 

can import the personal contacts that you keep in an Outlook address 

book or folder to this list of contacts. 

Company address book: Your organization's address book, which 

includes any contacts that your site administrator has added to it. If your 

organization uses a Microsoft Exchange Global Address List, your site 

administrator can import its contacts to this address book. 

New Contact Opens the New Contact page. Enter the requested information about the 

new contact you want to invite to the meeting. You can also add the new 

contact to your personal address book 

Search  Lets you search for text in the selected address book. For example, you 

can search for all or part of a contact name or email address 
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Use this option... To... 

Invite as  Attendee: Adds the selected contacts to the list of attendees. 

Alternate Host: Adds the selected contacts as alternate hosts to the list 

of attendees. An alternate host receives an invitation email message that 

provides information about acting as the alternate host. An alternate host 

can start the meeting and act as the host. If you join the meeting after an 

alternate host has started or joined it, you do not automatically assume 

the host role. 

An alternate host must have a user account on your meeting service 

Web site. 

Remove Removes the selected contacts from the list of invitees. 

 

About the Registration page 

How to access this page: 

On the navigation bar, click Host a Meeting> Schedule a Meeting > Registration 

  

 

What you can do on this page 

 Determine whether attendees must register to attend a meeting. 

 If attendees must register, select which information attendees must provide on the 

registration form. 

 Accept registration requests automatically. 



Chapter 5: Scheduling a Meeting 

 

114 

 

Options on this page 

  

Use this option... To... 

Set options using template  Select a template and use the settings saved in that template for 

this meeting. 

You can save time by using a template that includes the list of 

attendees you want to invite, a presentation you want to show 

before the meeting starts, and other options you have used in a 

previous meetings and saved as a template. 

For more details about creating and editing templates, see Using 

meeting templates (on page 133). 

Registration   None: Specifies that attendees need not register to attend the 

meeting. 

 Require attendee registration: All attendees must register to 

attend the meeting. An attendee cannot attend the meeting 

until his or her registration you accept his or her registration 

request. 

You can accept registration requests in either of two ways: 

 Automatically, by selecting the Automatically accept all 

registration requests option on this page. 

 Manually, by using the options on the Registered Attendees 

page. For details, see Accepting or Rejecting Registration 

Requests. 

 

Obtain detailed attendee 

information  

Select which information attendees must provide to register for the 

meeting. Information that you do not select still appears on the 

form, but attendees need not provide it to register for the meeting. 

Automatically accept all 

registration requests  

Accept all registration requests automatically, and lets all 

registrants attend the meeting. You do not receive registration 

requests. If this option is not selected, you must accept or reject 

each registration request individually, using the options on your 

meeting service Web site. 

 

 

Questions about registration 

What are the benefits of requiring attendees to register for a meeting? 

You can require meeting attendees to register for a meeting before they can join it. 

Requiring registration allows you to: 
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 View a list of attendees to determine whether they have registered for the meeting 

 Obtain attendees' names, email addresses, and optionally additional personal 

information before they can join the meeting 

 Accept or reject individual registration requests 

 Increase the security of your meeting 

If you invite an attendee to a meeting that requires registration, the attendee receives 

an invitation email message that includes information about the meeting and a link 

that the attendee can click to register for the meeting. 

  

Important: If you accept registration requests automatically for a meeting that requires a 

password—and an attendee registers after the meeting has already started—the attendee can join 

the meeting immediately, without providing the password. Therefore, to secure a meeting from 

unauthorized access, you must clear the Automatically accept all registration requests check box, 

and manually accept or reject all registration requests.  

If you do not accept registration requests automatically for a meeting that requires a password—

and an attendee registers after the meeting has already started—the attendee cannot join the 

meeting until he or she receives a registration confirmation email message and can provide the 

meeting password. During the meeting, you can check for registration requests in your email 

program and accept them to allow attendees to join the meeting. 

How do I accept or reject registration requests? 

If you scheduled a meeting for which attendees must register, you can accept or reject 

attendees' registration requests. If you accept a registration request, a registration 

confirmation email message which provides the meeting password, if any is sent the 

attendee. If you reject a registration request, a registration rejection email message is 

sent to the attendee.  

  

Note: If you select the Automatically accept all registration requests check box on the 

Registration page, all registration requests are accepted automatically and a registration 

confirmation email message is sent to each attendee who registers. 

To accept or reject registration requests: 

1 Log in to your meeting service Web site. For details, see Logging In to Your 

Meeting Service Web Site. 

2 On the navigation bar, click My WebEx. 

The My Meetings page appears, showing a list of any meetings that you have 

scheduled. 
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3 In the list of meetings, click the meeting topic link for the meeting for which you 

want accept or reject registration requests. 

The Meeting Information page appears. 

4 Click Attendees. 

The Registered Attendees page appears, showing a list of attendees who have 

registered for the meeting.  

5 Select the check box for each attendee for whom you want to accept or reject a 

registration request.  

 To select all attendees currently appearing in the list, click Select All.  

 To clear all selections in the current list, click Clear All.  

6 Opt to approve or reject selected registration requests. 

 Click Accept to approve the registration requests for all attendees that you 

selected 

 Click Reject to reject the registration requests for all attendees that you 

selected. 

  

Tip: You can sort the registered attendees list by clicking the column headings. 

You can also open the Registered Attendees page by selecting the meeting on the public Browse 

Meetings page. Then click Get Info> Attendees. 

How can I learn about the fields on the Registration page? 

Click the Help link in the top right corner of the Registration page, or review About 

the Registration page (on page 113). 
 

About the Agenda & Welcome page 

How to access this page 

On the navigation bar, click Host a meeting > Schedule a meeting > Agenda & 

Welcome. 
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What you can do on this page 

 Enter an agenda for your meeting. 

 Choose a template for the Info tab in the Meeting window. 

 Automatically show a document or presentation to participants once they join the 

meeting. 

Options on this page 

  

Use this option... To... 

Set options using template  Select a template and use the settings saved in that template for 

this meeting. 

You can save time by using a template that includes the list of 

attendees you want to invite, a presentation you want to show 

before the meeting starts, and other options you have used in a 

previous meetings and saved as a template. 

For more details about creating and editing templates, see Using 

meeting templates (on page 133). 

Agenda  Set the agenda for the meeting. You can type up to 2500 

characters, including spaces and punctuation. The agenda 

appears on the Meeting Information page for the meeting on your 

meeting service Web site. 

Info tab templates  Lets you choose a template for the Info tab, which appears in the 

content viewer during the meeting. The Info tab contains 

information about the meeting, such as the: 
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Use this option... To... 

 Meeting host 

 Teleconference phone numbers 

 Host key (if you are the host) 

If you are using WebEx Sales Center:You can choose another 

template only if your site administrator has provided one or more 

customized Info tab templates for your meeting service. 

Automatically share 

presentation or document 

once a participant joins the 

meeting  

Select a presentation or document to share automatically. after a 

participant joins the meeting. This option is useful if you allow 

attendees to join the meeting before the host. 

The file that you select must: 

 Be in the Universal Communications Format (UCF). For 

information about creating UCF files, refer to the guide, 

Getting Started with WebEx Universal Communications 

Toolkit, which is available on your meeting service Web site. 

 Reside in your personal folders on your meeting service Web 

site. You can select a UCF file that already resides in your 

folders, or upload a new file to your folders while scheduling a 

meeting. 

 Browse Opens the Add/Select Presentation page. You can select a UCF 

presentation or document that resides in your personal folders, or 

upload a new file to your folders. 

 Delete Delete the selected presentation or document from the box. 

Start automatically  Have presentation slides or document pages advance 

automatically in the content viewer at the time interval you choose. 

 Select this option only if the presentation or document 

contains multiple slides or pages. 

 Do not select this option if the presentation or document 

contains UCF media files. 

Continuous play: Available only if you select Start automatically. 

Specifies that shared presentation or document restarts once it is 

finished, and continues advancing page automatically. 

Advance page every [x] seconds: Available only if you select 

Start automatically. Lets you select the frequency at which slides 

or pages advance automatically. 

 Allow participants to control file: Let participants navigate the 

presentation or document independently in their content viewers. 

The slides or pages do not advance automatically. 
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Use this option... To... 

Select this option if the presentation or document contains only 

one slide or page, or if it contains any UCF rich media objects, 

such as audio or video objects. 

Quick Start  Select this option to display the Quick Start page to host and 

presenter at the start of the meeting. If not selected, the Info page 

displays at the start of the meeting. 

The Quick Start page provides easy access for sharing a 

document, application, Web browser or other item with 

participants. 

 

About the Add/Select Presentation page 

How to access this page 

On the navigation bar, click Host a Meeting >Schedule a Meeting >Agenda & 

Welcome > Browse. 

What you can do on this page  

 Upload a new Universal Communications Format (UCF) file to your personal 

folders, and then select it 

 Select an UCF presentation or document that already resides in your personal 

folders 

The file that you select plays automatically for a participant once the participant joins 

the meeting. 

  

Tip: The file that you select must be in the WebEx Universal Communications Format (UCF). 

Options on this page 

  

Use this option... To... 

Upload a file to My Folders Select a UCF presentation or document that resides on 

your computer, and upload it to your personal folders. 

To upload a file, under Select, select the folder in which 

you want to upload the file.Click Browse, select the file 

on your computer, and then click Open.Click Upload. 

Select a presentation to share 

automatically 

Select a UCF presentation or document that already 

resides in your personal folders. 
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Use this option... To... 

Upload a file to My Folders Select a UCF presentation or document that resides on 

your computer, and upload it to your personal folders. 

To upload a file, under Select, select the folder in which 

you want to upload the file.Click Browse, select the file 

on your computer, and then click Open.Click Upload. 

Done Save your file selection, and then return to the Agenda & 

Customizable Welcome page 

 

Questions about setting the agenda and welcome message 

Can I change how the information on the Info tab displays? 

You can choose a template for the Info tab, which appears in the content viewer 

during the meeting. The Info tab contains information about the meeting, including 

the meeting host, teleconference phone numbers, and host key (for the host only). 

  

Note: You can choose another template only if one or more customized Info tab templates are 

available for your meeting service. Your site administrator can add templates for your service. 

What is the Quick Start page? 

The Quick Start page allows a presenter to quickly display a document, application or 

other item they want to share during a meeting. If the Quick Start option is selected by 

the host on the Meeting Agenda & Welcome page, Quick Start is available to 

participants throughout the meeting by clicking the Quick Start tab in the content 

viewer. 

For more details about any of the actions available from Quick Start, click the Learn 

More link. 

Can I change the meeting agenda or add one after I have set up my meeting 

You can easily edit a scheduled meeting. You can edit it from the link in the 

confirmation email message you received or from your Meeting Center Web site. For 

detailed instructions, see Editing a scheduled meeting (on page 129). 
 

Why share a document before the meeting starts? 

When scheduling a meeting, you can select a presentation or document to share 

automatically in the content viewer once a participant joins the meeting. If the 

presentation or document contains multiple pages, you can also automatically advance 

its pages at a specified interval. 
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You can use this opportunity to share a presentation that informs or entertains 

participants while they wait for you to start the meeting. 

The presentation or document that you select must: 

 Be in the Universal Communications Format (UCF). For information about 

creating UCF files, review the Getting Started with WebEx Universal 

Communication Toolkit, available on your Meeting Center Web site; click 

Support > User Guides from the Welcome page. 

 Reside in your personal folders in the My WebEx area on your Meeting Center 

Web site. You can select a UCF file that already resides in your folders, or upload 

a new file to your folders while scheduling a meeting. 

  

Important: If you sharIe a UCF multimedia presentation that includes rich media files-such as 

audio or video files-follow these guidelines: 

 Ensure that each media file is embedded in the presentation file or resides on a publicly 

accessible Web server. If the presentation contains a link to a media file that resides on your 

computer, participants cannot view that media file. For more information about creating 

UCF multimedia presentations, refer to the guide Getting Started with WebEx Universal 

Communications Toolkit, which is available on your Meeting Center Web site. 

 Select Allow participants to control file on the Agenda and Welcome page. If you do not 

select this option, the pages or slides in the document or presentation will advance 

automatically, which may prevent participants from viewing the media files. 

 Ensure that each media file is set to play automatically for participants. For more 

information about setting this option for a UCF media file, refer to the guide Getting Started 

with WebEx Universal Communications Toolkit, which is available on your Meeting Center 

Web site. 

How can I learn about the fields on the Agenda & Welcome page? 

Click the Help link in the top right corner of the Agenda & Welcome page, or review 

About the Agenda & Welcome page (on page 116). 
 

 

About the Meeting Options page 

How to access this page 

On the navigation bar, click Host a Meeting > Schedule a Meeting > Meeting 

Options. 
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What you can do on this page 

 Select which options, such as chat, notes, and video are available during the 

meeting. 

 Allow presenters to transfer files and meeting participants to download these files 

of the meeting. 
 

 Specify whether attendees can share UCF rich media files. 
 

Options on this page 

  

Use this option... To... 

Set options using template  Select a template and use the settings saved in that template for 

this meeting. 

You can save time by using a template that includes the list of 

attendees you want to invite, a presentation you want to show 

before the meeting starts, and other options you have used in a 

previous meetings and saved as a template. 

For more details about creating and editing templates, see Using 

meeting templates (on page 133). 

Meeting Options  

 

Select which meeting options are available during the meeting. If 

an option is not selected, it is unavailable during the meeting. 

A presenter can turn any option on or off during the meeting 

 Chat: Specifies that chat options are available in the Meeting 

window during the meeting.  
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Use this option... To... 

 Video: Specifies that video options are available in the Meeting 

window during the meeting. 

 Turn on high-quality video: Video can be as high as 360p 

resolution (640x360). However, the quality of the video that 

participants can send and receive depends on each 

participant's webcam, computer capability, and network speed.  

 Turn on high-definition video: Allows participants to send or 

receive HD video with up to 720p resolution. However, the 

quality of the video that participants can send and receive 

depends on each participant's webcam, computer capability, 

and network speed.  

Check Turn on high-quality video before you can turn on the 

HD video option. 

 View video thumbnails: Allows participants to switch from 

viewing Participant List to video thumbnails of participants. If 

the option is turned off, participants will see only the active 

speaker's video and their self-views.    

 
 

Notes Specifies that note-taking options are available in the 

Meeting window during the meeting. 

 Allow participants to take notes: Lets all participants take 

their own notes during the meeting, and save them to their 

computers. 

 Single note taker: Lets only one participant take notes during 

the meeting. By default, the host is the note-taker, but can 

designate another participant as the note-taker during the 

meeting. A note-taker can publish notes in all participants' 

Meeting windows at any time during the meeting. The host can 

send a transcript of the notes to participants at any time. 

 Enable closed captioning: Lets one participant-the closed 

captionist-transcribe notes during the meeting. Closed captioning 

is useful if hearing-impaired participants are attending the 

meeting. By default, the host is the closed captionist, but can 

designate another participant as the closed captionist during the 

meeting. Meeting Manager publishes closed captions in all 

participants' Meeting windows once the closed captionist presses 

the Enter key on his or her keyboard. Thus, notes are usually 

published one line at a time. The host can send a transcript of the 

closed captions to participants at any time. 

 File transfer: Specifies that the presenter can publish files and 

attendees can download them during a meeting.  
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 Enable UCF rich media for attendees: Allows attendees to 

share Universal Communications Format (UCF) media files during 

the meeting, either in a UCF multimedia presentation or as 

standalone UCF media files. A meeting host who is also the 

presenter can always share UCF media files, whether or not you 

select this check box. 

  

Note: A presenter can change the default privileges for all attendees or individual attendees at 

any time during a meeting. 

 

Questions about setting meeting options 

What are some rules of thumb for sharing UCF media files? 

When scheduling a meeting, you can allow attendees to share Universal 

Communications Format (UCF) media files during the meeting, either in a UCF 

multimedia presentation or as standalone UCF media files. 

You can also prevent attendees from sharing UCF media files during a meeting. If 

you do so, only the meeting host can share UCF media files when also acting as the 

presenter. 

You may want to prevent attendees from sharing UCF media files, for example, if you 

intend to allow attendees to share presentations or documents but want to prevent an 

attendee from inadvertently sharing a very large media file. 

  

Note: The alerts options are applicable only if you select an integrated teleconference on the 

Teleconference page in the Advanced Scheduler. For more information about setting up an 

integrated teleconference, see About the Teleconference Settings page (on page 103). 

How can I learn about the fields on the Meetings Options page? 

Click the Help link in the top right corner of the Meeting Options page, or review 

About the Meeting Options page (on page 121). 
 

About the Attendee Privileges page 

How to access this page 

On the navigation bar, click Host a meeting > Schedule a meeting > Attendee 

Privileges. 
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What you can do on this page 

 Select the meeting privileges that attendees have once the meeting starts. 

  

Note: A presenter can grant any privileges to or remove them from attendees during a meeting 
 

Options on this page 

  

Use this option... To... 

Set options using template  Select a template and use the settings saved in that template for 

this meeting. 

You can save time by using a template that includes the list of 

attendees you want to invite, a presentation you want to show 

before the meeting starts, and other options you have used in a 

previous meetings and saved as a template. 

For more details about creating and editing templates, see Using 

meeting templates (on page 133). 

Privileges  Select privileges that you want attendees to have when meeting 

begins. 
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Use this option... To... 

 Save  Save any shared documents, presentations, or whiteboards that 

appear in their content viewers. 

 Print Print any shared documents, presentations, or whiteboards that 

appear in their content viewers. 

 Annotate  Annotate any shared documents or presentations, or write and 

draw on shared whiteboards that appear in their content viewers, 

using the toolbar that appears above the viewer. An attendee's 

annotations are visible to all participants. 

 View participant list View the participant list on the Participants panel. 

 View thumbnails Display miniatures of any pages, slides, or whiteboards in any 

document, presentation, or whiteboard that appear in their 

content viewers. 

However, attendees with this privilege cannot display a miniature 

at full size unless they also have the View any page privilege. 

 Control applications, 

Web browser, or 

desktop remotely 

Request that the presenter grant them remote control of a shared 

application, Web browser, or desktop. 

 View any document View any document, presentation, or whiteboard that appears in 

the content viewer, and navigate to any pages or slides in 

documents or presentations. 

 View any page View any pages, slides, or whiteboards that appear in their 

content viewers. This privilege allows attendees to navigate 

independently through pages, slides, or whiteboards 

 Contact operator 

privately 

Dial 00 at any time during a teleconference to contact the 

operator for your teleconferencing service. 

Available only if your site includes the private operator option. 

 Participate in private 

chat with: 

Send private chat messages to another participant. Private chat 

messages appear only in the recipient's Chat viewer. 

Host: Chat privately with the meeting host. 

Presenter: Chat privately with only the presenter. 

All attendees: Chat privately with any other attendee. 
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Questions about attendee privileges 

Besides the host, who can grant and remove attendee privileges? 

A presenter can grant any privileges to or remove them from attendees during a 

meeting. 

Can I change attendee privileges during a meeting? 

Yes, you can. On the Meeting menu, choose Attendees Privileges. Make any changes 

to the privileges you set when you scheduled the meeting. 

How can I learn about the fields on the Attendee Privileges page? 

Click the Help link in the top right corner of the Attendee Privileges page, or review 

About the Attendee Privileges Page (on page 124). 
 

About the Review page 

How to access this page 

On the navigation bar, click Host a Meeting > Schedule a Meeting > Review. 

What you can do on this page 

 Review all the information you've entered on each page of the Advanced 

Scheduler. 

 If you want to make any changes, return to the page where you entered the 

information and enter new information. 

 Rather than using the settings and options you have just selected in the scheduler, 

replace these setting with those in one of the meeting templates.  

For more details about creating and editing templates, see Using meeting 

templates (on page 133). 

When you have finished making changes, click Schedule or Start. 
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Managing and maintaining your scheduled 
meetings 

You can easily invite more participants to a scheduled meeting, change the day or 

time, or even add the meeting to your calendar program. 

  

If you want to... See... 

add a scheduled meeting to your calendar Adding a scheduled meeting to your calendar 

program (on page 128) 

make changes to a scheduled meeting Editing a scheduled meeting (on page 129) 

start a scheduled meeting Starting a scheduled meeting (on page 130) 

cancel a scheduled meeting Canceling a scheduled meeting (on page 132) 

 

Adding a scheduled meeting to your calendar program 

Once you schedule a meeting, you can add the meeting to your calendar program, 

such as Microsoft Outlook. This option is applicable only if your calendar program 

supports the iCalendar standard, a common format for exchanging calendaring and 

scheduling information across the Internet. 

To add a scheduled meeting to your calendar: 

1 Do one of these tasks, as appropriate: 

 On the Meeting Scheduled page, click Add to My Calendar. 

 On the Meeting Updated page, click Update My Calendar. 

 On the Meeting Information page for the meeting, click Add to My 

Calendar. 

 In the confirmation email message that you receive once you schedule or edit 

a meeting, click the link to add the meeting to your calendar. 

A meeting item opens in your calendar program. 

2 Select the option to accept the meeting request. For example, in Outlook, click 

Accept to add the meetingitem to your calendar. 

  

Note:  
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 If you cancel a meeting, the Meeting Deleted confirmation page and the confirmation email 

message that you receive contains an option that lets you remove the meeting from your 

calendar program. 

 If you invite attendees to a meeting, the invitation email message that they receive contains 

an option to add the meeting to their calendar programs. 

 

Editing a scheduled meeting 

Once you schedule a meeting, you can make changes to it at any time before you start 

it-including its starting time, topic, password, agenda, attendee list, and so on. 

If you update any information about a meeting, including adding or removing 

attendees, you can choose to send attendees a new invitation email message that 

informs them that you have modified information about the meeting. Attendees whom 

you removed from the attendee list receive an email message informing them that you 

have retracted their invitations. 

You can modify a meeting from the confirmation email message that you received 

after you scheduled the meeting or from your meeting list in My WebEx. 

To edit a meeting from the confirmation email message: 

1 Open your confirmation email message, and then click the link. 

If you are not already logged in to your Meeting Center Web site, the Log In page 

appears. 

2 If the Log In page appears, provide your account user name and password, and 

then click Log In. 

The Meeting Information page appears. 

3 Click Edit. 

4 Modify the meeting. For more information about the options that you can modify, 

see Using the Advanced Scheduler. 

5 To save your changes to the meeting, click Save. 

If you invited attendees, a message appears, asking you whether you want to send 

an updated email invitation to attendees. 

6 If a message box appears, click the appropriate update option, and then click OK. 

The Meeting Updated page appears. 

You receive a confirmation email message that includes information about the 

changes that you made to the meeting. 
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7 Optional. If you added the meeting to your calendar program, such as Microsoft 

Outlook, on the Meeting Updated page, click Update My Calendar. 

To edit a scheduled meeting from your meeting list on your Meeting Center Web site: 

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, click My WebEx. 

The My Meetings page appears, displays each meeting that you have scheduled. 

3 In the meeting list, under Topic, click the topic for the meeting. 

4 Click Edit. 

5 Modify the meeting. For more information about the options that you can modify, 

see Using the Advanced Scheduler. 

6 Click Save. 

If you invited attendees, a message appears, asking you whether you want to send 

an updated email invitation to attendees. 

7 If a message box appears, click the appropriate update option, and then click OK. 

If you click Cancel in the message box, the meeting is not updated. 

The Meeting Updated page appears. You receive a confirmation email message 

that includes information about the changes that you made to the meeting. 

8 Optional. If you added the meeting to your calendar program, such as Microsoft 

Outlook, in the confirmation email message, click Update My Calendar. 
 

Starting a scheduled meeting 

A meeting does not start automatically at the scheduled time. If, when scheduling the 

meeting, you did not select the option that allows participants to join the meeting 

before the host, you must start the meeting before participants can join it. 

After you schedule a meeting, you receive a confirmation email message that includes 

a link that you can click to start the meeting. Or, you can start the meeting from your 

meeting list in My WebEx. 

To start a meeting from the confirmation email message: 

1 Open your confirmation email message, and then click the link. 

If you are not already logged in to your Meeting Center Web site, the Log In page 

appears. 
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2 If the Log In page appears, provide your account username and password, and 

then click Log In. 

The Meeting Information page appears. 

3 Click one of the following: 

 Start Now. Appears if the meeting is not in progress. 

 Join Now. Appears if you allowed participants to join the meeting before its 

starting time and participants have already joined the meeting. 

The Meeting window appears. 

To start a scheduled meeting from your meeting list on your Meeting Center Web site: 

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, click My WebEx. 

The My Meetings page appears, displaying a list of each meeting that you have 

scheduled. 

3 In the meeting list, under Status, click one of the following: 

 Start. Appears if the meeting is not in progress. 

 Join Now. Appears if you allowed participants to join the meeting before its 

starting time and participants have already joined the meeting. 

The Meeting window appears. 
 

Starting a meeting from your iPhone 

A meeting does not start automatically at the scheduled time. If, when scheduling the 

meeting, you did not select the option that allows participants to join the meeting 

before the host, you must start the meeting before participants can join it. 

  

Note: To start a WebEx meeting from your iPhone, you must have set up your WebEx account 

from the Profile page in your iPhone application. 

To start a meeting from an email invitation link: 

In your email invitation, tap the meeting link. 

The WebEx Meeting Center application launches. 

To start a meeting from your My Meetings page: 

1 Tap the meeting you want to start 
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2 On the next page, tap on the Join/Start button. 

The WebEx Meeting Center application launches. 

For detailed information about all aspects of using your iPhone to start or attend 

meetings, visit our website http://www.webex.com/apple/. 
 

Canceling a scheduled meeting 

You can cancel any meeting that you have scheduled. Once you cancel a meeting, you 

can choose to send a cancellation email message to all attendees whom you invited to 

the meeting. Canceling a meeting deletes it from your personal meeting list. 

You can cancel a meeting from the confirmation email message that you received 

after you scheduled the meeting or from your meeting list in My WebEx. 

To cancel a meeting from a confirmation email message: 

1 Open your email confirmation message, and then click the link. 

If you are not already logged in to your Meeting Center Web site, the Log In page 

appears. 

2 If the Log In page appears, provide your account user name and password, and 

then click Log In. 

The Meeting Information page appears. 

3 Click Delete. 

If you invited attendees, a message appears, asking you whether you want to send 

a cancellation email message to all attendees whom you invited to the meeting. 

4 In the message box, click Yes or No, as appropriate. 

If you click Cancel in the message box, the meeting is not canceled. 

The Meeting Deleted page appears. 

5 Optional. If you added the meeting to your calendar program, such as Microsoft 

Outlook, on the Meeting Deleted page, click Remove From My Calendar to 

remove the meeting from your calendar. 

To cancel a scheduled meeting from your meeting list on your Meeting Center Web 

site: 

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, click My WebEx. 

http://www.webex.com/apple/
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The My Meetings page appears, showing your scheduled meeting list. 

3 In the meeting list, under Topic, click the topic for the meeting. 

4 Click Delete. 

If you invited attendees, a message appears, asking you whether you want to send 

a cancellation email message to all attendees whom you invited to the meeting. 

5 In the message box, click Yes or No, as appropriate. 

If you click Cancel in the message box, the meeting is not canceled. 

You receive a cancellation confirmation email message. 

6 Optional. If you added the meeting to your calendar program, such as Microsoft 

Outlook, in the confirmation email message, click the link to remove the meeting 

from your calendar. 
 

Saving time when scheduling a meeting 
  

If you want to... See... 

use a template with preset options when 

scheduling your meeting 

Using an existing meeting template for scheduling 

a meeting (on page 134) 

use a template with preset options and save 

your changes to the template 

Using an existing meeting template and 

overwriting the template settings (on page 135) 

use a template with preset options and save 

the changes in a new template 

Using an existing meeting template and saving 

the changes in a new template (on page 136) 

set up a recurring meeting Setting up a recurring meeting (on page 137) 

 

Using meeting templates 

If you meet with the same group of people and often schedule a meeting with the 

same tracking codes, audio settings and other meeting options, you can save these 

settings in a template. When you set up the first meeting, you can save your settings in 

a template. Later, when it is time to schedule another meeting, you can select that 

template from any page on the Quick Scheduler or Advanced Scheduler. 

You have three ways to use an existing meeting template: 

 Use the template, without saving any changes to it 



Chapter 5: Scheduling a Meeting 

 

134 

 

You can use the template as is or make changes to the settings without saving 

these changes to the template itself. For details, see Using an existing meeting 

template for scheduling a meeting (on page 134). 

 Make changes to the template settings and save the changes in the template 

You can save these changes in the template, if you want to make permanent 

changes to the template. For details, see Using an existing meeting template and 

overwriting the template settings (on page 135). 

 Make changes to the template settings and save them in a new template 

You can make changes to the template as you schedule your meeting. Then save 

your changes in the template, if you want to make a permanent change to the 

template. 

For details, see Using an existing meeting template and saving the changes in a 

new template (on page 136). 
 

Using an existing  template for scheduling 

You can use the template without making changes to any details, or you can make 

changes on any page in the scheduler. 

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, expand Host a meeting to view a list of links. 

3 Click Schedule a meeting. 

The meeting scheduler appears. 

4 Select the template you want to use in the Set options using template drop-down 

list. 

Look for the list on any title bar in the Quick Scheduler or Advanced Scheduler. 

  

 

These templates are available. You can select one from this list 

and use it to quickly schedule your meeting 

The template in brackets is the default template provided by your 

site administrator. 

5 Optional. Make changes to the settings on any page.  

For instance, you can add or remove attendees or show a new presentation as 

attendees join the meeting. Just go to the page in the scheduler that you want to 

change. 
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6 Start or schedule the meeting: 

 If the meeting's starting time is the current time, click Start to start the 

meeting. 

 If the meeting's starting time is after the current time, click Schedule. 

The Meeting Scheduled page appears, confirming that the meeting is scheduled. 

You also receive a confirmation email message that includes information about 

the scheduled meeting. 
 

Using an existing meeting template and overwriting the template 
settings 

You can open an existing meeting template and change the settings. You can save 

your changes to the template. 

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, expand Host a meeting to view a list of links. 

3 Click Schedule a meeting. 

The meeting scheduler page appears. 

4 Select the template you want to use in the Set options using template drop-down 

list. 

  

 

These templates are available. You can select one from this list and use it 

to quickly schedule your meeting. 

The template in brackets is the default template provided by your site 

administrator.  

5 Make changes to the details on any page.  

For example, you can add or remove attendees, change the meeting time, add a 

multimedia document to display before the meeting starts. For details about fields 

on each page, see Page-by-page guide to the Advanced Scheduler (on page 95). 

6 Click Save as Template. 

You see a list of templates you can assign these new settings to. 

7 To update an existing meeting template with your changes, select the template 

you want to change and click Save. 

A message box appears, asking if you want to replace the template you have 

selected with the edited template. 
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8 To save your changes in the template, click OK. 

  

 

Type a name for this new version of the 

template here.  

Then click Save. 

Note: You have not changed the original 

template. 

 

Using an existing meeting template and saving the changes in a new 
template 

You may host a meeting series with the same agenda, but different attendees. To save 

time, you can reuse the settings in a template, make changes (such as adding or 

removing attendees) and then save the updates in a new template. 

Find the existing meeting template with similar settings. You can save the changes in 

a new template. 

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, expand Host a meeting to view a list of links. 

3 Click Schedule a meeting. 

The meeting scheduler appears. 

4 Select the template you want to use in the Set options using template drop-down 

list. 

  

 

5 Make changes to the details on any page. 

For example, you can add or remove attendees, change the meeting time, add a 

multimedia document to display before the meeting starts. For details about fields 

on each page, see Page-by-page guide to the Advanced Scheduler (on page 95). 

6 Click Save as Template. 
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7 In the Template Name box, type a name for this new template. 

  

 

8 Click Save. 
 

Setting up a recurring meeting 

For a meeting that occurs on a regular basis, such as a monthly company meeting or 

weekly status meeting, you can set up a recurring meeting. You set up the meeting 

one time and include the email addresses of attendees, the teleconferencing details, 

the time and interval (for instance, daily, weekly, or monthly). You send out one 

invitation for the entire series. 

To set up a recurring meeting: 

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, expand Host a meeting to view a list of links. 

3 Click Schedule a meeting. 

The Schedule a meeting Wizard appears, showing the Required Information page. 

4 Click Date & Time. 

Set the date and time for the meeting. Review the information below about the 

options for a recurring meeting. 

5 Add other details about your recurring meeting. For details information about the 

other pages in the Advanced Scheduler, see Page-by-page guide to the Advanced 

Scheduler (on page 95). 

6 When you have finished scheduling your meeting, click Schedule or Start. 
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Options for setting up a recurring meeting 

  

Option Description 

Daily Repeats the meeting every day until the ending date that you select. 

 Every [x] days: Repeats the meeting after the specified number of days 

pass. 

 Every weekday: Repeats the meeting each day, from Monday to Friday. 

 Weekly: Repeats the meeting every week until the ending date that you 

select. 

 Sunday - Saturday: Specifies the day on which the meeting repeats 

every week. You can select one or more days. 

Monthly Repeats the meeting every month until the ending date that you select. 

 Day [x] of every [x] months: Specifies the specific day of the month on 

which to repeat the meeting, and the number of months that pass before 

the meeting repeats. 

 [x] [x] of every [x] months: Specifies the specific week and day of the 

week on which to repeat the meeting, and the number of months that 

pass before the meeting repeats. 

Yearly Repeats the meeting every year until the ending date that you select. 

 Every [month] [date]: Specifies the specific month and date on which to 

repeat the meeting each year. 

 [x] [day] of [month]: Specifies the specific week, day of the week, and 

month on which to repeat the meeting each year 

Ending  No end date: Repeats the meeting indefinitely. That is, the meeting 

recurs until you cancel it. 

 Ending: Specifies the last day on which the meeting recurs. You can 

select the month, day, and year in the drop-down lists. Or, you can click 

Calendar icon, and then select a date. 

After [x] meetings: Specifies the number in the meeting series after which 

the meeting stops recurring. 

 

Allowing another user to schedule meetings for you 

You can grant permission to one or more Meeting Center users to schedule meetings 

on your behalf. A user to whom you grant permission to schedule meetings must have 

an account on your Meeting Center Web site. 

Once a user schedules a meeting for you, the meeting appears in your list of meetings 

on your My Meetings page. You can then start the meeting and host it as you 

normally do when you schedule meetings yourself. 
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To allow another user to schedule meetings for you: 

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, click My WebEx. 

3 Click My Profile. 

The My Profile page appears. 

4 Under Session Options, do either or both of the following: 

 In the Scheduling permission box, type the email addresses of the users to 

whom you want to grant scheduling permission. Separate multiple addresses 

with either a comma or semicolon. 

 Click Select From Host List to select users from a list of all users who have 

accounts on your Meeting Center Web site. 

5 Click Update. 
 

About the Meeting Scheduled page (for meeting 
hosts) 

This confirmation page appears after you have scheduled a meeting successfully. 

What you can do on this page 

 Add this meeting to your meeting calendar (MS Outlook or Lotus Notes) 

 Edit the details about the meeting you have just scheduled 

  

Click this button... To... 

 
Add this meeting to your calendar program (MS Outlook or 

Lotus Notes only). 

 

Make changes to the meeting you have just scheduled. For 

example, you can change the day and time or invite 

additional attendees 
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About the Meeting Information page (for meeting 
hosts) 

This page provides the details about a meeting you have scheduled. 

What you can do on this page 

 Review the date, time, duration, and other helpful information about the meeting 

 Edit the details about the meeting you have just scheduled 

 Start the meeting 

 Add the meeting to your calendar, if you haven’t already done so 

  

Click this button... To... 

 

Start this meeting immediately.  

Appears only if the meeting is not yet in progress. 

 

Edit the details about this meeting. For example, you can add 

attendees, change the agenda, change the date, time, and 

duration. 

 
Cancel this meeting 

 

View the list of registered attendees. 

Appears only if the meeting requires attendees to register. 

 

Review the meeting agenda. 

To edit or add an agenda, click Edit and then go to the Edit 

and Customizable Welcome page. 

 

Add this meeting to the calendar program, such as Microsoft 

Outlook. 

To use this feature, your calendar program must conform with 

the iCalendar standard, a format used widely across the 

Internet for exchanging calendar information. 

 
Return to the meeting calendar 
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About the Meeting Information page (for 
attendees) 

This page provides the details about a meeting you have scheduled. 

What you can do on this page 

 Review the date, time, duration, and other helpful information about the meeting 

 Add the meeting to your calendar, if you haven’t already done so 

  

Click this button... To... 

 

Join this meeting.  

If this meeting requires you to register, the registration form 

for this meeting appears. 

Appears only if the host has started this meeting. 

 
Review the meeting agenda 

 

Add this meeting to the calendar program, such as 

Microsoft Outlook. 

To use this feature, your calendar program must conform 

with the iCalendar standard, a format used widely across 

the Internet for exchanging calendar information. 

 
Return to the meeting calendar 

 

About the Meeting Updated page 
This confirmation page displays after you have updated a meeting successfully. 

What you can do on this page 

 Add this meeting to your meeting calendar (MS Outlook or Lotus Notes) 

 Make additional changes to the meeting you have just updated 
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Click this button... To... 

 

Add this updated meeting to your calendar program (MS 

Outlook or Lotus Notes only). 

 

Make changes to the meeting you have just updated. For 

example, you can change the day and time or invite 

additional attendees 
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Chapter 6  

  

If you want to... See... 

Get an overview of Personal 

Conference meetings and 

MeetingPlace Personal 

Conference meetings 

About Personal Conference and MeetingPlace Personal 

Conference meetings (on page 144) 

Set up a Personal Conference or 

MeetingPlace Personal 

Conference meeting 

Setting up a Personal Conference or MeetingPlace Personal 

Conference meeting (on page 144) 

Add a scheduled Personal 

Conference  

Adding a scheduled Personal Conference meeting to your 

calendar program (on page 147) 

Make changes to the Personal 

Conference meeting you have 

scheduled 

Editing a Personal Conference meeting (on page 148) 

Start your Personal Conference 

meeting 

Starting a Personal Conference meeting (on page 145) 

Start your MeetingPlace Personal 

Conference meeting 

Starting a MeetingPlace Personal Conference meeting (on 

page 146) 

Cancel your Personal meeting Canceling a Personal Conference meeting (on page 149) 

 

Scheduling a Personal 
Conference meeting or 
MeetingPlace Personal 
Conference meeting 
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About Personal Conference and MeetingPlace 
Personal Conference meetings 

A Personal Conference meeting includes an audio portion and an online portion. You 

start the audio portion first, and as soon as it starts, the online portion is automatically 

created on your WebEx service site. If you are in the audio portion of the meeting and 

need to share a presentation, document, or application with meeting participants, you 

can start the online portion of the Personal Conference meeting and the participants 

can join it while still participating in the audio portion of the Personal Conference 

meeting. Personal Conference meetings are only available if your site supports 

Personal Conferencing. 

A MeetingPlace Personal Conference meeting uses your Cisco Unified MeetingPlace 

audio conferencing account for the audio conference, and does not have an online 

portion for the meeting. MeetingPlace Personal Conference meetings are only 

available if your site supports Cisco Unified MeetingPlace audio conferencing and 

MeetingPlace Personal Conferencing. 
 

Setting up a Personal Conference meeting or MeetingPlace 
Personal Conference meeting 

To set up a Personal Conference meeting or MeetingPlace Personal Conference 

meeting: 

1 Log in to your Meeting Center website. 

2 On the left navigation bar, select Schedule a Meeting. 

3 Select Advanced Scheduler. 

The Advanced Scheduler displays. 

4 On the Required Information page, for Meeting type, select Personal 

Conference or MeetingPlace Personal Conference. 

5 Enter the requested information. 

  

 Note: If you are scheduling a Personal Conference meeting, you do not need to specify a 

password. By default, the password is the attendee access code in your Personal Conference 

number account that is specified for this meeting. If you are scheduling a MeetingPlace 

Personal Conference, you do need to specify a password 
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For an overview of this page and the information requested, select the Help button 

in the upper-right corner of the page. 

  

 

 

6 Schedule your meeting now, or add more details. 

 To schedule your meeting with these details, select Schedule Meeting 

 To add more options, select Next or select another page in the scheduler. 

After you have added the details you need, select Schedule Meeting. 
 

Starting a Personal Conference meeting 

Personal Conference meetings do not start automatically at scheduled times. You 

must start the audio portion of the Personal Conference first, and then you can start 

the online portion of the Personal Conference.  

To start the audio portion of a Personal Conference meeting: 

Call the number listed in the confirmation email or on the Personal Conference 

Meeting Information page.  

To start the online portion of a Personal Conference meeting: 

1 Click the link in the confirmation email to view the Personal Conference Meeting 

Information page, or navigate to that page through your Meeting Center service 

site. 

2 In the Personal Conference Meeting Information page, select Start in the upper 

right-hand corner. This button is only available if the audio portion of the Personal 

Conference meeting has already started. 
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To access the Personal Conference Meeting Information page: 

1 Log in to your Meeting Center service site. 

2 On the navigation bar, select My WebEx. 

The My Meetings page appears, showing a list of any meetings that you have 

scheduled. Personal Conference meetings are listed as "Personal Conference" in 

the Type column. 

3 In the list of meetings, select the Topic or Display Info link for your Personal 

Conference meeting. 

The Personal Conference Meeting Information page displays. 

4 If necessary, select the More Info link to display all the information about the 

meeting. 

Under Audio conference, look for the valid phone number or numbers for the audio 

portion of the Personal Conference meeting.You'll also find the meeting number, 

password, and host key. 
 

Starting a MeetingPlace Personal Conference meeting 

Personal Conference meetings do not start automatically at scheduled times. You 

must start the audio portion of the Personal Conference first, and then you can start 

the online portion of the Personal Conference.  

To start a MeetingPlace Personal Conference meeting: 

Call the number listed in the confirmation email or on the Personal Conference 

Meeting Information page.  

To access the MeetingPlace Personal Conference Meeting Information page: 

1 Log in to your Meeting Center service site. 

2 On the navigation bar, select My WebEx. 

The My Meetings page appears, showing a list of any meetings that you have 

scheduled. Personal Conference meetings are listed as "Personal Conference" in 

the Type column. 

3 In the list of meetings, select the Topic or Display Info link for your Personal 

Conference meeting. 

The Personal Conference Meeting Information page displays. 
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4 If necessary, select the More Info link to display all the information about the 

meeting. 

Under Audio conference, look for the valid phone number or numbers to call for 

your MeetingPlace Personal Conference meeting, as well as other information you 

need to start the meeting.You may need to click the Show detailed dial-in 

information link. 
 

Adding a scheduled Personal Conference meeting or 
MeetingPlace Personal Conference meeting to your calendar 
program 

Once you schedule a Personal Conference meeting or MeetingPlace Personal 

Conference meeting, you can add the Personal Conference meeting or MeetingPlace 

Personal Conference meeting to your calendar program, such as Microsoft Outlook. 

This option is applicable only if your calendar program supports the iCalendar 

standard, a common format for exchanging calendaring and scheduling information 

across the Internet. 

To add a scheduled Personal Conference meeting or MeetingPlace Personal 

Conference meeting to your calendar 

1 Choose either method: 

 On the Personal Conference Meeting Scheduled page or the Personal 

Conference Meeting Information page, select Add to My Calendar. 

 In the confirmation email message that you receive once you schedule or edit 

a Personal Conference meeting or MeetingPlace Personal Conference 

meeting, click the link to add the meeting to your calendar. 

A meeting opens in your calendar program. 

2 Select the option to accept the meeting request. For example, in Outlook, select 

Accept to add the Personal Conference meeting item to your calendar. 

  

Note:  

 If you cancel a Personal Conference meeting or MeetingPlace Personal Conference meeting, 

the Personal Conference Meeting Deleted confirmation page and the confirmation email 

message that you receive contains an option that lets you remove the meeting from your 

calendar program. 

 If you invite participants to a Personal Conference meeting or MeetingPlace Personal 

Conference meeting, the invitation email message that they receive also contains an option to 

add the meeting to their calendar programs. 
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Editing a Personal Conference meeting or MeetingPlace 
Personal Conference meeting 

Once you a schedule a Personal Conference meeting or MeetingPlace Personal 

Conference meeting, you can make changes to it at any time before you start it—

including its starting time, topic, agenda, attendee list, and so on. 

If you update any information about the Personal Conference meeting or 

MeetingPlace Personal Conference meeting, including adding or removing attendees, 

you can choose to send attendees a new invitation email message containing the new 

details about the meeting. Attendees removed from the attendee list receive an email 

message letting them know that they are no longer asked to attend. 

If you are logged in, you can edit the meeting details by clicking the link in the 

confirmation email message that you received after you scheduled the Personal 

Conference meeting or MeetingPlace Personal Conference meeting, or from your list 

of meetings in My WebEx. 

To edit Personal Conference meeting or MeetingPlace Personal Conference meeting 

from the confirmation email message: 

1 Open your confirmation email message, and then click the link to view your 

Personal Conference meeting information. 

The Personal Conference Meeting Information page appears. 

2 Select Edit. 

3 Make changes to the Personal Conference meeting  details. 

For details about the information requested on any page, click the Help button in 

the upper-right corner of the page. 

4 To save your changes to the meeting, select Save. 

If you invited attendees, a message appears, asking you whether you want to send 

an updated email invitation to attendees. 

5 If a message box appears, click the appropriate update option, and then select OK. 

The Personal Conference Meeting Information page appears. 

You receive a confirmation email message that includes information about the 

changes that you made to the meeting. 
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6 Optional. If you added the meeting to your calendar program, such as Microsoft 

Outlook, on the Meeting Updated page, select Add to My Calendar. 

To edit a Personal Conference meeting or MeetingPlace Personal Conference meeting 

from your list of meetings on your Meeting Center Web site: 

1 Log in to your Meeting Center website. 

2 On the navigation bar, select My WebEx. 

The My Meetings page appears, showing a list of any meetings that you have 

scheduled. Personal Conference meetings have "Personal Conference" in the 

Type column. 

3 In the list of meetings, under Topic, click the topic for the meeting. or click the 

Display Info link. 

4 Select Edit. 

5 Make changes to the Personal Conference meeting details. 

For details about the options on each page, click the Help button in the upper-right 

corner of the page. 

6 Select Save. 

If you invited attendees, a message appears, asking you whether you want to send 

an updated email invitation to attendees. 

7 If a message box appears, click the appropriate update option, and then click OK. 

If you select Cancel in the message box, the Personal Conference meeting is not 

updated. 

8 Optional. If you added the meeting to your calendar program, such as Microsoft 

Outlook, in the confirmation email message, click the Update My Calendar link. 
 

Canceling a Personal Conference Meeting or MeetingPlace 
Personal Conference meeting 

You can cancel any Personal Conference meeting or MeetingPlace Personal 

Conference meeting you have scheduled. Once you cancel a meeting, you can choose 

to send a cancellation email message to all attendees whom you invited to the 

meeting. The Personal Conference meeting is removed automatically from your list of 

meetings in My WebEx. 
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If you are logged in, you can cancel a Personal Conference meeting or MeetingPlace 

Personal Conference meeting from the confirmation email message that you received 

after you scheduled the meeting or from your list of meetings in My WebEx. 

To cancel a Personal Conference meeting or MeetingPlace Personal Conference 

meeting from a confirmation email message: 

1 Open your confirmation email message, and then click the link to view your 

Personal Conference meeting information. 

The Personal Conference Meeting Information page appears. 

2 Select Delete. 

If you invited attendees, a message appears, asking you whether you want to send 

a cancellation email message to all attendees whom you invited to the meeting. 

3 In the message box, click Yes or No, as appropriate. 

If you click Cancel in the message box, the meeting is not canceled. 

The Personal Conference Meeting Deleted page appears. 

4 Optional. If you added the Personal Conference meeting to your calendar 

program, such as Microsoft Outlook, on the Personal Conference Meeting Deleted 

page, click Remove From My Calendar to remove the meeting from your 

calendar. 

To cancel a Personal Conference meeting or MeetingPlace Personal Conference 

meeting on your Meeting Center website: 

1 Log in to your Meeting Center website. 

2 On the navigation bar, select My WebEx. 

The My Meetings page appears, showing a list of any meetings that you have 

scheduled. Personal Conference meetings are indicated by the words "Personal 

Conference" in the Type column. 

3 In the list of meetings, under Topic, click the topic for your Personal Conference 

meeting. 

4 Select Delete. 

If you invited attendees, a message appears, asking you whether you want to send 

a cancellation email message to all attendees whom you invited to the Personal 

Conference meeting or MeetingPlace Personal Conference meeting. 

5 In the message box, click Yes or No, as appropriate. 
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If you click Cancel in the message box, the meeting is not canceled. 

You receive a cancellation confirmation email message. 

6 Optional. If you added the Personal Conference meeting or MeetingPlace 

Personal Conference meeting to your calendar program, such as Microsoft 

Outlook, on the Personal Conference Meeting Deleted page, select Remove From 

My Calendar to remove the meeting from your calendar. 
 

About the Personal Conference Meeting 
Information page (host) 

This page provides the details about the Personal Conference meeting or 

MeetingPlace Personal Conference meeting you have scheduled. 

What you can do on this page 

 Review the date, time, duration, and other helpful information about the Personal 

Conference meeting. 

 Click the More Info link to view the meeting number, audio conference 

information, and meeting password. This information can help you start the audio 

portion of the Personal Conference meeting. 

 Edit the details about the Personal Conference meeting or MeetingPlace Personal 

Conference meeting. 

 Cancel the he Personal Conference meeting or MeetingPlace Personal Conference 

meeting. 

 Add the he Personal Conference meeting or MeetingPlace Personal Conference 

meeting to your calendar, if you haven’t already done so. 

 Start the online portion of the Personal Conference after the audio portion has 

started. (Does not apply to MeetingPlace Personal Conference meetings.) 

  

Select this button… To… 

Edit Edit the details about the Personal Conference meeting or 

MeetingPlace Personal Conference meeting. For example, you can 

add attendees, change the Personal Conference number account for 

this meeting, or change the date, time, and duration. 

Delete Cancel the meeting. 
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Select this button… To… 

Add to My Calendar Add this Personal Conference meeting or MeetingPlace Personal 

Conference meeting to a calendar program, such as Microsoft 

Outlook. 

To use this feature, your calendar program must conform with the 

iCalendar standard, a format used widely across the Internet for 

exchanging calendar information.  

Go Back Return to the meeting calendar. 

Start Start the online portion of the Personal Conference meeting. This 

button is only available after you have started the audio portion of the 

Personal Conference meeting. (Does not apply to MeetingPlace 

Personal Conference meetings.) 

 

About the Personal Conference Meeting 
Information page (for attendees) 

This page provides the details about Personal Conference meeting or MeetingPlace 

Personal Conference meeting. 

What you can do on this page 

 Review the date, time, duration, and other helpful information about thePersonal 

Conference meeting or MeetingPlace Personal Conference meeting.  

 Click the More Info link to see the meeting number, audio conference 

information, and meeting password. This information can help you join the audio 

portion of the Personal Conference meeting or the MeetingPlace audio 

conference. 

 Add the meeting to your calendar, if you haven’t already done so 

 Join the online portion of the Personal Conference after the audio portion has 

started. (Does not apply to MeetingPlace Personal Conference meetings.) 

Options on this page 

  

Click this button... To... 

View Agenda View Personal Conference meeting or MeetingPlace Personal 

Conference meeting agenda, if the host has provided it. 
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Click this button... To... 

Add to My Calendar Add Personal Conference meeting or MeetingPlace Personal 

Conference meeting to a calendar program, such as Microsoft 

Outlook. 

To use this feature, your calendar program must conform with the 

iCalendar standard, a format used widely across the Internet for 

exchanging calendar information. 

Go Back Return to the meeting calendar. 

Join Once the audio portion of the Personal Conference meeting has 

started, you can select Join to join the online portion of the 

Personal Conference meeting. (Does not apply to MeetingPlace 

Personal Conference meetings.) 
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Chapter 7  

Once a meeting starts, all participants are automatically granted meeting privileges 

either by host specification or by default: 

 If the host scheduled the meeting and specified privileges, participants receive 

those privileges. 

 If the host scheduled the meeting but did not specify privileges, participants 

receive default privileges. 

 If the host started an instant meeting, participants receive default privileges. 

The following table describes the privileges a host can grant and those that are granted 

by default. For detailed information on a particular set of privileges, click More by the 

privilege description. 

Granting Privileges During a 
Meeting 
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 Privileges  

 

A host can grant the following privileges to one 

or more participants: 

 Chat-who a participant can chat with and 

whether that chat can be private. More (on 

page 157) 

 Document-whether a participant can draw 

on a document or save or print it. More (on 

page 158) 

 View-what a participant can view in the 

meeting: participant list, document, 

thumbnails, or pages. More (on page 159) 

 Meeting-whether a participant can record 

the meeting, share documents, or control 

sharing. More (on page 160) 

 

 

 

Selecting participants 
During a meeting, you can grant privileges to or remove them from all participants at 

once or to an individual participant. 

  

 

To choose  

 all participants-select All Participants. 

 an individual participant-expand All 

Participants, and select a participant name. 

For instructions on granting privileges to participants, see Granting privileges (on 

page 157). 
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About Default privileges 
If the host does not specify privileges when scheduling a meeting, or starts an instant 

meeting, a set of default privileges are automatically assigned to a participant: 

 all chat privileges More (on page 157) 

 viewing the participant list More (on page 159) 

 controlling shared applications, web browser, or desktop remotely More (on page 

160) 
 

Granting or removing privileges 

To grant participant privileges during a meeting: 

1 In the Meeting window, on the Participant menu, choose Assign Privileges. 

The Participants Privileges dialog box appears. 

2 Grant or remove a privileges, as follows: 

 To grant a specific privilege, check its box. 

 To grant all privileges, check the Assign all privileges check box. 

 To remove a privilege, clear its check box. 

 To reset to the preset meeting privileges, select Reset to Meeting Defaults. 

3 Select Assign. 
 

Granting or removing Chat privileges 

As host, you can grant or remove chat privileges for one or more participants. 
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To grant or remove a chat privilege: 

  

 

You can chat with participants privately or 

publicly. 

Select or clear the checkbox for each 

privilege you want to grant 

Chat privileges: 

 Host-chat privately with the meeting host. Your chat message appears in only the 

host's Chat viewer. 

 Presenter-chat privately with the presenter. Your chat message appears in only 

the presenter's Chat viewer. 

 Other participants-chat privately with another participant. Your chat message 

appears in only that participant's Chat viewer. 

 Everyone-Chat publicly with all participants. Your chat message appears in 

everyone's Chat viewer. 

 Contact operator privately-Available only if your site includes the private 

operator option. Participants dial 00 at any time during a teleconference to contact 

the operator of the teleconferencing service. 
 

Granting or removing document privileges 

As host, you can assign privileges for saving, printing, and annotating documents, 

whiteboards, and presentations that are shared in the content viewer 



 Chapter 7: Granting Privileges During a Meeting 

 

159 

 

To grant or remove a document privilege: 

  

 

Select or clear the checkbox for each 

privilege you want to grant 

A participant uses the Annotation toolbar that appears whenever a document is being 

shared to 

 draw on shared elements 

 point to items on shared elements. 
 

Granting or removing viewing privileges 

To grant or remove a viewing privilege: 

  

 

Select or clear the checkbox for each 

privilege you want to grant 

Viewing privileges you can grant to participants: 

 Participant list-view the names of all other participants on the Participants panel. 

If this option is not selected, participants can view the names of only the meeting 

host and the presenter on the Participants panel  
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 Thumbnails-display miniatures, or thumbnails, of any pages, slides, or 

whiteboards in the center viewer. This privilege allows participants to view 

miniatures at any time, regardless of the content that appears in the presenter's 

content viewer.If participants have this privilege, they can display any page at full 

size in the content viewer, regardless of whether they also have the Any page 

privilege. 

 Any page-view any pages, slides, or whiteboards that appear in the content 

viewer. This privilege allows participants to navigate independently through 

pages, slides, or whiteboards. 

 Any document-view any document, presentation, or whiteboard that appears in 

the content viewer, and navigate to any pages or slides in documents or 

presentations. 
 

Granting or removing meeting privileges 

To grant or remove a viewing privilege: 

  

 

Select or clear the checkbox for each 

privilege you want to grant 

Document privileges you can grant: 

 Share documents-share documents, presentations, and whiteboards, and copy 

and paste any pages, slides, and whiteboards in the content viewer. Participants 

can share UCF rich media presentations or files only if the host selected the option 

to enable UCF rich media for participants when scheduling the meeting 

 Control shared applications, Web browser, or desktop remotely-request 

remote control of a shared application, Web browser, or desktop. If this privilege 

is cleared, the command to request remote control is unavailable to participants. 

 Record a meeting-record all interactions during a meeting and play them back at 

any time. 
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Chapter 8  

WebEx Audio lets you use either your telephone or your computer to hear others and 

to speak in your meeting: 

 Telephone—you can use your telephone to receive a call to the audio portion of 

the meeting or to dial in. 

 Computer—you can use a headset connected to your computer to join the audio 

portion of the meeting if the computer has a supported sound card and a 

connection to the Internet. 

  

Note: If you are a host, you can invite up to 500 people to participate in the audio conference. 

After joining the conference, participants can switch between audio modes with little 

or no listening interruption. In a mixed-mode conference, where some participants are 

using the telephone and others are using the computer, up to 125 people can speak. 

Your role in an audio conference determines your level of participation. Whichever 

role you take, the following table describes the basic tasks you can accomplish in that 

role. For detailed instructions on a particular task, click "More" by the task 

description. 

  

Using WebEx Audio 
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Task description 

Call using phone 

 

Call using computer 

 

Host an audio conference: 

 join or leave the audio conference More 

(on page 162) 

 switch audio connection modes More 

(on page 167) 

 mute or unmute one or more 

microphones More (on page 168)  

 use caller authentication to join the 

conference More? More (on page 171) 

 Edit or update phone numbers in your 

user profile More  

Participate in an audio conference: 

 join or leave the audio conference More 

(on page 162) 

 switch audio connection modes More 

(on page 167) 

 ask to speak More (on page 170) 

 mute or unmute your microphone More 

(on page 168) 

 use caller authentication to join the 

conference More (on page 171) 

 edit or update phone numbers in your 

user profile More 

  

Note: If you set up another type of audio conference—such as that of a third-party service—you 

must manage the conference using the options that service provides. 

 

Connecting to an audio conference 
Once you start or join a meeting that uses WebEx Audio, the Audio Conference 

dialog box appears automatically on your screen. 

What device do you want to use for speaking and listening in the meeting? 

 your phone: typically provides good voice transmission, but may have a cost 

attached. 
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 your computer (with a headset, and an Internet connection): Sometimes 

causes noisy transmission, or an irregular voice stream, but has no cost attached. 

You can select your preferred device from the Audio Conference dialog box that 

appears automatically after you start or join a meeting: 

  

 

1) Use Phone: You can call in or 

have the meeting call you. More 

(on page 163) 

2) Use Computer for Audio: Select 

the arrow, then choose Call using 

Computer. More (on page 166) 

At any time during the meeting, you 

can switch your audio device (on page 

167). 

 

 

Using your telephone to connect to audio 

After you join a meeting, the Audio Conference dialog box appears automatically. 

When you use your telephone to connect to the audio portion of the meeting, you can 

call in or receive a call back. 

 Call back—receive a call at a valid number you provide, or at number that is 

already stored in your user profile. A valid number must contain the area code and 

the seven-digit local telephone number. 

 Call in—call in from your phone to a number your host provides. 

The Audio Conference dialog box appears automatically. 

To receive a call back: 

In the Use Phone pane of the Audio Conference dialog box, do one of the following: 
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 Click Call Me to receive a call at the number 

displayed. 

 Select another number from the dropdown list 

of available numbers, then click Call Me. 

 Select Call me at a new number from the 

dropdown list, enter a number, then click Call 

Me. 

 If available, select Call me at an internal 

number from the dropdown list, then click 

Call Me. 

This dropdown option (or another customized 

label defined by your site administrator) will 

only be displayed if the internal call-back 

feature is available on your site. 

A telephone icon appears next to your name in the participant list to indicate that you 

are using your phone in the audio conference, and a mute icon appears next to the 

video icon so that you can mute or unmute your microphone as desired. More (on 

page 168) 

  

 

You can switch from using your telephone 

as your audio device to using your computer 

at any time during the audio conference. 

More (on page 167) 

To call in: 

1 In the Use Phone pane of the Audio Conference dialog box, select I will call in 

from the dropdown menu. 
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The Audio Conference dialog box displays 

default call-in numbers. 

2 Follow the instructions to join the audio conference. 

3 Optional. To view all international numbers, click the link All global call-in 

numbers.  

An information dialog box appears, which lists international numbers. 

A telephone icon appears next to your name in the participant list to indicate that you 

are using your phone in the audio conference, and a mute icon appears next to the 

video icon so that you can mute or unmute your microphone as desired. More (on 

page 168) 

  

 

You can switch from using your telephone 

as your audio device to using your 

computer at any time during the audio 

conference. More (on page 167) 

To leave an audio conference: 

1 Click Audio below the Participant list. 

The Audio Conference dialog box appears. 

2 Click Leave Audio Conference. 

Your participation in the audio conference ends; however, your participation in the 

meeting continues until you leave it or the host concludes it. 
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Using your computer to connect to audio 

After you join a meeting, the Audio Conference dialog box appears automatically. 

When you use your computer to speak and listen in a meeting, your computer sends 

and receives sound across the Internet. To do this, your computer must have a 

supported sound card and be connected to the Internet.  

  

Note: For purposes of audio quality and convenience, use a computer headset with a high-quality 

microphone rather than speakers and a microphone. 

To use your computer for audio: 

  

 

1) Select the arrow. 

2) Select Call Using Computer. 

Note: If this is your first time 

connecting to a meeting with your 

computer, a wizard appears to fine 

tune your sound settings (on page 

167).  

 

After you are connected to your 

meeting, you can  

1) mute or unmute your speaker or 

microphone 

2) change the volume on your 

speaker or microphone  

A headset icon appears next to your name in the participant list to indicate that you 

are using your phone in the audio conference, and a mute icon appears next to the 

video icon so that you can mute or unmute your microphone as desired. More (on 

page 168) 

  

 

You can switch from using your computer as your 

audio device to using your telephone at any time 

during the audio conference. More (on page 167) 
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Fine tuning your microphone and speaker settings 

If you are using your computer to connect to the meeting audio, you can fine-tune 

your microphone and speaker settings to optimize your audio experience.  

The Speaker/Microphone Audio Test walks you through testing your devices, and 

setting your speaker volume and microphone level.  

When you first start or join a meeting, you can manually test and adjust your sound 

device before you actually start using your computer for audio.  

To open the Speaker/Microphone Audio Test and adjust your sound settings: 

1 From the meeting window menu, select Audio > Speaker/Microphone Audio 

Test. 

2 Follow the instructions. 

  

Tip: After you join the audio portion of the meeting you can retest your settings at any time 

simply by reopening the Audio Conference dialog box and clicking Test speaker/microphone at 

the bottom of the box. 

 

Switching audio devices during a meeting 
You can easily switch from one audio device to another during a meeting with little 

disruption. 

To switch from your computer connection to a phone connection: 

  

 

1) Open the Audio Conference dialog box 

from  

 the Quick Start page 

 your participant list 

 the Audio menu.  

 the Meeting Controls Panel (If you are 

sharing) 

2) Select the down arrow beside Use Phone. 

3) Call the number in the Use Phone area 

and enter the access code and attendee 

ID, as directed by the automated operator. 

After you are connected by phone, your 

computer connection is dropped automatically. 
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To switch from your phone connection to a computer connection: 

  

 

1) Open the Audio Conference dialog box 

from  

 the Quick Start page 

 your participants list 

 the Audio menu.  

 the Meeting Controls Panel (If you are 

sharing) 

2) Select the down arrow beside Use 

Computer for Audio. 

3) Select Switch to Using Computer. 

Your phone connection is dropped after your 

computer connection is established. 

(Remember to switch to your computer 

headset.) 

 

 

Connecting to audio during sharing 
If you join a meeting that is already in progress and shared content is all you see, you 

can connect to the audio portion of the meeting from the Meeting Controls Panel. 

To connect to the audio portion of the meeting: 

  

 

1) On the Meeting Controls 

Panel at the top of your 

screen, select Audio. 

The Audio Conference 

dialog box opens 

2) Connect to the audio (on 

page 162) portion of the 

meeting as usual. 

 

Muting and unmuting microphones 
The following table illustrates how to quickly mute and unmute microphones in your 

meeting depending on your user role. 
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Role  Task description: 

Host Windows: Right click in the participants list 

 

 Mute on Entry to mute all 

microphones automatically when 

participants join a meeting 

 Mute or Unmute to mute or 

unmute your own or a specific 

participant's microphone  

 Mute All to mute or unmute all 

participant microphones 

simultaneously at any time 

during a meeting More (on page 

169) 

Participant 

Mac:Ctrl + click in the participants list 

 

Select the Mute or Unmute icon to 

mute or unmute your own 

microphone. 

The microphone icon to the right changes state. 

  

Tip: During sharing, participants can mute and unmute their microphones from the Meeting 

Controls Panel at the top of their screens. 

 

 

Muting and unmuting all participant microphones 
simultaneously 

Host and presenter only 

You can mute or unmute all participant microphones simultaneously. 
 

This option does not affect the host's and presenter's microphones. 
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To mute or unmute all participants: 

 Windows: Right click on the participant list 

 Mac: Ctrl + click on the participant list 

Select Mute All or Unmute All. 

 

 

The microphone icon to the right of each participant's name changes state. 
 

Asking to speak in an audio conference 
Participant 

If you want to speak and the host has muted your microphone, you can ask the host to 

unmute your microphone so that you can speak. You can cancel a request to speak at 

any time. 
 

  

To ask to speak Windows result 

Select Raise Hand on the 

Participants panel  
The Raised Hand indicator appears on the 

participant list for the host and presenter. 

  

To cancel a request to speak Windows result 

Select Lower Hand On the 

Participants panel  
The Raised Hand indicator is removed from 

the participant list for the host and presenter. 



 Chapter 8: Using WebEx Audio 

 

171 

 

  

To ask to speak Mac result 

Select the Raise Hand icon at 

the bottom of the Participants 

panel 
 

The Raised Hand indicator appears on the 

participant list for the host and presenter. 

  

To cancel a request to speak Mac result 

Select the Lower Hand icon at 

the bottom of the Participants 

panel 
 

The Raised Hand indicator is removed from 

the participant list for the host and presenter. 

 
 

 

Using caller authentication to start or join an 
audio conference 

Host accounts only 

CLI (caller line identification), or ANI (automatic number identification), is a form of 

caller ID, a telephony intelligent service that transmits a caller's telephone number 

before the call is answered. Any dial-in caller with a host site account can be 

authenticated and placed into the correct audio conference without needing to enter a 

meeting number. 

If you have a host account, and your site is enabled for ANI/CLI, you can 

 schedule a meeting with dial-in ANI/CLI teleconferencing authentication. 

 be authenticated whenever you dial into any ANI/CLI enabled audio conference 

to which you have been invited by email. Call-in authentication is established by 

mapping your email address to a phone number in your user profile. 

 specify a call-in authentication PIN to prevent "spoofers" from using your number 

to dial into an audio conference 

To schedule an audio conference with ANI/CLI authentication: 

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, under Host a Meeting, click Schedule a Meeting. 

The Schedule a Meeting page appears. 
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3 Click Change audio options. 

The Audio Options dialog box appears. 

4 Select the Enable audio conference CLI authentication when participants call 

in checkbox if it is not already selected. 

  

Note: Caller authentication will only be available to participants if they are invited to a CLI/ANI 

enabled audio conference by email during the meeting scheduling process. Any participant invited 

to the audio conference once it has begun cannot use caller authentication. 

 
 

 

Specifying call-in authentication for your host account 

If you have a host account, and your site is enabled for call-in authentication, you can 

set authentication for any phone number listed in your user profile. Your call will be 

authenticated by mapping your email address against specified phone numbers in your 

profile whenever you dial into a CLI (caller line identification), or ANI (automatic 

number identification) enabled audio conference to which you have been invited by 

email. 

  

Note: Caller authentication will only be available if you have been invited to a CLI/ANI 

(automatic number identification) enabled audio conference by email during the meeting 

scheduling process. Caller authentication will not be available if you are dialing in to a CLI/ANI 

enabled audio conference: 

 from an invitation other than email. 

 from an email invitation originated during the meeting. 

To specify call-in authentication for your host account: 

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, click My WebEx. 

3 Click My Profile. 

The My WebEx Profile page appears. 

4 Under Personal Information, select the Call-in authentication checkbox beside 

any phone number for which you want dial-in authentication. 

5 Click Update. 
 



 Chapter 8: Using WebEx Audio 

 

173 

 

Using an authentication PIN 

If you have a host account, and your site is enabled for CLI (caller line identification), 

or ANI (automatic number identification) audio conferences, you can use an 

authentication PIN to prevent "spoofers" from using your number to dial into an audio 

conference. 

If your site administrator sets the authentication PIN as mandatory for all accounts 

using call-in authentication on your site, then you must specify a PIN number or caller 

authentication will be disabled for your account. 

To specify an authentication PIN: 

1 Log in to your Meeting Center Web site. 

2 On the navigation bar, click My WebEx. 

3 Click My Profile. 

The My WebEx Profile page appears. 

4 Under Personal Information, in the PIN: text box, enter a 4-digit PIN number of 

your choosing. 

5 Click Update. 
 

Editing or updating your stored phone numbers 
You can edit or update the phone numbers listed in your profile if you have not yet 

joined the audio conference or if you joined the audio conference from your 

computer. In addition, you can view any phone number cookies stored on your 

computer. 

Any updates you make do not take effect until the next time you join a meeting. 

To edit or update your profile: 

1 Do either of the following: 

 On the Audio menu, choose Join Audio Conference. 

 At the bottom of the Participants panel, click Audio. 
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The Audio Conference dialog box 

appears. 

2 Select Manage phone numbers from the dropdown box in the lower pane. The 

Manage phone numbers dialog box appears. 

3 Click Edit to update the phone numbers in your My WebEx profile, or Clear to 

delete phone numbers that are stored in cookies on your computer. 

  

Note: You cannot be participating in an audio conference by phone if you want to edit or update 

your phone numbers. 
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Chapter 9  

An Integrated Voice Conference allows participants to speak to each other using voice 

over Internet Protocol (VoIP)-an Internet-based way of connecting through the 

computer. Integrated voice conferences are useful if: 

 Participants are located a great distance away and do not want to incur long 

distance phone charges 

 The meeting is a presentation rather than a discussion and does not involve 

interaction among participants 

Your user role in an Integrated Voice conference determines your level of 

participation. Whichever role you take, the following table describes the basic tasks 

associated with that role. For detailed instructions on a particular task, click “More” 

by a task description. 

  

 Task description: 

Host  

 

Start and manage a voice conference: 

 fine tune your microphone and speaker seetings 

More (on page 178) 

 mute or unmute participant microphones More (on 

page 168) 

To start a voice conference: 

 Select Voice Conference on the Quick Start page  

 or, select Integrated Voice Conference > Start 

Conference from the Audio menu. 

To end a voice conference: 

Select Integrated Voice Conference > End 

Using Integrated Voice 
Conferences 
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 Task description: 

Conference from the Audio menu. 

Participant 

 

Participate in a voice conference: 

 Join or leave a conference More… 

 Mute or unmute your microphone More… 

To join a voice conference: 

 Select Yes in the dialog box that automatically 

appears when the host starts the conference. 

 or, select Integrated Voice Conference > Join 

Conference from the Audio menu. 

To leave a voice conference: 

Select Integrated Voice Conference > Leave 

Conference from the Audio menu. 

  

Note: For better audio quality and greater convenience, use a computer headset with a high-

quality microphone, rather than speakers and a microphone. 

 

Speaking in a voice conference 
If you are a current speaker, the method by which you speak depends on the speaker 

setup option that is currently selected for your meeting: 

 Desktop speakers (default): If this option is selected, the following appears in 

the bottom-right corner of your Meeting window: 

  

 

 

 

Press the Ctrl key on your keyboard while speaking. Pressing this key mutes your 

speakers, thereby preventing your voice from echoing in the conference. 

 Headset: If this option is selected, the following appears in the bottom-right 

corner of your Meeting window: 
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Simply speak into your microphone. 

  

Tip: Before you join a voice conference, you can use the audio setup wizard to select your audio 

device and adjust its settings. More (on page 178) 

 

 

Muting and unmuting microphones 
The following table illustrates how to quickly mute and unmute microphones in your 

meeting depending on your user role. 

  

Role  Task description: 

Host Windows: Right click in the participants list 

 

 Mute on Entry to mute all 

microphones automatically when 

participants join a meeting 

 Mute or Unmute to mute or 

unmute your own or a specific 

participant's microphone  

 Mute All to mute or unmute all 

participant microphones 

simultaneously at any time 

during a meeting More (on page 

169) 

Participant 

Mac:Ctrl + click in the participants list 

 

Select the Mute or Unmute icon to 

mute or unmute your own 

microphone. 

The microphone icon to the right changes state. 
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Tip: During sharing, participants can mute and unmute their microphones from the Meeting 

Controls Panel at the top of their screens. 

 

 

Muting and unmuting all participant microphones 
simultaneously 

Host and presenter only 

You can mute or unmute all participant microphones simultaneously. 
 

This option does not affect the host's and presenter's microphones. 
 

  

 

To mute or unmute all participants: 

 Windows: Right click on the participant list 

 Mac: Ctrl + click on the participant list 

Select Mute All or Unmute All. 

 

 

The microphone icon to the right of each participant's name changes state. 
 

Fine tuning your microphone and speaker 
settings 

The first time you use an integrated voice conference, the audio wizard walks you 

through selecting your sound device, and setting your speaker volume and 

microphone level.   

Any time before you start or join a meeting, you can manually open the wizard to test 

your device again, or make further adjustments, as necessary.  
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To open the wizard and adjust your sound settings: 

1 From the meeting window menu, select Audio > Computer Setup for Audio. 

2 Follow the wizard instructions. 
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Chapter 10  

If a video camera is installed on your computer, you can send video. Other 

participants can see you, or whatever you focus your webcam on. To see video, 

participants do not need to have a webcam installed on their computers. 

WebEx Meeting Center supports high-definition (HD) video with up to 720p 

resolution. Other WebEx services, such as Training Center, Event Center, and 

Support Center, support high-quality video with up to 360p resolution. The Cisco 

technology automatically adjusts video to the highest quality for each participant 

according to the computer capabilities and network bandwidth. 

Your administrator can set video options at the site level. A meeting host can set 

video options on the scheduler as well as in the meeting. If your site or meeting is not 

set up to use HD or high-quality video, standard video is used. 

To start or stop sending video, select the video icon beside your name.  

  

 

The icon turns green when you are 

sending video. 

If you have a High Definition camera and you select the video icon, a one-time 

notification indicating You are ready to send HD video to other participants 

displays.  

Sending and Receiving Video 
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After you start sending video, you can perform the following tasks depending on your 

role. 

  

Role 
 

Tasks 

Host 

 

 

What you can do: 

 Start or stop sending video at will. 

 Lock focus on one participant (on page 183). 

 View everyone who is sending video (on page 186) on one big screen. 

 List participants or show thumbnails. (on page 184) 

 Set webcam options (on page 189). 

Participant 

What you can do: 

 Start or stop sending video at will. 

 View everyone who is sending video (on page 186) on one big screen. 

 List participants or show thumbnails. (on page 184) 

 Set webcam options (on page 189). 

  

Note: If you are managing a meeting that includes TelePresence systems (Meeting Center only), 

the following WebEx features are unavailable: 
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 Recording 

 Polling 

 File Transfer 

 Chat with TelePresence room participants 

 

Minimum system requirements 
To send or receive video with a resolution of 360p, ensure that your system meets the 

following minimum requirements: 

  

Action What you need 

Send 

 A webcam capable of producing high-quality video. WebEx supports 

most webcams of this type 

 A computer with at least 1 GB of RAM and a dual-core processor  

 A fast network connection  

Receive 
 A computer with at least 1 GB of RAM and a dual-core processor  

 A fast network connection  

To send or receive video with a resolution of 720p, ensure that your system meets the 

following minimum requirements: 

  

Action What you need 

Send 

 A webcam capable of producing HD video. WebEx supports most 

webcams of this type 

 A computer with at least 2 GB of RAM and a quad-core processor  

 A fast network connection  

Receive 
 A computer with at least 2 GB of RAM and a dual-core processor  

 A fast network connection  

 

Locking focus on one participant 
If you are the host, you can select whose video you want everyone to see. Follow 

these steps: 

1 Select the name on the video display. 
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2 In the dialog box, select one of the following: 

  

 

 

 The active speaker. This is the 

default. The display focuses on the 

person currently speaking and 

switches as the loudest speaker 

changes.  

 A specific participant. The display 

focuses on only the specific 

participant that you select. All 

participants see that person, 

regardless of who is speaking. 

 

Switching between a list or thumbnail view of 
participants 

You can switch between the Participant List and participants' video thumbnails. 
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To view video thumbnails: 

1) Select the list icon. 

2) Select Thumbnails. 

 

To view Participant List: 

1) Select the thumbnail icon. 

2) Select List. 

 

 

In the thumbnails view, select the down or 

up arrow to view additional thumbnails. 
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Viewing everyone who is sending video 
With one click, you can view live, high-quality video display across your entire 

screen. In the video view, you see all participants who are sending video, including: 

 the active speaker or a specific participant whom the host chose to lock on 

 five thumbnails on the bottom. To see more participants, use the arrow on either 

side. 

  

 

To view all participants who are sending 

video: 

Select the icon in the upper-right corner of 

the display. 

 

To return to the Meeting window: 

Select Exit Full-Screen Mode in the 

upper-right corner of the screen. 

 

 

Understanding the large video view 

When you are viewing everyone who is sending video, high-quality video displays 

across your entire screen. 
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One of the following is displayed here: 

 The active speaker's video, which switches as the loudest speaker changes  

 A specific participant's video that the host chose to lock on 

 

Your self-view appears in this corner. You can 

 Minimize or restore the display by selecting the icon in the upper-right corner of the 

self-view. 

 Mute or unmute your audio by selecting Mute Me or Unmute Me. 

 Stop or show your self-view by selecting Stop My Video or Start My Video. 

 Video thumbnails of five other participants appear here.  

 Use these controls to see additional participants. 

 

If you are the host or presenter, you can choose to lock everyone's focus on the active 

speaker's video or a specific participant's video. Select the name to get started. More… (on 

page 183) 

 You can expand the active speaker's video display to full screen. More… (on page 188) 
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Expanding the active speaker's video display 

When you are viewing all participants who are sending video, you can expand the 

active speaker's video display to full screen. With the full-screen display, you can 

continue sending or receiving HD video (applicable for Meeting Center only). 

  

 

 

To see the active speaker (or the specific participant 

the host chose to lock on) in full-screen view, select 

this icon in the upper-right corner of the active 

speaker's display. 

 

To return to the view where you see everyone who 

is sending video, select this icon in the upper-right 

corner of your screen. 

 

 

Floating Icon Tray in Video Full Screen Mode 

Meeting participants have access the the Floating Icon Tray in full video mode 

making it easy to use the all the common WebEx functions. The Floating Icon Tray 

automatically displays at the top of the video screen. 
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Note: Screen save option is disabled in video and other full screen modes.  

 

 
 

Setting webcam options 
If you have a working webcam, you can set options that are available for that webcam 

directly from your meeting. 

To set webcam options: 

  

 

Windows: 

At the top right of the 

Participants panel, select the 

options icon. 

 

 

Mac: 

At the bottom right of the 

Participants panel, select the 

options icon. 

Typically, you can set options for general settings, such as contrast, sharpness, and 

brightness. But options can vary depending on your webcam. 
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Managing video display during sharing 
When you are sharing information or someone else is sharing information with you, a 

floating panel containing participant video and your self-view appears on the right-

hand side of your screen.  

  

 

What you can do on the floating panel: 

 Stop or start your video. More… (on page 190) 

 Minimize or restore your video. More… (on page 190) 

 Move the panel by dragging it. More… (on page 191) 

 Switch to view everyone who is sending video. More… (on page 191) 

 Lock focus on another participant (for host and presenter only). More… (on page 

183) 

  

Note: If your are viewing everyone sending video and the presenter starts sharing, you will 

automatically exit the video view so that you can view what is being shared. 

 
 

Controlling your self-view 

During sharing, your self-view appears in the lower-right portion of the floating panel. 

You can manage your self-view in several ways. 
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To minimize self-view: 

Select the icon in the upper-right portion of the self-

view display. 

To restore self-view: 

Select the icon in the lower-right portion of the 

floating panel. 

To stop or show self-view: 

Select the video icon at the center of the self-view 

display. 

 

 

Controlling video display 

During sharing, you see the active speaker's video or a specific participant's video, if 

the host chose to lock on the participant, in a floating panel. You can manage this 

video display in several ways. 

  

 

To minimize: 

Select the downward arrow in the upper-left 

corner. 

To resize:  

Select the bottom right-corner and drag the 

edge. 

To move: 

Select and drag the display to another 

location on your screen. 

To lock another participant's video: 

Select the name and then select the 

participant in the dialog box. For details, see 

Locking focus on one participant (on page 

183). 

To switch to view everyone: 

Select the icon in the upper-right corner of 

the display. 
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Obtaining video and audio data during a meeting 
Having video or audio problems in a meeting? If you contact technical support, the 

video and audio data you can obtain within the meeting comes in handy. 

To obtain audio and video data while in the Meeting window: 

  

 

 

Windows 

 

Select Meeting > Audio & Video 

Statistics... 

 

MAC 

 

Select Meeting > Audio & Video 

Statistics... 

To obtain audio and video data while viewing everyone sending video: 

Right-click the active speaker's display and then select Audio & Video Statistics...  
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Chapter 11  

  

If you want to... See... 

get an overview of starting a One-Click 

Meeting from your WebEx service Web site 

About setting up a One-Click Meeting (on 

page 195) 

specify settings for your One-Click Meeting Setting up your One-Click Meeting on the 

Web (on page 196) 

install WebEx One-Click, which includes the 

One-Click panel and One-Click shortcuts 

Installing WebEx Productivity Tools (on page 

199) 

start a One-Click Meeting from your WebEx 

service Web site 

Starting a One-Click Meeting (on page 202) 

remove WebEx One-Click, including all One-

Click shortcuts, from your computer 

Removing WebEx Productivity Tools (on 

page 206) 

 

About setting up a One-Click Meeting 
WebEx One-Click allows you to start a meeting instantly from your desktop (desktop 

version) and from your WebEx service Web site (Web version). You can set up one or 

both versions, depending on your needs: 

 Web version: allows you to start a One-Click Meeting from your WebEx service 

Web site. Doing so does not require you to download any application. For more 

information about the web version, refer to the WebEx One-Click User's Guide, 

which is available on the Support page of your WebEx Service web site. 

 Desktop version: if this feature and the Productivity Tools feature are enabled by 

your site administrator, allows you to start and join meetings and send meeting 

invitations without logging in to your WebEx service site or navigating Web 

Setting Up a One-Click Meeting 
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pages. For more information about the desktop version, refer to the WebEx One-

Click User's Guide. 
 

Setting up your One-Click Meeting on the Web 
The One-Click Meeting Setup page allows you to specify options a One-Click 

Meeting. You can return to the One-Click Meeting Setup page at any time to modify 

your meeting. 

The settings you specify apply to both the One-Click Web version and the desktop 

version. 

To set up your One-Click Meeting: 

1 Log in to your WebEx Service Web site. 

2 Click My WebEx > Productivity Tools Setup (on the left navigation bar). 

The Productivity Tools Setup page appears. 

On this screen, you can also download WebEx Productivity Tools, which include 

the desktop version of One-Click and its shortcuts. For details, see Installing 

WebEx Productivity Tools (on page 199). 

3 Click Set Up Now. 

The One-Click Setup page appears. 

4 Specify the meeting information and settings on the page. 

For details about the options on the One-Click Settings page, see About the One-

Click Settings page (on page 196). 

5 Click Save. 

  

Tip: Whenever you want to edit options for your One-Click Meeting, return to the One-Click 

Settings page by clicking My WebEx > Productivity Tools Setup > Edit Settings. 

 

 

About the One-Click Settings page 

How to access this page: 

On your WebEx service Web site, do one of the following: 
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 If you are setting up your One-Click Meeting for the first time, on your WebEx 

service Web site, click My WebEx > Productivity Tools Setup (on the left 

navigation bar) > Set Up Now. 

 If you already set up your One-Click Meeting, on your WebEx service Web site, 

click My WebEx > Productivity Tools Setup (on the left navigation bar) > Edit 

Settings. 

What you can do here: 

Set options for your One-Click Meeting 

Meeting Options 

  

Use this option… To… 

Service type Select the type of WebEx session for which you want to start a 

One-Click Meeting. 

This option lists only the session types available for your site and 

user account. 

Meeting template Select the meeting template you want to use to set options for 

your One-Click Meeting. The drop-down list of templates includes: 

Standard templates: Templates that your site administrator set 

up for your account. 

My Templates: Any personal templates that you created by 

saving the settings for a meeting you previously scheduled, using 

the scheduling options on your site. 

Topic Specify the topic for the meeting 

Meeting password Specify the password for the meeting. 

Confirm password Type the password again to prevent typing errors. 

Listed on calendar Specify that the meeting appears on the calendar on your site. 

Available for meetings and sales meetings only. 

CUVC Meeting ID (CUVC Integration to Meeting Center only) Enter a custom URL to 

create a virtual meeting room in which you can use Cisco Unified 

Video (CUVC) in your meeting. 

If you leave this box empty, the WebEx Meeting ID is used by 

default. 

When you start your WebEx meeting, the CUVC Video panel 

displays automatically. 
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Tracking Codes 

  

Use this option… To… 

Tracking code Identify your department, project, or other information that 

your organization wants to associate with your meetings. 

Tracking codes can be optional or required, depending on 

how your site administrator set them up. 

If your site administrator requires you to select a code from a 

predefined list, click the link Select Code, and then select a 

code from the list or enter one in the box above. 

Audio Conference 

meetings, training sessions, and sales meetings only 

  

Use this option… To… 

Use Select the type of teleconference you would like to use: 

WebEx Audio: Specifies that the meeting includes an integrated audio 

conference. If you select this option, select one of the 

following options: 

 Display toll-free number: Select if your site provides 

toll-free call-in audio conferencing, in which both a toll-

free number and a toll number are available. If your 

participants dial a toll-free call-in number, your 

organization assumes the charges for the calls. 

Otherwise, participants assume the charges for their 

calls. 

 Display global call-in numbers to attendees: Select if 

you want to provide a list of numbers—such as toll-free 

or local numbers—that attendees in other countries can 

call to join the audio conference. 

Note: After you start the meeting, participants have a choice 

of joining by can choose to use their computer as their audio 

device, using VoIP, or to use their phone as their audio 

device. 

Tip: A participant must have a direct phone line to receive a 

call from the teleconferencing service. However, a 

participant without a direct phone line can join an audio 

conference by calling a call-in telephone number, which is 

always available in the Meeting window. 

Personal Conference Available only if your site has the Personal Conferencing 
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Use this option… To… 

Number Account feature turned on, and only for Meeting Center. 

Select the Personal Conference number account that you 

want to use for your meeting. You can manage your 

Personal Conference number accounts on the My WebEx 

>Personal Conferencing page. 

Cisco Unified MeetingPlace 

Audio Conferencing 

Available only if your site has Cisco Unified MeetingPlace 

Audio turned on. 

If you select this option, choose the type of conference: 

 Call-in teleconference: Select if you want customers to 

dial a number to join 

 Call-back teleconference: Select if you want 

customers to type in a phone number and receive a call 

back from the conferencing service. 

A participant must have a direct phone line to receive a call 

from the conferencing service. However, a participant 

without a direct phone line can join an audio conference by 

dialing a call-in number, which is always available in the 

meeting window. 

Other teleconference 

service: 

Specifies that the meeting includes a teleconference that 

another service provides, such as a third-party 

teleconferencing service or internal teleconferencing 

system, such as a PBX (private branch exchange). 

In the text box, type instructions for joining the 

teleconference. 

Use VoIP Only Specify that the meeting includes only Integrated VoIP, 

which allows meeting participants to use computers with 

audio capability to communicate over the Internet rather 

than the telephone system. 

None Specify that the meeting does not include either an audio 

conference or Integrated VoIP. 

 

Installing WebEx Productivity Tools 
If your site administrator has enabled you to download WebEx Productivity Tools, 

you can start you can start or join meetings instantly using One-Click; start meetings 

instantly from other applications on your desktop, such as Microsoft Office, Web 

browsers, Microsoft Outlook, IBM Lotus Notes, and instant messengers; and schedule 

meetings using Microsoft Outlook or IBM Lotus Notes without going to your WebEx 

service site. 
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Before installing WebEx Productivity Tools, ensure that your computer meets the 

following minimum system requirements: 

 Microsoft Windows 2000, XP, 2003, Vista 

 Microsoft Internet Explorer 6.0 SP1 or 7.0, or Firefox 3.0 or later 

 Intel x86 (Pentium 400MHZ +) or compatible processor 

 JavaScript and cookies enabled in the browser 

To install WebEx Productivity Tools: 

1 Log in to your WebEx service Web site. 

2 Click My WebEx > Productivity Tools Setup (on the left navigation bar). 

The Productivity Tools Setup page appears. 

3 Click Install Productivity Tools. 

The File Download dialog box appears. 

4 Save the installation program to your computer. 

The name of the installation file has an .msi extension. 

5 Run the installation file and follow the instructions. 

6 Once you complete installation, log in using your WebEx account information and 

then verify your WebEx settings for Productivity Tools, including One-Click, in 

the WebEx Settings dialog box. 

  

Note: System administrators can also perform a mass installation for computers at their site. For 

more information, see the IT Administrator Guide for Mass Deployment of WebEx Productivity 

Tools at http://support.webex.com/US/PT/wx_pt_ag.pdf 

(http://support.webex.com/US/PT/wx_pt_ag.pdf). 

After you have logged in, the WebEx One-Click panel and shortcuts appear. For 

instructions about using the One-Click panel and shortcuts, see the WebEx One-Click 

User's Guide. 

The Help in the WebEx One-Click panel also provides detailed information about 

how to use the One-Click panel and shortcuts. 

http://support.webex.com/US/PT/wx_pt_ag.pdf
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Tip: For instructions on using the WebEx One-Click panel and the One-Click taskbar menu, refer 

to the WebEx One-Click User's Guide, which is available on the Support page of your WebEx 

Service web site. 

 

 

Starting a One-Click Meeting 
Before you start a One-Click Meeting from your WebEx Service Web site, ensure that 

you set up One-Click settings. For details about setting up One-Click settings, see 

Setting up your One-Click Meeting on the Web (on page 196). For details 

To start a One-Click Meeting from your WebEx service Web site: 

1 Log in to your WebEx Service Web site. 

2 Click My WebEx > Start One-Click Meeting. 

  

 

 

Your meeting starts. 
 

If your site includes Meeting Center, you can also start a One-Click Meeting from this 

specific service. 

To start a One-Click Meeting from the Meeting Center service: 

1 Log in to your WebEx service Web site, and click Meeting Center. 

2 On the left navigation bar, click Host a Meeting > One-Click Meeting. 

  

 

 

Your meeting starts. 
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To start a One-Click Meeting using the WebEx One-Click panel: 

1 Open your WebEx One-Click panel by doing any of the following: 

 Double-click the WebEx One-Click shortcut on your desktop. 

  

 

 

 Go to Start > Programs > WebEx > Productivity Tools > WebEx One-

Click. 

 Right-click the WebEx One-Click icon on the taskbar of your desktop. 

  

 
 

If you did not specify automatic login, enter the required WebEx account 

information in the dialog box, and then click Log In. 

2 On the WebEx One-Click panel, click Start Meeting. 

  

 

 

  

Note: For instructions on using the WebEx One-Click panel, refer to the WebEx One-Click 

User's Guide. 
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To start a One-Click Meeting using a One-Click shortcut: 

Click one of the following shortcuts: 

  

Shortcut Description 

 

Right-click menu of taskbar icon shortcut: 

 Right-click the WebEx One-Click taskbar 

icon and then click Start meeting now to 

start an instant meeting. 

 Right-click the WebEx One-Click taskbar 

icon and then click Start a Scheduled 

Meeting to start a previously scheduled 

meeting, or click Start Personal 

Conference meeting to start a previously 

scheduled Personal Conference meeting.  

Note: You can also right-click the WebEx One-

Click taskbar icon and then click Schedule a 

meeting to schedule a WebEx meeting using 

Microsoft Outlook or Lotus Notes. 

For more details, see the Integration to 

Outlook User's Guide and the Integration to 

Lotus Notes User's Guide, which are available 

on the Support page of your WebEx Service 

web site. 

 

  

 

Email and Scheduling shortcut: Click One-

Click Meeting in Microsoft Outlook or Lotus 

Notes to start a One-Click meeting. 

Note: You can also click Schedule Meeting in 

Microsoft Outlook or Lotus Notes to schedule a 

WebEx meeting using Outlook or Lotus Notes. 

For more details, see the Integration to 

Outlook User's Guide and the Integration to 

Lotus Notes User's Guide, which are available 

on the Support page of your WebEx Service 

web site. 
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Shortcut Description 

 

Instant messenger shortcut: Click WebEx > 

Start WebEx Meeting to start a One-Click 

meeting in your instant messenger, such as 

Skype, AOL Instant Messenger, Lotus 

SameTime, Windows Messenger, Google 

Talk, or Yahoo Messenger. For more details, 

see the Integration to Instant Messengers 

Guide, which is available on the Support page 

of your WebEx Service web site. 

Available for meetings, sales meetings, 

training sessions, and support sessions only. 

 

  

 

Web browser shortcut: Click this icon to start 

your meeting. 

Note If you previously customized your 

Internet Explorer toolbar, the shortcut button 

may not automatically appear on the toolbar. 

Instead, it is added to the list of available 

toolbar buttons in Internet Explorer. In this 

case, you must add the button to the toolbar, 

using the Internet Explorer Customize option. 

To access this option, on the View menu, point 

to Toolbars, and then choose Customize. 

Available for meetings, sales meetings, 

training sessions, and support sessions only. 

 

  

 

Microsoft Office shortcut: In Microsoft Word, 

Microsoft Excel, and Microsoft PowerPoint, 

select Share As Document or Share As 

Application. This command starts the meeting 

and automatically shares the application you 

are using, including all files that are already 

open in that application. You can still work in 

the application during the meeting. 

Available for meetings, sales meetings, 

training sessions, and support sessions only. 

 

Right-Click menu shortcut: Right-click the 

icon for an application or document file on your 

computer, and then point to Share in WebEx 

Meeting > As Application. This command 

starts the meeting and automatically shares 

the application, including all files that are 

already open in that application. You can still 

work in the application during the meeting. 

Available for meetings, sales meetings, 

training sessions, and support sessions only. 
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Tip:  

 Once you start a One-Click Meeting, it appears on your Personal Meeting Room page, unless 

you specified it to be an unlisted meeting. If you provide others with the URL for this page, 

they can quickly join your meeting by clicking the link for the meeting on this page. 

 You can control which shortcuts are available in the WebEx Settings dialog box. 

 For instructions on using the WebEx One-Click shortcuts, refer to the WebEx One-Click 

User's Guide. 
 

 

Removing WebEx Productivity Tools 
You can uninstall WebEx Productivity Tools at any time. Uninstalling Productivity 

Tools removes all Productivity Tools, including the WebEx One-Click panel and 

One-Click shortcuts, from your computer. 

To uninstall WebEx Productivity Tools: 

1 Click Start > Programs> WebEx > Productivity Tools > Uninstall 

2 Click Yes to confirm that you want to uninstall WebEx Productivity Tools. 

To uninstall WebEx Productivity Tools from the Control Panel: 

1 Click Start > Settings > Control Panel. 

2 Double-click Add/Remove Programs. 

3 Click WebEx Productivity Tools. 

4 Click Remove. 

5 Click Yes to confirm that you want to uninstall WebEx Productivity Tools. 

  

Note: Uninstalling Productivity Tools removes all Productivity Tools and shortcuts from your 

computer. If you want to keep using some Productivity Tools but disable others, edit the options 

in the WebEx Settings dialog box. 
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Chapter 12  

The My Recorded Meetings page allows you to view and manage your meeting 

recordings. Meetings that you recorded on the server are automatically listed on your 

My Recorded Meetings page. You can also upload recordings of meetings that were 

recorded on your local computer. 

  

My Recorded Meetings page Task description: 

 

 Open the My Recorded 

Meetings page. More… 

(on page 207) 

 Upload a recorded 

meeting file. More… (on 

page 211) 

 Edit information about a 

recording. More… (on 

page 212) 

 Send an email to share a 

recording. More… (on 

page 214) 

 

Opening the My Recorded Meetings Page 

To open the My Recorded Meetings page: 

1 Log in to your WebEx Meeting Center service Web site. 

2 On the left navigation bar, under Host a Meeting, click My Files > My 

Recordings. 

The My Recorded Meetings page appears, showing your recording files. 

Managing Meeting Recordings 
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For details about the My Recorded Meetings page, see About the My Recorded 

Meetings page (on page 209). 
 

About the Recording Information page 

How to access this page 

On your Meeting Center Web site, from the left navigation bar, click My Recorded 

Meetings > [topic of a recording]. 

What you can do here 

 View information about the recording. 

 Play back the recording. 

 Send an email to share the recording with others. 

 Download the recording. 

 Enable or disable the recording 

 Open the Edit Recorded Meeting page, on which you can edit information about a 

recording. 

Options on this page 

  

Option Description 

Topic The name of the recording. You can edit the topic at any time. 

Create time The time and date the recording was created. 

Duration The length of the recording. 

Description A description of the recording. 

File size The file size of the recording. 

Create time The date and time at which the recording was created. 

Status 
The status of the recording. The possible options are Enable or 

Disable.  

Password 
Indicates whether a user must provide a password to view the 

recording. 
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Option Description 

Stream recording link 

Clicking the link lets you play the recording (available only for 

recording files with the .arf extension that were recorded by 

NBR). 

Download recording link Clicking the link lets you download the recording. 

 

Clicking the button lets you play the recording (available only for 

recording files with the .arf extension that were recorded by 

NBR). 

If you want to download the recording, you can also click the 

link for downloading under Play Recorded a meeting Now. 

 

Clicking the button opens the Share My Recording window, 

which allows you to send an email message to selected 

recipients, inviting them to play your recording. 

If you want to send the email with your local email client 

instead, click the link for using the email client under Share My 

Recording. 

 Clicking the button opens the Edit Recording page. 

 Clicking the button deletes the recording. 

 

Clicking the button disables the recording everywhere it is 

published on your WebEx Service Web site. (Available only for 

enabled recordings.) 

 

Clicking the button enables the recording everywhere it is 

published on your WebEx Service Web site. (Available only for 

disabled recordings.) 

 Clicking the button returns you to the recording list. 

 

 

About the My Recorded Meetings page 

How to access this page 

Log in to your WebEx service Web site. From the left navigation bar, click My Files 

> My Recordings. 
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What you can do here 

Manage, upload, and maintain recording files of meetings you host. 

Options on this page 

  

Option Description 

 
Refreshes the information on the page. 

Search 
Allows you type text to search for within recording names. Click 

Search to start the search. 

You are currently using X 

% of Y GB 

The percentage of available personal storage space on your 

WebEx Service Web site that is being used by your recordings. 

This field appears only if your site administrator has turned on 

the option to show personal recording storage allocation usage. 

If this field does appear, and you exceed your personal storage 

allocation, you will not be able to record meetings until some 

recordings are deleted or the storage allocation is increased by 

your system administrator. 

Site storage X % of Y GB 

The percentage of total available storage space on your WebEx 

Service Web site that is being used by all recordings on your 

site. If your site exceeds its storage allocation, users will not be 

able to record meetings until recordings are deleted or the 

storage allocation is increased by your system administrator. 

Topic 

The name of the recording. If you record a meeting on the 

server, the WebEx server automatically uploads the recording to 

this page. In this case, the topic of the recording is the topic of 

the meeting. You can edit the topic at any time. 

Size The size of the recording. 

Create Time/Date The date and time the recording was created. 

Duration The length of the recording. 

Format 

The format of the recording file. 

A recording file can be in WebEx Advanced Recording Format 

(ARF) or WebEx Recording Format (WRF). You can also store 

recording files that are in Windows Media Audio/Video (WMV) 

format. For Event Center and Training Center, you can also 

store Shockwave Flash Object (SWF) format files. 
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Option Description 

 

Lets you play the recording (available only for recording files 

with an .arf extension that were recorded by the Network-Based 

Recorder). 

If playback of the file requires a password, you must provide the 

password. 

 
Lets you send an email to share this recording with others. 

 

Displays a menu with more options for your recording: 

  Download: Lets you download the recording to your 

local computer. 

If downloading the file requires a password, you must 

provide the password. 

  Modify: Lets you edit information of the recording. For 

details, see About the Add/Edit Recordings page (on page 

341). 

  Disable: Lets you disable the recording in all locations. 

  Delete: Lets you delete the recording from this page. 

 

Lets you upload a new recording. 

For details, see Uploading a recording file (on page 338) and 

About the Add/Edit Recordings page (on page 341). 

 Indicates that a recording is password-protected. 

 

Uploading a recorded meeting file 
If you recorded meeting using the integrated or standalone WebEx Recorder, you can 

upload the recording meeting file, with a .wrf extension, from your local computer to 

the My Recorded Meetings page. 

For instructions on editing a recording, see Editing information about a recording (on 

page 339). 

  

Note: If you recorded a meeting using the WebEx Network-Based Recorder (NBR), the WebEx 

server automatically uploads the recording file, with an .arf extension, to the appropriate tab on 

the My Recorded Meetings page once you stop the Recorder. You do not need to upload it 

yourself. 

To upload a recording file: 

1 Go to the My Recorded Meetings page. For details, see . 
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2 Click Add Recording. 

3 On the Add Recorded Meeting page, enter information and specify options. 

For details about what you can do with each option on the Add/Edit Recorded 

Meetings page, see About the Add/Edit Recorded Meetings page (on page 212). 

4 Click Save. 
 

Editing information about a recorded meeting 
You can edit information about a recorded meeting at any time. 

To edit information about a recorded meeting: 

1 Go to the My Recordings page or the My Recorded Meetings page. For details, 

see Opening the My Recordings page (on page 338). 

2 Click the following icon for the recording that you want to edit. 

 

The Edit Recorded Meetings page appears. 

3 Make your changes. 

For details about what you can do with each option on the Edit Recorded 

Meetings page, see About the Add/Edit Recorded Meetings Page (on page 212). 

4 Click Save. 
 

About the Add/Edit Recorded Meetings page 

How to access this page 

If you are adding a recording... 

1 Log in to your WebEx Meeting Center service Web site. 

2 On the left navigation bar, under Host a Meeting, click My Recordings. 

3 Click Add Recording. 

If you are editing information about a recording... 

1 On your WebEx service Web site, under Host a Meeting, click My Recordings. 

2 Click the More button in the row of the recording that you want to edit. 
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3 Click Modify. 

  

 

 

What you can do here 

 Edit general information about a recording, including the topic and description. 

 Require a password to play or download the recording. 

 Specify playback control options, such as panel display options and recording 

playback range and whether to include Network Recording Play controls. 

Options on this page 

  

Use this option.... To.... 

Topic Specify the topic of the recording. 

Description Provide a description of this recording. 

Recording file Click Browse to select the recording file that resides on your 

local computer. 

Duration Specify the duration of the recording. 

File size Displays the size of the recording file. (Available only when 

editing recording information.) 

Set password Set an optional password that users must provide to view the 

recording. 

Confirm password Confirm the password that users must provide to view the 

recording. 
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Sending an email to share a recorded meeting 
You can send an email one or more people to share your recorded meeting with them.  

To send an email to share a recorded meeting with others: 

1 Go to the My Recorded Meetings page. For details, see Opening the My Recorded 

Meetings Page (on page 207). 

2 Open the Share My Recording window: 

 Click the following icon for the recording that you want to share with others. 

  

 
 

 Click the linked name of the recording you want to share. On the Recording 

Information page, click Send Email. 

  

 
 

The Share My Recording window appears. 

  

 

 

3 Select recipients for your email: 

 Click Select Recipients to select contacts from your Contacts list 

 Type email addresses in the Send to list, separated by commas. 
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4 (Optional) Type a message in the Your message box. 

5 Click Send. 

Your email message will be sent to the selected recipients, and will include 

information about the recording and a link to play it. 
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Chapter 13  

Your user role in a meeting determines your level of file sharing. Whichever role you 

take, the following table describes the basic tasks associated with that role. The type 

of files you can share include documents, presentations, and videos. 

For detailed instructions on a particular task, click “More” by the task description. 

  

 
Task description: 

Host 

 

Open and share a file or whiteboard 

 learn about tools for sharing More 

(on page 218) 

 start sharing More (on page 221) 

 assigning sharing privileges to 

participants More (on page 218) 

 save a file More (on page 234) 

Participant with granted permissions 

 

View and interact with shared files 

and whiteboards 

 display slides or pages More (on 

page 237) 

 use tools to annotate a file More 

 synchronize your view with the 

host More (on page 237) 

 

 

 

Sharing Files and Whiteboards 
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Granting sharing privileges 

To grant or remove participant privileges during a meeting: 

1 In the Meeting window, on the Participant menu, choose Assign Privileges. 

The Participant Privileges dialog box appears. 

2 Grant or remove a privilege, as follows: 

 To grant a specific privilege, select its check box. 

 To grant all privileges, select the Assign all privileges check box. 

 To remove a privilege, clear its check box. 

 To revert to the preset privileges, click Reset to Meeting Defaults. 

3 Click Assign. 
 

Content viewer tools 
  

Content Viewer Tools 

 

The tools on the content viewer toolbar 

allow you to share and perform actions on 

whiteboards, or on files, such as 

presentations or documents. 

 
Select this button at the top right of the 

content viewer to start a new whiteboard. 

 

annotation toolbar-Select a drawing tool 

for directing attention onscreen, using 

pointers, a highlighter, or drawing a shape 

More (on page 220) 
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Content Viewer Tools 

 

Viewing toolbar and menu-Change to full-

screen, rotate pages, zoom in or out using 

these tools. More 

 

Changing views in a file or whiteboard 

You can switch views in the content viewer by clicking the view icons and selecting 

from the View menu in the bottom left corner of the content viewer: 

  

 

View tools 

  

Tool Icon Description 

Show Thumbnail 
 

To display thumbnails, or miniatures, of shared pages, slides, or 

whiteboards to the side of the content, click Show Thumbnail. 

This tool helps you locate a page or slide quickly. 

Full-Screen View 
 

Displays shared content in a full-screen view. Helps to ensure that 

participants can view all activity on your screen. Also helps to 

prevent participants from viewing or using other applications on 

their screens during a presentation. 

Click ESC to return to the content viewer. 

Rotate page 
 

For documents in landscape orientation, you can rotate the pages 

to the left or right so they appear correctly in the content viewer. 

Zoom In/ 

Zoom Out  

Lets you display shared content at various magnifications. Click 

this button, and then click the page, slide, or whiteboard to 

change its magnification. For more magnification options, click the 

downward-pointing arrow. 
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Tool Icon Description 

Sync Display for 

All  

For presenters, synchronizes all participants' displays with your 

display. Helps to ensure that all participants are viewing the same 

page or slide, at the same magnification, as in your display. 

 

 

Using annotation tools on shared content 

In an online meeting, you can use annotation tools on shared content to annotate, 

highlight, explain, or point to information: 

  

 
Basic annotation tools  

  

Annotation 
Tool Icon Description 

Pointer 
 

Lets you point out text and graphics on shared content. The pointer 

displays an arrow with your name and annotation color. To display the 

laser pointer, which lets you point out text and graphics on shared 

content using a red “laser beam,” click the downward-pointing arrow. 

Clicking this button again turns off the pointer tool. 

Text 
 

Lets you type text on shared content. Participants can view the text 

once you finish typing it and click your mouse in the content viewer, 

outside the text box. 

To change the font, on the Edit menu, choose Font. Clicking this button 

again turns off the text tool. 

Line 
 

Lets you draw lines and arrows on shared content. For more options, 

click the downward-pointing arrow. Clicking this button closes the 

Rectangle tool. 

Rectangle 
 

Lets you draw shapes, such as rectangles and ellipses on shared 

content. For more options, click the downward-pointing arrow. Clicking 

this button again closes the Rectangle tool. 

Highlighter 
 

Lets you highlight text and other elements in shared content. For more 

options, click the downward-pointing arrow. Clicking this button again 

closes the Highlighter tool 

Annotation 

Color  

Displays the Annotation Color palette, on which you can select a color 

to annotate shared content. Clicking this button again closes the 

Annotation Color palette. 
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Annotation 
Tool Icon Description 

Eraser 
 

Erases text and annotations or clears pointers on shared content. To 

erase a single annotation, click it in the viewer. For more options, click 

the downward-pointing arrow. Clicking this button again turns off the 

eraser tool. 

  

 

Sharing files 
File sharing is ideal for presenting information that you do not need to edit during the 

meeting, such as a video or slide presentation. Participants can 

 view shared files in their content viewers without the need for the application with 

which it was created.  

 view a media file, such as a video, without the need for special software or 

hardware.  

 view any animation and transition effects on shared Microsoft PowerPoint slides.  

After a meeting starts, you can open a presentation or document to share. You do not 

need to select it or “load” it before the meeting. 

While sharing a file, you can: 

 Draw on the screen  

 Use a pointer to emphasize text or graphics  

 Print it More 

 Display it at various magnifications, in miniature (thumbnails), and in a full-

screen view More (on page 231) 

 Synchronize all participants' displays with the display in your content viewer 

More (on page 232) 

 Save it to a file More (on page 234) 
 

At any time during a meeting, you can grant participants privileges that allow them to 

annotate, save, print, and display different views of shared content. 
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Sharing a file 

You can share a file, such as a document, presentation, or video, that resides on your 

computer. Participants view the shared file in their content viewers. 

To share a file: 

1 On the Share menu, choose File. 

The Share File dialog box appears. 

2 Select the document or presentation that you want to share. 

3 Click Open. 

The shared document or presentation appears in the content viewer. 
 

Choosing an import mode for presentation sharing 

For Windows users only 

Before you share a presentation, you can choose one of the following import modes: 

 Universal Communications Format (UCF)-The default mode. Lets you display 

animations and slide transitions in Microsoft PowerPoint presentations. In the 

UCF mode, Meeting Manager imports presentations more quickly than it does in 

the printer driver mode. However, pages or slides may not appear consistently in 

Meeting Manager across platforms. 

 Printer driver-Displays shared presentations as they appear when you print them, 

providing a consistent appearance of pages and slides in Meeting Manager across 

platforms. However, this mode does not support animations or slide transitions. In 

this mode, the first page or slide may appear quickly, but the total import time for 

all pages or slides is usually longer than it is in the UCF mode. 

  

Note: Changing the import mode does not affect any presentations that you are currently sharing. 

To apply a new import mode to a shared presentation, you most close it first, and then share it 

again. 

To choose an import mode for shared presentations: 

1 In the Meeting window, on the Meeting menu, choose Options. 

The Meeting Options dialog box appears, with the Options tab selected by 

default. 
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2 Click the Import Mode tab. 

  

 

 

The Import Mode tab 

options appear. 

3 Select either Universal Communications Format or Printer driver. 
 

Sharing a whiteboard 
Sharing a whiteboard allows you to draw objects and type text that all Participants can 

see in their content viewers. You can also use a pointer to emphasize text or graphics 

on a whiteboard. 

Other things you can do while sharing a whiteboard: 

 Display it at various magnifications, in miniature (thumbnails), and in a full-

screen view.  

 Copy and paste images into it 

 Reorder its position in reference to any other whiteboards 

 Print it 

 Synchronize Participants' displays with the display in your content viewer  More 

(on page 232) 

 Save it 

If you allow participants to annotate slides and pages, you and participants can draw 

and type on a whiteboard simultaneously. You can also allow participants to save, 

print, and display different views of shared whiteboards. For details, see Granting 

sharing privileges (on page 218). 
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Starting whiteboard sharing 

You can share a whiteboard on which you can draw and write. Participants can view a 

shared whiteboard in their content viewers. 

To share a whiteboard: 

On the Share menu, choose Whiteboard. 

  

Note:  

 You can add multiple pages to a shared whiteboard. For details, see Adding new pages or 

slides (on page 227). 

 You can share multiple whiteboards. For each whiteboard that you share, you see a new 

Whiteboard tab in the content viewer. 

 

 

 

Navigating presentations, documents, or 
whiteboards 

When sharing a file, such as a document, presentation, or whiteboard, you can 

 Navigate slides, pages, or whiteboards using the toolbar More (on page 224)  

 Advance pages or slides automatically, at an interval of time that you specify 

More (on page 225) 

 Perform animations and slide transitions in a presentation More (on page 226)  

 Use keys on your computer's keyboard to navigate a presentation and display 

animations on the slides More 
 

Navigating slides, pages, or whiteboards using the toolbar 

You can navigate to different pages, slides, or whiteboard “pages” in the content 

viewer. Each document, presentation, or whiteboard being shared appears on a tab at 

the top of the content viewer. 
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To display pages or slides in the content viewer: 

1 In the Meeting window, in the content viewer, select the tab for the document, 

presentation, or whiteboard that you want to display. 

If there are more tabs than can appear at one time, select the down arrow button to 

see a list of remaining tabs, or use your keyboard arrows forward and back 

through all the tabs. 

  

 

 

Select the down arrow 

to view remaining tabs 

2 On the toolbar, click a button to change the page or slide you are viewing. 

  

 

 

Select the  

 drop-down arrow to choose any page or 

slide 

 left arrow to see the previous page or 

slide 

 right arrow to see the next page or slide 

 

  

Note:  

 Alternatively, you can navigate to different pages or slides in a shared document, 

presentation, or whiteboard by opening the thumbnail viewer. For details, see Viewing 

thumbnails (on page 231). 

 You can advance pages or slides automatically at a time interval that you specify. For details, 

see Advancing pages or slides automatically (on page 225). 

 If you your presentation includes animations or slide transitions, you can use the toolbar or 

keyboard shortcuts to perform them. For details, see Animating and adding effects to shared 

slides (on page 226). 

 

Advancing pages or slides automatically 

When sharing a document or presentation in the content viewer, you can 

automatically advance pages or slides at a specified interval. Once you start automatic 

page or slide advancement, you can stop it at any time. 
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To automatically advance pages or slides: 

1 In the Meeting window, in the content viewer, select the tab for the document or 

presentation for which you want to advance pages or slides automatically. 

2 On the View menu, choose Automatically Advance Pages. 

The Automatically Advance Pages dialog box appears. 

3 To change the time interval for advancing pages, do one of these: 

 click the up or down buttons to increase or decrease the interval 

 type a specific time interval 

  

 

 

Optional:To restart page or slide 

advancement once all pages or slides 

are displayed, select the Return to 

beginning and continue advancing 

pages check box. 

4 Click Start. 

5 Optional. Close the Automatically Advance Pages dialog box by clicking the 

Close button in the upper-right corner of the dialog box. 

The pages or slides continue to advance at the specified interval. 

To stop automatic page or slide advancement: 

1 If you closed the Automatically Advance Pages dialog box, on the View menu, 

choose Automatically Advance Pages. 

The Automatically Advance Pages dialog box appears. 

2 Click Stop. 
 

Animating and adding effects to shared slides 

When sharing a Microsoft PowerPoint slide presentation in the content viewer, you 

can animate text and slide transitions, just as you can when using the Slide Show 

option in PowerPoint. 

  

Note: To show slide animations and transitions, you must share the presentation as a Universal 

Communications Format (UCF) file (.ucf). The UCF import mode automatically converts a 

PowerPoint file (.ppt) to a UCF file when you share it. More (on page 222) 
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 For best results when sharing a presentation created using Microsoft PowerPoint 2002 for 

Windows XP, use a computer with an Intel Celeron or Pentium 500 MHz or faster processor. 

 If at least one meeting participant is using the Java Meeting Manager, animations and slide 

transitions will not display during the meeting. The meeting host can prevent participants 

from joining a meeting using the Java Meeting Manager when scheduling the meeting. 

To show slide animations and transitions in a shared presentation: 

1 Ensure that the content viewer has input focus by clicking in the viewer. 

The content viewer has input focus if a blue border appears around the outside of 

the slide in the viewer. 

2 On the toolbar, select the appropriate arrows to move through your presentation. 

  

 

 

Select the  

 drop-down arrow to select any page or slide 

 left arrow to see the previous page or slide 

 right arrow to see the next page or slide 

 

 

 

Working with pages or slides 

When sharing a file, such as a document, presentation, or whiteboard, you can 

 Add new, blank pages or slides for annotation More (on page 227) 

 Paste images that you copy to your computer's clipboard into a new page or slide 

in a shared document, presentation, or whiteboard More (on page 228) 
 

Adding new pages to shared files or whiteboards 

When sharing a file or whiteboard in the content viewer, you can add a new, blank 

page for annotation. 

To add a new page or slide: 

1 In the content viewer, select the tab for the document, presentation, or whiteboard 

to which you want to add a page or slide. 

2 Select Add Page from the Edit menu. 
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A new page appears in the content viewer at the end of the currently selected 

document, presentation, or whiteboard. 

  

Tip: If you have added multiple pages to a shared file or whiteboard tab, you can view thumbnails 

(on page 231) to make it easy to view and navigate around your added pages. 

 

 

Pasting images in slides, pages, or whiteboards 

If you copy any bitmap image to your computer's clipboard, you can paste the image 

into a new page, slide, or whiteboard in the content viewer. 

For example, you can copy an image on a Web page or in an application, then quickly 

share that image by pasting it in the content viewer. 

To paste an image in a page, slide, or whiteboard in the content viewer: 

1 In the content viewer, select the tab for the document, presentation, or whiteboard 

in which you want to paste an image. 

2 On the Edit menu, choose Paste As New Page. 

The image appears on a new page in the content viewer, at the end of the currently 

selected document, presentation, or whiteboard. 

  

Note: You can paste any type of bitmap image, such as a GIF, JPEG, BMP, or TIF image in the 

content viewer. However, you cannot paste other types of images-such as EPS or Photoshop 

(PSD) images-in the content viewer. 

 

 

Managing views of presentations, documents, or 
whiteboards 

All shared files, such as presentations, documents, or whiteboards, appear in the 

content viewer in the Meeting window. A tab at the top of the content viewer appears 

for each document, presentation, or whiteboard that is being shared. 

Depending on your role and the privileges that you have, you can do the following 

when viewing shared content in the content viewer: 

 Magnify (on page 229) slides, pages, or whiteboards 
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 View thumbnails (on page 231) of slides, pages, or whiteboards. 

 Display a full-screen view (on page 230) of a page, slide, or whiteboard. 

 Synchronize all participant views (on page 232) of a page or slide with the view 

that appears in your content viewer 
 

Zooming in or out 

Using the tools on the content viewer toolbar, you can: 

 Zoom in to or out from a page, slide, or whiteboard 

 Adjust the size of a page, slide, or whiteboard to fit the content viewer 

 Turn off the Zoom tool at any time 

To zoom in to or out from a page, slide, or whiteboard: 

On the content viewer toolbar: 

 Select the Zoom In or Zoom In button, and then drag your mouse to the area. 

Release your mouse button. 

 To zoom in or out to a preset percentage, select the downward-pointing arrow to 

the left of the Zoom In/Zoom Out button, and then choose the percentage. 

  

 

 
  

To adjust the size of a page, slide, or whiteboard within the content viewer: 

On the toolbar, select the downward-pointing arrow to the left of the Zoom In/Zoom 

Out buttons. 
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Choose a viewing option  

To turn off a zoom tool: 

On the toolbar, click the Zoom In/Zoom Out button. 
 

Controlling full-screen view 

You can maximize the size of a page, slide, or whiteboard in the content viewer to fit 

your monitor's entire screen. A full-screen view replaces the normal meeting window 

view. You can return to a normal view at any time. 

  

Note: If a meeting presenter displays a full-screen view of a page, slide, or whiteboard, 

participant screens automatically display a full-screen view as well. However, participants can 

control full-screen view independently in their meeting windows. 

To display a full-screen view: 

  

 
On the content viewer toolbar, select the Full Screen icon. 

To return to a normal view: 

  

 

On the Meeting Controls Panel, select the stop 

icon to return to the main window. 
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Viewing thumbnails 

You can view thumbnails of the shared pages, slides, and whiteboards that appear in 

the content viewer. Thumbnails provide a fast way to locate a shared page or slide that 

you want to display in the content viewer. 

To view thumbnails of slides, pages, or whiteboards: 

1 In the content viewer, select the tab for the document, presentation, or whiteboard 

for which you want to view thumbnails. 

2 On the content viewer toolbar, select Show Thumbnails from the View menu. 

  

 

 

 

Thumbnails of all pages or slides in the selected document, presentation, or 

whiteboard appear in the thumbnail viewer, in the left column. 
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3 Optional. To display any page or slide in the content viewer, double-click its 

miniature in the thumbnail viewer. 

  

Note: Participants must have both the View thumbnails and View any page privileges to display 

a miniature of a page or slide at full size in the content viewer. 

To close the thumbnail viewer: 

On the content viewer toolbar, select Hide Thumbnail from the View menu.. 
 

Synchronizing all participant views 

You can synchronize the display of a shared page, slide, or whiteboard in all 

participant content viewers with the display in your viewer. Once you synchronize 

displays, the page, slide, or whiteboard in participant content viewers appears at the 

same magnification as in your content viewer. 

To synchronize participant views of slides, pages, or whiteboards: 

On the View menu at the bottom of the window, select Sync Display for All. 

  

 
Sync Display for All 

 

 

Clearing annotations 

You can clear any annotations made by you or another participant on a shared page, 

slide, or whiteboard in the content viewer. You can clear: 

 All annotations at once 

 Only specific annotations 

 If you are the presenter or host, clear all annotations you have made 

  

 
annotation tools 

To clear all annotations on a shared page, slide, or whiteboard: 

1 On the annotation toolbar, click the downward-pointing arrow to the right of the 

Eraser Tool icon. 
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Eraser tool 

2 Choose Clear All Annotations. 

  

Note: Only annotations on the page or slide that currently appears in your content viewer are 

cleared. Annotations on other pages or slides are not cleared. 

If you are the host or presenter, you can clear all the annotations you've made. 

To clear all annotations you have added to a shared page, slide, or whiteboard: 

1 On the annotation toolbar, click the downward-pointing arrow to the right of the 

Eraser Tool icon. 

  

 
 

Eraser tool 

2 Choose Clear My Annotations. 

To clear specific annotations on a shared page, slide, or whiteboard: 

1 On the toolbar, click the Eraser Tool icon. 

  

 
 

Eraser tool 

Your mouse pointer changes to an eraser. 

2 Click the annotation you want to clear. 

To turn off the eraser tool: 

On the toolbar, click the Eraser Tool icon. 

  

 
Eraser tool 
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Clearing pointers 

You can clear your own pointers on all shared slides, pages, or whiteboards in the 

content viewer. If you are a presenter, you can also clear all participant pointers. 

  

 

annotation tools 

To clear your own pointer on all shared slides, pages, or whiteboards: 

1 On the toolbar, click the downward-pointing arrow to the right of the Eraser Tool 

icon. 

  

 
 

Eraser tool 

2 Choose Clear My Pointer. 
 

 

Saving, opening, and printing presentations, 
documents, or whiteboards 

Meeting participants (hosts, presenters, and participants with privileges) can access 

and print documents, presentations, and whiteboards shared in a meeting. For 

example, you can: 

 save a shared presentation More (on page 234) 

 open a saved document More (on page 235) 

 print a whiteboard More (on page 236) 
 

Saving a presentation, document, or whiteboard 

You can save any shared document, presentation, or whiteboard that appears in the 

content viewer. A saved file contains all the pages or slides in the document, 

presentation, or whiteboard that is currently displayed in the content viewer, including 

any annotations and pointers that you or other attendees added to them. 

Files that you save are in the Universal Communications Format (UCF), which have a 

.ucf extension. You can open a .ucf file either in another meeting or at any time 

outside of a meeting. 
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Once you save a new document, presentation, or whiteboard to a file, you can save it 

again to overwrite the file or save a copy to another file. 

To save a new document, presentation, or whiteboard that appears in the content 

viewer: 

1 On the File menu, choose Save > Document. 

The Save Document As dialog box appears. 

2 Choose a location at which to save the file. 

3 Type a name for the file in the File name box. 

To save changes to a saved document, presentation, or whiteboard that appears in the 

content viewer: 

On the File menu, choose Save > Document. 

Meeting Manager saves the changes to the existing file. 

To save a copy of a document, presentation, or whiteboard: 

1 On the File menu, choose Save As > Document. 

The Save Document As dialog box appears. 

2 Do either or both of the following: 

 Type a new name for the file. 

 Choose a new location at which to save the file. 
 

Opening a saved document, presentation, or whiteboard 

If you saved a document, presentation, or whiteboard that appeared in the content 

viewer during a meeting, you can do either of the following: 

 Open file in the content viewer during another meeting for sharing. Only a 

presenter or participants who have the Share documents privilege can open a 

saved file during a meeting. 

 Open the file at any time on your computer's desktop. If you open a saved file on 

your desktop, it appears in the WebEx Document Manager, a standalone, or 

“offline,” version of the content viewer. 

A saved document, presentation, or whiteboard is in the saved Universal 

Communications Format (UCF) and has a .ucf extension. 
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To open a saved document, presentation, or whiteboard file in the content viewer: 

1 On the File menu, choose Open and Share. 

The Share Document dialog box appears. 

2 Select the document, presentation, or whiteboard file that you want to open. 

3 Click Open. 

To open a saved document, presentation, or whiteboard on your computer's desktop: 

Double-click the saved file. 

The document, presentation, or whiteboard opens in the WebEx Document Viewer. 
 

Printing presentations, documents, or whiteboards 

You can print any shared presentations, documents, or whiteboards that appear in 

your content viewer. A printed copy of shared content includes all added annotations 

and pointers. 

To print shared content: 

1 In the content viewer, select the tab for the document, presentation, or whiteboard 

that you want to print. 

2 On the File menu, choose Print > Document. 

3 Select the printing options that you want to use, and then print the document. 

  

Note: When printing shared content in the content viewer, Meeting Manager resizes it to fit on 

the printed page. However, for whiteboards, the Meeting Manager prints only the content that lies 

within the dashed lines on the whiteboard. 

 

 

If you are a meeting participant... 
If you are participating in a meeting (and have not taken on another role, such as host 

or presenter), you can move around independently in shared documents and 

presentations if the host has assigned these privileges to you. For shared documents, 

presentations, and whiteboards, you can: 

 display any page More (on page 237) 

 synchronize your view with the host's view More (on page 237) 
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 save shared documents More (on page 234) 

 open shared documents More (on page 235) 

 print shared documents More (on page 236) 
 

Displaying pages, slides, or whiteboards 

For participants 

If you have been granted the necessary privileges, you can navigate to different pages, 

slides, or whiteboard “pages” in the content viewer. Each document, presentation, or 

whiteboard being shared appears on a tab at the top of the content viewer. 

1 In the Meeting window, in the content viewer, select the tab for the document, 

presentation, or whiteboard that you want to display. 

If there are more tabs than can appear at one time, select the down arrow button to 

see a list of remaining tabs, or use your keyboard arrows forward and back 

through all the tabs. 

  

 

 

Select the down arrow 

to view remaining tabs 

2 On the toolbar, click a button to change the page or slide you are viewing. 

  

 

 

Select the  

 drop-down arrow to choose any page or 

slide 

 left arrow to see the previous page or 

slide 

 right arrow to see the next page or slide 

 
 

Synchronizing your view of pages, slides, or whiteboards 

During a meeting, you can synchronize the display of shared content in your content 

viewer with the display in the presenter's viewer. This option is useful, for example, if 

you are viewing a previous slide in a presentation and want to quickly return to the 

actual slide that the presenter is discussing. Synchronizing your display also resizes it 

to that in the presenter's content viewer. 
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To synchronize your view of shared content in the presentation viewer: 

On the View menu at the bottom of the window, select Sync Display With 

Presenter. 

  

 
Sync Display With Presenter 
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Chapter 14  

  

If you want to... See... 

get an overview of sharing Web content About sharing Web content (on page 239) 

share Web content with meeting participants Sharing Web content (on page 240) 

understand the differences between sharing a 

browser and sharing Web content 

Differences between sharing Web content 

and sharing a Web browser (on page 240) 

 

About sharing Web content 
You can share Web content that resides on: 

 The public Internet or Web 

 Your company's intranet 

 Your computer or another computer on your private network 

Web content includes: 

 Web pages, including pages that contain embedded media files, such as Flash, 

audio, or video files 

 Standalone media files, such as Flash, audio, or video files 

The Web content that you share opens in the content viewer on each participant's 

screen. If you share a Web page, participants view and interact independently with the 

content on the page. If the page contains links to other pages, they can also navigate 

independently to those pages. 

Sharing Web Content 
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If you use Web content sharing, then, participants can experience audio and video 

effects on a Web page. However, unlike Web browser sharing, this option does not 

allow you to guide participants to other Web pages. For more information, see 

Differences between sharing Web content and sharing a Web browser (on page 240). 

  

Important: If you share content that requires a media player, participants can view and interact 

with the content only if the appropriate player is installed on their computers. 

 

Sharing Web content 
You can share a Web page that contains multimedia effects. The page opens in the 

content viewer on each participant's screen. 

To share Web content: 

1 On the Share menu, choose Web Content. 

The Share Web Content dialog box appears. 

2  In the Address box, enter the address, or URL, at which the content resides. 

Or, if you have previously shared the content, select it in the drop-down list. 

3 In the Type box, select the type of Web content that you want to share. 

4 Click OK. 

  

Tip: You can copy a URL from any source, such as another browser window, and then paste it in 

the Address box. 

 

Differences between sharing Web content and 
sharing a Web browser 

Meeting Center provides two options for sharing Web-based information. You can 

share Web content or share a Web browser with meeting participants. Choose the 

feature that better suits your needs. 
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Sharing option Advantages Disadvantages 

Web browser sharing  Lets you guide 

participants to various 

Web pages and sites on 

the Web. 

 Lets you grant attendees 

control of your Web 

browser. 

 Lets you and other 

participants annotate 

Web pages. 

 Does not display media 

effects or transmit 

sounds on Web pages. 

 Does not let participants 

interact with Web pages 

independently. 

Web content sharing  Displays Web pages, 

and lets participants 

experience media effects 

on Web pages, including 

video and sound. 

 Lets participants interact 

with Web pages 

independently in their 

content viewers. 

Does not let you guide 

participants to other Web 

pages. 
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Chapter 15  

Sharing a tool, like a software application, works differently from sharing a document 

or presentation. When you share software during a meeting, a sharing window opens 

automatically on all participant screens. You can show, in this special sharing 

window: 

 an application (for example, you want to edit a document as a group or show 

your team how a tool works) 

 computer desktop (for easily sharing several applications at once and for sharing 

file directories open on your computer) 

 web browser (useful for sharing particular Web pages with participants or 

showing a private intranet) 
 

 any application or the desktop on a remote computer with Access Anywhere 

installed on it (for example, you are on the road, and the computer in your office 

has the information you need) 
 

Your site settings and your user role in a meeting determines your level of 

participation in sharing software. Whichever role you take, this table describes the 

basic tasks associated with that role. For detailed instructions on a particular task, 

select "More" by the task description. 

Sharing Software 
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Role  Task description: 

host and 

presenter  

 

Share software: 

 Share applications More… (on 

page 244) 

 Share your desktop More (on 

page 247) 

 Share a Web browser More (on 

page 249) 

 Share a remote computer  More 

(on page 251) 

 Control the appearance of shared 

software More (on page 260) 

 Annotate shared software More 

(on page 268) 

 Let a participant control your 

shared software More 

participant 

 

 

View and work with shared software: 

 Control the appearance of shared 

software More (on page 265) 

 Ask to control shared software 

More (on page 275) 

 Annotate shared software More 

(on page 268) 

 Stop participating in software 

sharing More (on page 277) 

 

 

Sharing applications 
You can use application sharing to show all meeting participants one or more 

applications on your computer. Application sharing is useful for demonstrating 

software or editing documents during a meeting. 
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Participants can view the shared application, including all mouse movements without 

having to run the application that you are sharing on their computers. 

Here are just a few tasks you can perform: 

 Start sharing an application More (on page 245) and open more applications to 

share More (on page 246) 

 Control the appearance and viewing of shared software (pausing, changing to full-

screen view, and so on) More (on page 260) 

 Annotate and draw on a shared application More (on page 268) and allow 

participants to draw More 

 Learn about sharing application effectively More (on page 280) 

 Stop sharing an application More (on page 247) 
 

Starting application sharing 

Host or Presenter only 

You can share any application on your computer with meeting participants. 

To share an application: 

1 On the Share menu, choose Application. 

The list of all applications currently running on your computer is displayed. 

  

 

 

2 Do one of the following: 
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 If the application you want to share is currently running, select it in the list to 

begin sharing it. 

 If the application you want to share is not currently running, select Other 

Application. The Other Application dialog box appears, showing a list of all 

applications on your computer. Select the application, and then select Share. 

Your application appears in a sharing window on participant screens. 

For tips that can help you to share applications more effectively, see Tips for Sharing 

Software (on page 280). 
 

Sharing several applications at once 

Host or Presenter only 

If you are already sharing an application, you can share additional applications 

simultaneously. Each application that you share appears in the same sharing window 

on participant screens. 

To share an additional application: 

Select the application you want to share: 

 If that application is currently running: Select the Share button. 

  

 
 

Each application you have open on your desktop 

has these buttons in the upper right corner 

  

 
Tip: When you open any application that you have minimized, it opens with the sharing 

buttons in the upper-right corner. 

 

 If the application is not currently running: Select the Share Application 

button in the Meeting Controls Panel. You can also find it using File Explorer 

or any other tool you use to locate applications on your computer. When you 

open it, it appears with the Share button. 

Your application appears in a sharing window on participant screens. 

Meeting Center tracks the number of applications you are currently sharing: 

  

 

 

The Share button to the 

right of Pause lets you 

select the different types of 

content you want to share. 
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Tip: Alternatively, you can share multiple applications by sharing your computer's desktop. For 

details, see Sharing your desktop. (on page 247) 

 

 

Stopping application sharing for all participants 

Host or Presenter only 

You can stop sharing an application at any time. Once you stop sharing an 

application, participants can no longer view it. 

If you are sharing multiple applications simultaneously, you can stop sharing either a 

specific application or all applications at once. 

To stop sharing a specific application when sharing multiple applications: 

On the title bar of the application that you no longer want to share, select the Stop 

button, or in the Meeting Controls Panel, select the STOP button. 

  

 

To stop sharing all applications: 

In the Meeting Controls Panel, select the STOP button. 

  

 

You can also pause sharing: Select the Pause button (located next to the Stop button). 

 

 

Sharing your desktop 
You can share the entire content of your computer, including any applications, 

windows, and file directories that reside on it. Participantscan view your shared 

desktop, including all mouse movements. 
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Tasks related to sharing your desktop: 

 Start sharing your desktop More (on page 248) 

 Manage how participants view your shared software (pausing, changing to full-

screen view, and so on) More (on page 260) 

 Annotate and draw on your desktop More (on page 268) and allow participants to 

annotate More 

 Read a few tips for sharing your desktop effectively More (on page 280) 

 Stop sharing your desktop More (on page 249) 
 

 Allow a participant to control the shared desktop More… 
 

Starting desktop sharing 

Host or Presenter only 

You can share your computer's desktop with meeting participants. 

To share your desktop: 

1 On the Share menu, choose Desktop. 

If you have more than one monitor, a submenu shows the available monitors. 

  

 

 

2 Select the monitor to share. 

Your desktop appears in a sharing window on participants' screens. 
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For ideas that can help you to share your desktop more effectively, see Tips for 

Sharing Software. (on page 280) 

  

Note: If your desktop has any background images or patterns, or wallpaper, your Meeting 

Manager software may remove them from participant views to improve the performance of 

desktop sharing. 

 

 

Stopping desktop sharing 

You can stop desktop sharing at any time. 

To stop sharing your desktop: 

In the Meeting Controls Panel, select the Stop button. 

  

 

You can also pause sharing: Select the Pause 

button (located next to the Stop button). 

If you are a participant, rather than the presenter, select the Return button to leave the 

sharing session. 

  

 

You do not leave the meeting, just the sharing 

portion of it. 

 

 

Sharing a Web browser 
A presenter uses Web browser sharing to show all meeting participants all Web pages 

that he or she accesses in a browser. Web browser sharing is useful for showing 

participants Web pages on the Internet, or the presenter's private intranet or computer. 

Participants can view the presenters Web browser, including mouse movements, in a 

sharing window on their screens. 

Tasks related to sharing a Web browser: 

 Start sharing a web browser More (on page 250) 

 Manage how participants view the shared Web browser More 
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 Annotate and draw on a shared Web browser More and let a participant draw on a 

shared Web browser More 

 Learn how to share Web browsers effectively More (on page 280) 

 Stop sharing a Web browser More (on page 250) 
 

Starting Web browser sharing 

Host or Presenter only 

You can share a Web browser with meeting participants. 

To share a Web browser: 

1 On the Share menu, choose Web Browser. 

Your default Web browser opens. 

2 Go to a Web page in your browser. 

  

Note: Participants view all new Web browser windows that you open. You can show 

participants several Web pages simultaneously 

 

 

 

Stopping Web browser sharing 

You can stop sharing a Web browser at any time. 

To stop Web browser sharing: 

On the title bar of the application that you no longer want to share, select the Stop 

button. 

  

 

  

Tip: You can temporarily pause Web browser sharing, rather than stopping Web browser sharing. 

For details, see Pausing and resuming software sharing (on page 261) 
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Sharing a remote computer 
A presenter uses remote computer sharing to show all meeting participants a remote 

computer. Depending on how the remote computer is set up, the presenter can show 

the entire desktop or just specific applications. Remote computer sharing is useful to 

show participants an application or file that is available only on a remote computer. 

Participants can view the remote computer, including all the presenter's mouse 

movements, in a sharing window on their screens. 

As presenter, you can share a remote computer during a meeting if: 

 You have installed the Access Anywhere Agent on the remote computer 

 You logged in to your Meeting Center Web site before joining the meeting, if you 

are not the original meeting host 

For information about setting up a computer for remote access, refer to the Access 

Anywhere User's Guide. 

Tasks related to sharing a remote computer: 

 Start sharing a remote computer More (on page 251) 

 Manage how and what participants view on the shared remote computer(pausing, 

changing to full-screen view, and so on) More (on page 260) 

 Change settings on a remote computer while sharing it More (on page 255) 

 Stop sharing a remote computer More (on page 254) 
 

Starting remote computer sharing 

Host or Presenter only 

If you have already set up a computer for Access Anywhere, you can share the 

computer during a meeting. 

To share a remote computer: 

1 On the Share menu, choose Remote Computer. 

2 The Access Anywhere dialog box appears. 
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3 Under Remote Computers, select the computer you want to share. 

4 Under Applications, select an application that want to share. 

If you set up the remote computer so you can access its entire desktop, the option 

Desktop appears under Applications. 

5 Select Connect. 

Depending on the authentication method you chose when you set up the computer 

for Access Anywhere, you perform one of these tasks: 

 If you chose access code authentication: You enter the access code you 

typed when you set up the remote computer. 

 If you chose phone authentication: You receive a phone call at the number 

that you entered when you set up the remote computer. 

6 Complete your authentication. 

 If you chose access code authentication: Type your access code in the box, 

and then select OK. 

 If you chose phone authentication: Follow the voice instructions. 

  

Note:  

 If you are not the original meeting host, you must log in to your Meeting Center Web site 

before joining a meeting in which you want to share a remote computer. If you are already in 

a meeting, but did not log in to your site, you must leave the meeting, log in to your site, and 

then rejoin the meeting. 

 If a password-protected screen saver is running on the remote computer, your meeting service 
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automatically closes it once you provide your access code or pass code. 

 If the remote computer is running Windows 2000, and you must log in to the computer, send 

a Ctrl+Alt+Del command to the computer. 

 If you set up the remote computer so you can access multiple applications, you can share 

additional applications simultaneously. 

 

 
 

Sharing additional applications on a shared remote computer 

Host or Presenter only 

While sharing a remote computer on which you have specified that you can access 

only specific applications rather than its entire desktop, you can share additional 

applications on the remote computer. Meeting participants can view all shared 

applications simultaneously. 

To share an additional application on a shared remote computer: 

1 On the Meeting Controls Panel, select the down arrow button (it is the last button 

on the Meeting Controls Panel). Then choose Share Remote Application. 

  

 

 

2 In the Select Application box, select the application you want to share. 
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After you choose another 

application to share, all 

previously selected 

applications remain open. 

Example: You opened the 

Paint application first. Then 

you chose Notepad from the 

Select Application box. 

Both applications remain 

open on the shared desktop. 

3 Select OK. 
 

Stopping remote computer sharing 

Host or Presenter only 

You can stop sharing a remote computer during a meeting at any time. Once you stop 

sharing a remote computer, the Access Anywhere Server disconnects your local 

computer from the remote computer. The remote computer remains logged into the 

Access Anywhere Server, so you can access it again at any time. 

Before you stop remote computer sharing: 

To ensure your privacy and the security of your remote computer, do one of the 

following: 

 Close any applications that you started during the sharing session. 

 If the remote computer is running Windows 2000, and you have administrator 

rights on the computer, log off from or lock the computer. To access these options 

on the computer, send a Ctrl+Alt+Del key combination to the remote computer 

More… (on page 259) 

 Specify a screen saver password, and set the screen saver to appear after short 

period of inactivity-for example, 1 minute. 

 Shut down the computer, if you do not plan to access it again remotely. 
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To stop remote computer sharing: 

On the Meeting Controls Panel, select Stop Sharing. 

  

 

 

Sharing stops and you return to Meeting Manager. 
 

Managing a shared remote computer 
Host or Presenter only 

While sharing a remote computer during a meeting, you can manage the remote 

computer by setting options and sending commands. 

Options you can set: 

 Disable or enable the keyboard and mouse on the remote computer More (on page 

256) 

 Reduce the screen resolution on the remote computer to match that of your 

computer, or restore the resolution on the remote computer More (on page 256) 

 Adjust the size of the view of the remote computer that appears in the sharing 

window, including zooming in to and out from the view and scaling the view to fit 

the sharing window More (on page 257) 

 Hide or display the contents on the remote computer's screen at the remote 

location More (on page 258) 

  

Note: Any changes that you make to options affect the remote computer only during the current 

sharing session. The changes do not affect the default options that you set for the remote computer 

in the Access Anywhere Agent preferences. 

Commands you can send: 

 Ctrl+Alt+Del key combination, which allows you to access options to log in to, 

log out from, lock, or unlock a Windows PC More (on page 259) 

 A command to bring remote applications to the front of your screen, if they are 

either behind other applications or minimized More (on page 259) 
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Reducing the screen resolution for a shared remote 
computer 

While sharing a remote computer, you can reduce the screen resolution on the remote 

computer. This option helps to prevent the need to scroll while viewing the desktop or 

applications on the remote computer. The reduced screen resolution also appears in all 

participant sharing windows. You can return a remote computer's screen resolution to 

its original setting at any time during a remote access session. 

To reduce the screen resolution on a remote computer: 

On the Meeting Controls Panel, select the down arrow button (it is the last button on 

the Meeting Controls Panel). Then choose Reduce Screen Resolution to Match This 

Computer. 

  

 

  

Note:  

 If you reduce the screen resolution a remote computer during a sharing session, the Access 

Anywhere Agent restores the resolution to its original setting once you end the session. 

 You can specify whether or not the remote computer's screen resolution is reduced 

automatically once you connect to the computer remotely. For details, refer to the Access 

Anywhere User's Guide. 

 

Disabling and enabling the keyboard when sharing a remote 
computer 

Host or Presenter only 
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While sharing a remote computer, you can disable the keyboard and mouse on the 

remote computer, thereby preventing anyone from using the computer while you are 

accessing it remotely. You can re-enable a remote computer's keyboard and mouse at 

any time. 

To disable or enable a remote computer's keyboard and mouse: 

On the Meeting Controls Panel, select the down arrow. Then choose Disable 

Keyboard and Mouse. 

  

 

The down arrow is located at the end of the 

Meeting Controls Panel. 

A check mark next to the command indicates that the keyboard and mouse are 

disabled. If no check mark appears, the keyboard and mouse are enabled. 

  

Note:  

 If you disable a remote computer's keyboard and mouse during a sharing session, the Access 

Anywhere Agent re-enables them once you end the session. 

 You can specify whether or not the remote computer's keyboard and mouse are disabled 

automatically once you connect to the computer remotely. For details, refer to the Access 

Anywhere User's Guide. 

 

Adjusting the size of the view of a shared remote computer 

Host or Presenter only 

While sharing a remote computer, you can adjust the size of the shared view using 

one of these methods: 

 Select a preset percentage at which to view the remote computer. 

 Zoom in to and out from the remote computer in increments. 
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 Scale the remote computer view to fit the sharing window in which it appears. 

To adjust the size of the view of a shared remote computer: 

On the Meeting Controls Panel, select the down arrow (the last button on the 

panel)and then choose View. Choose a display option from the menu. 

  

 

 

 

Hiding the contents on a shared remote computer's screen 

Host or Presenter only 

While sharing a remote computer, you can make a remote computer's screen blank, 

thereby preventing anyone at the remote computer's location from viewing the 

contents of the screen. If the contents on a remote computer's screen are hidden, you 

can display them at any time. 

To hide or display the contents on a remote computer's screen: 

On the Meeting Controls Panel, select the down arrow (the last button on the panel) 

and then choose Make Screen Blank. 

A check mark next to the command indicates that the contents on the remote 

computer's screen are not visible. If no check mark appears, the contents on the 

remote computer's screen are visible. 
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Note:  

 If you make a remote computer's screen blank during a sharing session, the Access Anywhere 

Agent displays the contents on the screen once you end the session. 

 You can preset the remote computer screen to be blank after you connect to it. For details, 

refer to the Access Anywhere User's Guide. 

 

Sending a Ctrl+Alt+Del command to a shared remote 
computer 

Host or Presenter only 

While sharing a remote computer that is running Windows, you can send an 

Ctrl+Alt+Del command to the computer to access options that let you: 

 Log in to the computer 

 Log out from the computer 

 Lock the computer 

 Unlock the computer 

To send a Ctrl+Alt+Del command to a shared remote computer: 

On the Meeting Controls Panel, select the down arrow (the last button on the 

panel)and then choose Make Screen Blank. Send Ctrl+Alt+Del. 
 

Selecting an application on a shared remote computer 

Host or Presenter only 

If you have set up a remote computer to share only selected applications, rather than 

the entire desktop, you can only work with one application at a time. You can easily 

switch and share a different application. 

To choose a different application to share: 

On the Meeting Controls panel, select the down arrow. Then choose Share Remote 

Application. 

Select the application you want to share from the list of available application. 
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Controlling views of shared software 
  

Role 
 

Task description: 

Host or 

Presenter 

 

 Pause or resume sharing 

More 

 Control full-screen view of 

shared software More (on 

page 260) 

 Synchronize views More 

(on page 263) 
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Role 
 

Task description: 

Participant 

 

 Control your view of shared 

software More (on page 

265) 

 Close your sharing window 

More (on page 266) 

The presenter can control participant views of a shared desktop, remote computer 

(if available), application or Web browser. 

Participants can manipulate their individual displays of the shared software 
 

Pausing and resuming software sharing 

Host or Presenter only 

While sharing software, you can temporarily pause sharing to freeze attendees' views. 

If you want to return attendees to the Meeting window while sharing software, 

pausing shared software conserves resources on your computer and bandwidth for 

your Internet connection. This option is also useful if you do not want attendees to see 

certain actions that you take with shared software. 

You can resume sharing to restore attendees' views of shared software at any time. 

To pause software sharing: 

Select the Pause button, located to the right of the Stop button. 
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The word "Paused" now appears in the panel. A short message is displayed indicating 

that the participant view would be frozen until you resume sharing. Additionally, the 

Pause button text changes to Resume. 

  

 

To resume software sharing: 

Select the Resume button. 
 

Controlling full-screen view of shared software 

Host or Presenter only 

You can switch participant views of a shared application, remote computer (if 

available), or Web browser between a standard window and a full-screen view. 

A full-screen view of shared software fits participant entire screens and does not 

include a title bar or scroll bars. 

Participants can override your setting to control full-screen view or to zoom in or out 

on the shared software on their computers. 

To display shared software in a full-screen view: 

On the Meeting Controls Panel, select the down arrow (the last button on the 

panel)and then choose View. Then choose Full screen for Participants. 

  

 

To see panel controls, select the gray 

down-arrow button (it is the last 

button). 
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Synchronizing views of shared software 

Host or Presenter only 

While sharing an application, desktop (if desktop sharing is available), or Web 

browser, you can synchronize all participant views of the software with your view. 

Synchronizing views of shared software ensures that the sharing window appears as 

the active window on participant screens. For example, if a participant has minimized 

the sharing window, or moved another window on top of it, the sharing window 

becomes the active window when you synchronize views. 

 

Note: Synchronizing views has no effect on the size in which the shared software appears on 

participant screens. Participants can control the size of their views independently. 

To synchronize your view with participants: 

On the Meeting Controls Panel, select the down arrow (the last button on the panel) 

and then choose View. Then choose Synchronize for All. 

  

 

 

 

Selecting a monitor to share 

To select a monitor to share: 

1 Start sharing your desktop: 

 On the Quick Start page, select Share Desktop. 

If two or more monitors are detected on your system, a window appears and 

allows you to select one of the monitors.  



Chapter 15: Sharing Software 

 

264 

 

  

 

 

 On the Share menu, select Desktop. 

A submenu shows the available monitors. 

  

 

 

2 Select the monitor you want to share. 

The Meeting Controls Panel indicates which monitor you are sharing. If you are 

sharing the same monitor where the Meeting Controls Panel is, it says, "You are 

sharing this monitor." 

  

 

If you are sharing a monitor that is not the same monitor where the Meeting Controls 

Panel is, it says, "You are sharing monitor <number>." 

  

 

In addition, a green border appears around the monitor you are sharing. 
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To select a different monitor to share: 

1 On the Meeting Control Panel, select the Select Content to Share button. 

  

 

 

2 In the submenu that appears, select Share Desktop. 

A submenu shows you the available monitors. 

  

 

 

3 Select the monitor number you want to share. 

The Meeting Controls Panel indicates which monitor you are sharing. In addition, a 

green border appears around the monitor you are sharing. 
 

Controlling your view as a participant 

Participant only 

When viewing or remotely controlling shared software, you can set these options, 

which determine how shared software appears on your screen: 

 Display the shared software in a full-screen view or a standard window. A full-

screen view of a shared application or desktop fits your entire screen and does not 

include a title bar or scroll bars. 

 Scale, or resize, a shared desktop or application to fit the full-screen view or 

standard window in which it appears. 

To control your view of shared software: 

On the Meeting Controls Panel, select the down arrow (the last button on the 

panel)and then choose View. Then choose an option from the menu. 
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Tip: To switch quickly from the standard window to a full-screen view of shared software, 

double-click the shared software. 

 

 

Closing your participant sharing window 

Participant only 

While viewing or remotely controlling shared software, you can close the sharing 

window in which the software appears at any time. Closing a sharing window returns 

you to the Meeting window. If you close a sharing window, you can reopen it at any 

time. 

To close a sharing window: 

1 On the Meeting Controls Panel, select the down arrow (the last button on the 

panel)and then choose Stop <option> from the menu. The following graphic 

shows the Stop Application Sharing option because an application has been 

shared. If you have shared your desktop or Web Browser, the menu would show 

Stop Desktop Sharing. 
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2 Choose the appropriate option.  

The sharing window closes. The Meeting window then automatically opens. 

To return to the sharing window at any time: 

In the Meeting window, on the Sharing menu, select a sharing option (desktop, 

remote computer, application or Web browser). 
 

Switching your participant view 

Participant only 

While a presenter is sharing software, you can return to the Meeting window at any 

time. The sharing window remains open on your computer, so you can return to 

viewing the shared software at any time. 

To return to the Meeting window while the presenter is sharing software: 

On the Meeting Controls Panel, select the Return to Meeting Window icon. 

  

 

The Meeting window then appears. 

To return to a sharing window: 

In the Application Share dialog box, which appears in the Meeting window, select 

Return to Sharing.  
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Annotating shared software 
  

 
Task description: 

Host or Presenter 

 

 Start or stop annotation mode 

More (on page 269) 

 Use annotation tools More (on 

page 270) 

 Let a participant use annotation 

More 

 Save annotations More (on 

page 274) 

Participant 

 

 Ask for permission to use 

annotation More (on page 272) 

 Use annotation tools More (on 

page 270) 

 Save annotations More (on 

page 274) 

 Give up annotations More (on 

page 273) 

You can annotate a shared desktop, application or Web browser during a meeting, 

using the highlighter or other annotation tool. 

Meeting participants can see annotations in their sharing windows. 
 



 Chapter 15: Sharing Software 

 

269 

 

Starting and stopping annotation 

Host or Presenter only 

When you are sharing a desktop, application or Web browser, you can make 

annotations on the software. 

Participants can see all your annotations. 

To start annotating shared software: 

1 On the Meeting Controls panel, select the Annotate button. 

  

 

 

The Annotation button has the image of 

a pencil on it. 

The Tools panel appears. 

  

 

 

2 Select a tool for making annotations. 

For details about annotation tools, see Using annotation tools (on page 270). 

  

Note:  

 You can let one or more participants annotate the shared software. For details, see Letting a 

participant annotate shared software. 

 Once you or a participant makes annotations, you can save an image of the software, 

including the annotations. For details, see Taking a screen capture of annotations on shared 

software (on page 274). 

To stop making annotations on shared software and return your mouse to a normal 

pointer, you must stop annotation mode. 

To stop annotation mode: 

Select the Stop Annotating button in the Tools panel. 
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Using annotation tools 

If, while sharing software, you are the presenter or the presenter allows you to 

annotate, you can use the Annotation Tools panel that appears to make annotations. 

The Annotation Tools panel provides a variety of tools for annotating a shared 

desktop or application. 

  

 

  

Annotation 
Tool Icon Description 

Pointer 
 

Lets you point out text and graphics on shared content. The pointer 

displays an arrow with your name and annotation color. To display the 

laser pointer, which lets you point out text and graphics on shared 

content using a red “laser beam,” click the downward-pointing arrow. 

Clicking this button again turns off the pointer tool. 

Text 
 

Lets you type text on shared content. Participants can view the text 

once you finish typing it and click your mouse in the content viewer, 

outside the text box. 

To change the font, on the Edit menu, choose Font. Clicking this button 

again turns off the text tool. 

Line 
 

Lets you draw lines and arrows on shared content. For more options, 

click the downward-pointing arrow. Clicking this button closes the 

Rectangle tool. 

Rectangle 
 

Lets you draw shapes, such as rectangles and ellipses on shared 

content. For more options, click the downward-pointing arrow. Clicking 

this button again closes the Rectangle tool. 
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Annotation 
Tool Icon Description 

Highlighter 
 

Lets you highlight text and other elements in shared content. For more 

options, click the downward-pointing arrow. Clicking this button again 

closes the Highlighter tool 

Annotation 

Color  

Displays the Annotation Color palette, on which you can select a color 

to annotate shared content. Clicking this button again closes the 

Annotation Color palette. 

Eraser 
 

Erases text and annotations or clears pointers on shared content. To 

erase a single annotation, click it in the viewer. For more options, click 

the downward-pointing arrow. Clicking this button again turns off the 

eraser tool. 

  

 

Letting a participant annotate shared software 

Host or Presenter only 

You can let one or more meeting participants annotate a shared desktop (if available), 

application or Web browser. 

You can let several participants annotate shared software at the same time. 

To let a participant annotate shared software: 

1 On the Meeting Controls Panel, select the Annotate icon. 

  

 

 

 

The tools panel appears. 

  

 

 

2 Select the down arrow on the Allow to Annotate button. 
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3 On the menu that appears, choose which participants can annotate the shared 

software: 

You can choose "All" or select someone from the list. 

  

Note:  

 You can stop a participant from annotating shared software at any time. For details, see 

Stopping a participant from annotating shared software. (on page 273) 

 

Requesting annotation control of shared software 

Participant  only 

If a presenter is sharing a desktop, Web browser or application, you can ask the 

presenter to allow you to annotate the shared software. 

After you have permission, you can: 

 Make annotations by highlighting areas on the software, drawing lines and shapes, 

typing text, and using pointers. 

 Clear annotations at any time. 

 Change the color that you are using to make annotations. 

 Save an image of your annotations on the shared software. 

To request annotation control of shared software: 

1 In the Meeting Controls Panel, select the Annotate button. 

  

 

 

The Annotate button has the image 

of a pencil on it. 

A request message appears on the presenter's screen. 

After the presenter allows you to annotate, the Annotation Tools panel appears: 

  

 

 

2 Select the tool you want to use. 
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3 Optional. Choose another annotation tool. For details, see Using annotation tools 

(on page 270). 

  

Note: If you are controlling shared software remotely, the presenter must take back control to 

turn on annotation mode. You and the presenter can then annotate the shared software 

simultaneously. 

 

 

Giving up annotation control 

Participant  only 

If the presenter has granted permission to you to annotate, you can stop annotating at 

any time. 

To stop annotating: 

In the Annotation Tools panel, select the Stop Annotating button. 
 

Stopping an participant from annotating shared software 

Host or Presenter only 

If a participant  is annotating shared software, you can turn off the annotation feature. 

To turn off the drawing feature: 

1 On the Meeting Controls Panel, select the Assign Control button. 

  

 

 

2 On the menu that appears, choose Allow to Annotate. 

A check mark appears next to the names of those who can annotate the shared 

software. 

3 Choose the name of the participant to cancel the selection. 
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Taking a screen capture of annotations on shared software 

If you make annotations on shared software, you can save an image of the shared 

software, including all annotations and pointers, to a WebEx Universal 

Communications Format (.ucf) file. You can open a .ucf file on your computer 

desktop or in the content viewer in a meeting. 

  

Note: Participants cannot use this option unless the Host or Presenter grants the Screen Capture 

privilege to them. As Host, if you are sharing proprietary software, you may want to ensure that 

this privilege is turned off. 

To take a screen capture of annotations on shared software: 

1 On the Tools panel, select the Screen Capture button. 

  

 

 

The Save As dialog box appears. 

2 Choose a location at which to save the file, and then select Save. 

  

Note: The file you save is an image of your entire desktop. 

 

 

Granting participants control of shared software 
While sharing the following types of software, the presenter can let a participant 

control it remotely: 

 Application 

 Desktop (if available) 

 Web browser 
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A participant who has remote control of shared software can interact with it fully. 

While a participant is controlling shared software, the presenter's mouse pointer is 

inactive. 

Rules of thumb for controlling shared software: 

 Any participant can send a request to control the software remotely. More (on 

page 275) 

 The presenter can then grant control to the participant. More (on page 276) 

 Alternatively, the presenter can automatically grant control of shared software to 

any participant who requests remote control. More (on page 276) 

 The presenter can stop a participant from remotely controlling shared software at 

any time. More (on page 277) 

  

Caution: A participant who has remote control of the presenter's desktop can run any programs 

and access any files on the computer that the presenter has not protected with a password. 

 

 

Requesting remote control of shared software 

Participant only 

If the presenter is sharing an application, desktop, or Web browser, you can ask the 

presenter to grant remote control to you. 

Once you assume remote control of shared software, you can interact with it fully. 

To request remote control of shared software: 

On the Meeting Controls Panel select Ask to Control. 

  

 

 

A request message appears on the presenter's screen. 
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Tip: While remotely controlling shared software, you can request the presenter to allow you to 

annotate it. For details, see Requesting annotation control of shared software. (on page 272) 

 

Letting a participant remotely control shared software 

Host or Presenter only 

If you are sharing software, you can let a participant control it remotely. 

To let a participant remotely control shared software: 

1 On the Meeting Controls Panel select the down-arrow button on the Assign 

button. 

  

 

 

This button is the third button from the 

left on the Controls panel. 

2 On the menu that appears, choose Pass Keyboard and Mouse Control > [name of 

participant]. 
 

Automatically letting participants remotely control shared 
software 

Host or Presenter only 

While sharing software, you can automatically grant control of the software to a 

participant who requests control. In this case, a participant who requests remote 

control automatically takes control of the software that you are sharing. While 

automatic remote control is turned on, any participant can take control away from any 

other participant by requesting remote control. 

To automatically let participants control shared software: 

1 On the Meeting Controls Panel select the down-arrow button on the Assign 

button. 
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2 On the menu that appears, choose Pass Keyboard and Mouse Control > Auto 

Accept All Requests. 

To stop letting participants control shared software automatically: 

1 On the Meeting Controls Panel select the down-arrow button on the Assign 

button. 

2 On the menu that appears, choose Pass Keyboard and Mouse Control. Then 

select Auto Accept All Requests to remove the check mark and cancel the 

selection. 
 

Stopping remote control of shared software 

Host or Presenter only 

While a participant is remotely controlling a shared application, desktop, or Web 

browser, you can take back control of the shared software at any time. You can do 

either of the following: 

 Take back remote control of shared software temporarily, allowing a participant to 

take control at any time. 

 Prevent a participant from further controlling shared software. 

To take back control a shared software temporarily: 

On your computer's desktop, select your mouse. 

You can now control the shared software. 

The participant who was controlling the shared software can take back control at any 

time by clicking his or her mouse. 
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To prevent a participant from further controlling a shared software: 

1 On your computer's desktop, click your mouse. 

You can now control the shared software. 

On the Meeting Controls Panel select the down-arrow button on the Assign 

button. 

  

 

 

 

2 On the menu that appears, choose Pass Keyboard and Mouse Control. 

A menu appears, containing a list of all participants in the meeting. A check mark 

appears to the left of the participant who has remote control. 

3 Choose the participant's name to remove the check mark and cancel the selection. 
 

Sharing applications with detailed color 
(Windows) 

For Windows users only 

By default, Meeting Manager sends images of shared software using 16-bit color 

mode, which is the equivalent of your computer's “High Color” (16-bit) setting. This 

mode provides an accurate representation of color for most shared applications. 

However, if your shared application contains detailed color images-such as color 

gradients-the color may not appear accurately on participants' screens. For example, 

color gradients may appear and color “bands.” 

If the accuracy and resolution of color in a shared application is important, you can 

turn on True Color mode in Meeting Manager. Using this mode, however, may affect 

the performance of application sharing. 

When using True Color mode, you can select one of the following options: 

 Better imaging (no image compression) 
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 Better performance (some image compression) 

“Performance” refers to the “speed” at which images appear on participant screens, 

and “imaging” refers to the quality of the color in shared images.  

  

Note: Before turning on True Color mode, ensure that your monitor display is set to True Color 

(either 24- or 32-bit color). For more information about setting options for your monitor, refer to 

Windows Help. 

To turn on True Color mode: 

1 If you are currently sharing an application, stop your sharing session. 

2 On the Meeting menu, choose Meeting Options. 

The Meeting Options dialog box appears. 

3 Select the True Color Mode tab. 

4 Select Enable True Color mode. 

5 Select one of the following options: 

 Better imaging 

 Better performance 

6 Select OK or Apply. 
 

Sharing applications with detailed color (Mac) 
For Mac users only 

Before sharing an application or your desktop, you can choose one of the following 

display modes: 

 Better performance: The default mode. Lets you display your content faster than 

you do using the better image quality mode.  

 Better image quality: Lets you display your content with better image quality. In 

this mode, your shared content may take longer time to display than in the better 

performance mode.  

  

Note: Changing the display mode does not affect presentation or document sharing. 

To choose a display mode for your shared desktop or applications: 

1 In the Meeting window, on the Meeting Center menu, choose Preferences. 
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The Preferences dialog box appears. 

2 Select Display. 

  

 

 

The display mode options 

appear. 

3 Select Better performance or Better image quality, as appropriate. 
 

Tips for sharing software 
The following tips can help you to share software more effectively: 

 Application sharing only: To save time during a meeting, ensure that any 

applications you intend to share are open on your computer. At the appropriate 

time during the meeting, you can then quickly begin sharing an application, 

without waiting for the application to start. 

 If participants cannot see all of the shared software without scrolling their sharing 

windows, they can adjust their views of the shared software. They can reduce the 

size of the shared software in decrements, or scale it to fit inside their sharing 

windows. 

 To improve the performance of software sharing, close all applications that you 

do not need to use or share on your computer. Doing so conserves processor usage 

and memory on your computer, thus helping to ensure that Meeting Manager can 

send images of shared software quickly during a meeting. Also, to ensure that a 

maximum amount of bandwidth is available for software sharing, close any 

applications that use bandwidth, such as instant messaging or chat programs, and 

programs that receive streaming audio or video from the Web. 
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 If you are sharing an application for which the rendering of color on participants' 

screen is important, you can improve color quality by turning on True Color 

mode. For details, see Sharing applications with detailed color (on page 278). 

 Application and Web browser sharing only: Avoid covering a shared application 

or Web browser with another window on your computer's desktop. A 

crosshatched pattern appears in participant sharing windows where the other 

window is covering the shared application or browser. 

 Application and Web browser sharing only: If you want to switch your display 

between shared software and the Meeting window, you can pause software 

sharing before you return to the Meeting window, and then resume sharing once 

you return to the shared application. Pausing software sharing conserves processor 

usage and memory on your computer while you view the Meeting window. For 

details, see Pausing and resuming software sharing. (on page 261) 

 Application and Web browser sharing only: If you have more than one monitor, 

when you share an application or web browser, the participants can see it on 

whichever monitor you are displaying it. If you move the application or Web 

browser to another monitor, it is still visible to the participants. If you are sharing 

more than one application, the participants will see the best view if you make sure 

the applications are displaying on the same monitor. 

 Because software sharing requires additional bandwidth during a meeting, it is 

recommended that you use a dedicated, high-speed Internet connection when 

sharing software. However, if participants are using dial-up Internet connections, 

they may notice a delay in viewing or controlling shared software. If you want to 

share a document, such as a Microsoft Word or Excel document, you can improve 

the meeting experience for these participants by using document sharing instead 

of application sharing. 
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Chapter 16  

During a meeting, you can poll participants by presenting them with a questionnaire. 

Conducting a poll can be useful for gathering feedback from participants, allowing 

participants to vote on a proposal, testing participant knowledge of a topic, and so on. 
 

During the meeting, the presenter is responsible for: 

 Preparing a poll questionnaire More… (on page 283) 

 Conducting a poll during the meeting More… (on page 287) 

After closing a poll, the presenter can: 

 View poll results More…. (on page 288) 

 Share poll results with participants More… (on page 289) 

 Save poll results for viewing outside a meeting More… (on page 291) 
 

Preparing a poll questionnaire 
When preparing a poll questionnaire, you can: 

 Create a questionnaire More… (on page 283) 

 Edit a questionnaire More… (on page 285) 

 Set a timer for polling More… (on page 287) 
 

Creating a poll questionnaire 

Presenter only 

Polling Attendees 
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To conduct a poll, you must first create a poll questionnaire. You create a 

questionnaire in a meeting. To save time during a meeting, you can start the meeting 

earlier than the scheduled time, create a questionnaire on the Polling panel, save it, 

and then open it during the actual meeting. 
 

To create a questionnaire (for Windows): 
 

1 Open the Polling panel in a meeting. 

2 In the Question section, select one of these question types: 

 To create a multiple-answer question, select Multiple choice, and then select 

Multiple Answers in the drop-down list. 

 To create a single-answer question, select Multiple choice, and then select 

Single Answer in the drop-down list. 

 To create a text question, select Short answer. 

3 Click New. 

4 Type a question in the box that appears. 

5 In the Answer section, click Add. 

6 Type an answer in the box that appears. 

7 To type another answer, click Add once you finish typing an answer. 

The question and answers appear in the Poll Questions area. 

8 To add questions, repeat steps 2 to 7. 

This figure shows an example of a poll questionnaire. 

  

 



 Chapter 16: Polling Attendees 

 

285 

 

 
 

To create a questionnaire (for the Mac): 

1 Open the Polling panel in the meeting. 

2 Add a question by clicking this button and then typing the question. 

  

 

 

3 Add an answer by clicking this button and then typing the answer. 

  

 

 

4 To add more answers, repeat step 3. 

5 To add more questions, repeat step 2. 

6 To change the question type for a question, click the text "Click here to change 

question type" that appears under the specific question and then do one of the 

following: 

 To create a multiple-answer question, select Multiple Answers. 

 To create a single-answer question, select Single Answer. 

 To create a question that requires a text answer, select Short Answer. 

  

 

 

 
 

 

Editing a questionnaire 

You can change the type of a question and edit, rearrange, or delete the questions and 

answers. 
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To change the type of a question: 

1 Select the question by clicking it, and then select the new type of question in the 

Question section. 

For more information about the different types of questions, see Creating poll 

questionnaires (on page 283). 

2 Click Change Type. 

To edit any question or answer that you entered: 

1 Select the question or answer by clicking it, and then click the Edit icon. 

  

 

 

2 Make your changes. 

To delete a question or an answer: 

Select the question or answer by clicking it, and then click the Delete icon. 

  

 
Windows 

 
Mac 

To rearrange questions or answers: 

Select the question or answer by clicking it, and then click the Move Up or Move 

Down icon, as appropriate. 

  

 

To delete an entire questionnaire: 

Click Clear All. 

If you have not saved the questionnaire, a message box appears, asking whether you 

want to save it or not. 
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Displaying a timer during polling 

You can specify that a timer displays for participants and yourself when a poll is in 

progress. 

To display a timer: 

1 Open the Polling Options dialog box. 

 If you use Windows, click Options at the bottom of your Polling panel. 

 If you use the Mac, click this button on the lower-right portion of the Polling 

panel. 

  

 

 

2 In the dialog box that appears, select Display, and then type the length of time in 

the Alarm: box. 

3 Click OK. 
 

Opening a poll 
After you finish preparing a poll questionnaire, you can open the poll. 

If you prepared your questionnaire in advance and saved it, you must first display it 

on the Polling panel. For details, see Opening a poll questionnaire file (on page 291). 

To open a poll: 

1 Display your poll questionnaire on the Polling panel, if you have not done so. 

2 Click Open Poll. 

The questionnaire appears on participants' Polling panels. Participants can now 

answer the poll. 
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As participants answer the questions, you can watch the polling status on your 

Polling panel.  

  

 

 

Windows: 

To view each participant’s 

polling status, click one of 

these three buttons. 

 

 

 

Mac: 

To view each participant’s 

polling status, select the text 

"Click to see detailed status." 

3 Click Close Poll when the time is up. 

If you specify a timer and the poll times out, the poll automatically closes. 

Participants can no longer answer questions. 

Once you close a poll, you can view the poll results and optionally share them with 

participants. For details, see Viewing and sharing poll results (on page 288). 
 

Viewing and sharing poll results 
After closing a poll, you can: 

 View the complete results of the poll. More… (on page 288)  

 Share group results with participants. More… (on page 289) 

The poll results you can share during a meeting are anonymous. However, 

Meeting Center records responses from each participant, in addition to group 

results, and allows you to save those individual and group results. For more 

information, see Saving results of a poll (on page 291).  
 

Viewing poll results 

Meeting Center bases the percentage for each answer on the total number of 

participants in the meeting, not the total number of participants who submitted 

answers in the poll. 
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The Results column 

indicates the 

percentage of 

attendees who chose 

each answer. The Bar 

Graph column 

provides a graphic 

representation of each 

percentage in the 

Results column. 

 

 

Sharing poll results with participants 

After you close a poll, you can share the poll results with participants. 

The poll results you can share during a meeting are anonymous. However, Meeting 

Center records responses from each participant, in addition to group results, and 

allows you to save those individual and group results. For more information, see 

Saving results of a poll (on page 291).  
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To share the results of a poll: 

In the Share with attendees section on your Polling panel, select Poll results, and 

then click Apply. 

The results of the poll appear in the participants' Polling panels, just as they do on 

your Polling panel. 
 

Saving and opening poll questionnaires and 
results 

  

 
Task description 

 

If you have prepared a poll questionnaire, you can: 

 Save the questionnaire More… (on page 290) 

 Open the saved questionnaire for use in any meeting 

More… (on page 291) 

After you close a poll, you can: 

 Save group results to a .txt file More… (on page 291) 

 Save responses from individual participants to a .txt file 

More… (on page 291) 

 

Saving a poll questionnaire in a meeting 

After you create a poll questionnaire in a meeting, you can save it as a .atp file. You 

can open the file for use in any meeting. 

To save a poll questionnaire: 

1 On the File menu, choose Save > Poll Questions. 

The Save Poll Questions As dialog box appears. 

2 Choose a location at which to save the file. 

3 Type a name for the file. 
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4 Click Save. 

Meeting Manager saves the poll questionnaire to a file at the location you 

specified. Poll questionnaire file names have a .atp extension. 
 

Saving results of a poll 

After closing a poll, you can save the responses in one of these ways: 

 Text File group result—Saves the percentage of attendees who chose each 

answer in a .txt file  

 Text File individual attendees result—Saves the responses from each attendee, 

in addition to the group results, in a .txt file 

  

 

When you are saving poll results, 

you can select a format in which you 

want to save the results. 

To save results of a poll: 

1 Close the poll if you have not done so. 

2 On the File menu, choose Save > Poll Results. 

The Save Poll Results As dialog box appears. 

3 Select a location at which to save the file. 

4 In the "File name" drop-down list, enter a name for the file. 

5 In the "Save as type" drop-down list, select the format in which you want to save 

the results. 

6 Click Save. 

You can now view poll results by opening the file. 
 

Opening a poll questionnaire file 

If you saved a poll questionnaire to a file, you can display the questionnaire on your 

Polling panel by opening the file. 
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Note: You can open a poll questionnaire file only during a meeting. 

To open a poll questionnaire file: 

1 Use one of these methods to browse to the file: 

 On the File menu, choose Open Poll Questions. 

 Click the Open icon on your Polling panel. 

  

 
 

 
Windows 

 
  Mac 

The Open Poll Questions dialog box appears. 

2 Select the poll questionnaire file that you want to open. 

A poll questionnaire file has a .atp extension. 

3 Click Open. 

The poll questionnaire appears on your Polling panel. You can now open the poll 

to the participants. 
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Chapter 17  

During a meeting, you can publish files that reside on your computer. Meeting 

participants can then download the published files to their computers or local servers. 

Publishing files is useful if you want to provide participants with a document, a copy 

of your presentation, an application, and so on. 

Files that you publish reside only on your computer - not on a server. Thus, your 

published files are always protected from unauthorized access during a meeting. 

  

 

hosts can publish files 

More… (on page 294) 

 

participants can download 

published files More… (on 

page 295) 

 

Transferring and Downloading 
Files During a Meeting 
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Publishing files during a Meeting 
During a meeting, you can publish files that reside on your computer, and meeting 

attendees can download the files to their computers or local servers. 

To publish files during a meeting: 

1 In the Meeting window, on the File menu, choose Transfer. 

The File Transfer window appears. 

  

 

 

2 Click Share File. 

The Open dialog box appears. 

3 Select the file that you want to publish. 

4 Click Open. 

The file appears in the File Transfer window. 

The file is also now available in each attendee's File Transfer window. 

5 Optional. Publish additional files that you want attendees to download. 

  

 
Note: The number of attendees that have the File Transfer window open, including you, 

appears in the lower-right corner of the File Transfer window. 

 

To stop publishing files during a meeting: 

In the title bar of the File Transfer window, click the Close button. 

Meeting Manager closes the File Transfer window in each attendee's Meeting 

window. 
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Downloading Files During a Meeting 
If a presenter publishes files during a meeting, the File Transfer dialog box 

automatically appears in your Meeting window. You can then download the published 

files to your computer or a local server. 

To download files during a meeting: 

1 In the File Transfer window, select the file that you want to download. 

  

 

 

2 Click Download. 

The Save As dialog box appears. 

3 Choose a location at which to save the file. 

4 Click Save. 

The file downloads to your selected location. 

5 If applicable, download additional files. 

6 Once you finish downloading files, in the title bar of the File Transfer window, 

click the Close button. 

  

 
Note: To reopen the File Transfer window at any time, from the File menu, choose 

Transfer. This option is available only if the presenter is currently publishing files. 
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Chapter 18  

When scheduling a meeting, the host can specify the default note-taking options that 

take effect once the meeting starts. During a meeting, the presenter can change the 

default note-taking options at any time. 

You can choose how to handle meeting notes: 

 All participants with access can take private notes. More… (on page 301) 

 Only one participant takes notes or meeting minutes. More… (on page 299) 
 

 Only one participant takes notes for closed captions. More… (on page 302) 
 

  

Note: The notes feature is not available on the Mac. 

  

Role 
 

Task description: 

Host 

 

If the Notes panel is closed, click 

Manage Panels and then select 

Notes from the list and click 

Add. 

 set up options for taking 

notes in a meeting More… 

(on page 298) 

 choose one person to take 

notes More… (on page 299) 

 Select a participant as 

closed captionist More… (on 

page 299) 

Managing and Taking Notes 
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Role 
 

Task description: 

Note taker  

 

The host can select one person 

to take notes or allow all 

participants to take notes 

 get an overview of taking 

notes More… 

 take personal notes during a 

meeting More… (on page 

301) 

 saving notes to a file More… 

(on page 303) 

 Provide closed captions for 

a meeting More… (on page 

302) 

  
 

 

Specifying note-taking options for a meeting 
During a meeting, you can turn the notes option on or off and specify one of these 

options: 

 All participants with access to notes can take private notes. 

 Only one participant can take notes. 
 

 Only one participant takes notes for closed captions. More… (on page 302) 
 

To specify note-taking options for Windows: 

1 In the Meeting window, on the Meeting menu, choose Options. 

The Meeting Options dialog box appears, with the General tab selected by 

default. 

2 Select the note-taking option you want and click OK. 

 To turn the notes option on or off, check or uncheck the Notes check box. 

 To turn the closed captions option on or off, select or clear the Enable Closed 

Captioning check box. 

To specify note-taking options for the Mac: 

1 On the Meeting Center menu, select Preferences. 

2 Select Tools. 
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3 Select the note-taking option you want and click OK. 

 To turn the notes option on or off, check or uncheck the Notes check box. 

 To turn the closed captions option on or off, check or uncheck the Enable 

Closed Captioning check box. 
 

  

Note:  

 Once you change the notes option, any published notes or closed captions  are removed from 

each participant's Notes or Closed Caption panel. Be sure to ask participants to save notes or 

closed captions  before you change the notes option. 

 When scheduling a meeting, the meeting host can specify the default note-taking options, 

which take effect once the meeting starts. 
 

 

Choosing a note taker 
If the single note taker or closed captions  option is set for a meeting, you can 

designate any participant or closed captionist to be the note taker. When scheduling a 

meeting, you can set the notes option, or a presenter can set the notes option during a 

meeting. 

To designate a note taker for Windows: 

1 On the Participants panel, select the participant you want to designate as note 

taker. 

2 Right-click and then select Change Role To > Note Taker. 

A pencil indicator appears to the right of the participant's name in the participant 

list. 

To designate a note taker for the Mac: 

1 On the Participants panel, select the participant you want to designate as note 

taker. 

2 Select ctrl and then click; then select Change Role To > Note Taker. 

A pencil indicator appears to the right of the participant's name in the participant 

list. 

  

Note:  

 If you select another note taker or closed captionist, any notes or closed captions  that the 

previous note taker or closed captionist published remain on each participant's Notes or 

Closed Caption panel. However, the new note taker or closed captionist cannot edit the 
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existing notes or closed captions . 

 For information about selecting a note-taking option during a meeting, see Specifying note-

taking options for a meeting (on page 298). 
 

To designate a closed captionist: 

1 In the meeting window, in the participant list, select the participant you want to 

designate as a closed captionist. 

2 On the Participants panel, do one of the following: 

 Windows: Right-click and select Change Role To > Closed Captionist. 

 Mac: Select ctrl and then click. Then select Change Role To > Closed 

Captionist. 

  

 

A closed caption indicator appears 

next to the participant's name in the 

participant list. 

 
 

 

Enabling closed captions 
You can easily select the option for closed captions and appoint a participant to 

transcribe the closed captions. 

To specify the closed caption option: 

1 Depending on the operating system you are using, do one of the following: 

 Windows: In the Meeting window, on the Meeting menu, choose Options. 

The Meeting Options dialog box appears, with the General tab selected by 

default. 

 Mac: On the Meeting Center menu, select Preferences. Select Tools. 

2 To turn the closed captioning option on or off, check or uncheck the Enable 

Closed Captioning check box. 
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To learn how to display the Closed Captions panel, see Managing panels (on page 

25). 

To select another participant to transcribe, select the participant's name on the 

Participants panel; then right-click (Windows) or select ctrl and then click (Mac) and 

then select Change Role To >Closed Captionist. 
 

About taking notes 
During a meeting, one or more meeting participants with access to the notes feature 

can take notes on the Notes or Closed Caption panel in the Meeting window. Only 

one participant performs closed captioning. 

If all participants are allowed to take notes, they cannot publish their notes to others 

during the meeting. However, participants can save their notes at any time during the 

meeting. 

The meeting host can select the single note taker during the meeting. A single note 

taker can publish notes at any time during the meeting or send a meeting transcript 

containing the notes to all participants. 

If needed, the host can also select a closed captionist. A closed captionist can publish 

captions in real-time during the meeting and can also send a transcript containing the 

captions to all participants. 
 

 

Taking personal notes 
If the meeting host or presenter has selected the option to allow participants to take 

personal notes, you can type your notes on the Notes panel in the Meeting window. 

To take personal notes: 

1 In the Meeting window, open the Notes panel. 

2 Type your notes in the box. 

  

Note: You can save your notes to a text file on your computer. For details, see Saving notes to a 

file (on page 303). 
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Taking public notes (meeting minutes) 
If the meeting host has designated you as the single note taker for a meeting, you can 

type notes on the Notes panel in your Meeting window. Your notes are not visible to 

other meeting participants until you publish them. You can publish your notes at any 

time during the meeting, or you can send your notes in a meeting transcript to all 

participants. 

To take public notes: 

1 In the Meeting window,open the Notes panel. 

2 Type your notes in the box. 

3 Optional. To publish your notes, so they appear in each participant's Notes panel, 

click Publish. 

  

Note: If the Notes panel is not selected on a participant's Meeting window once you publish 

notes, the participant is sees an alert. 

 

For information about selecting a note-taking option during a meeting, see Specifying note-taking 

options for a meeting (on page 298). 

 

For details about sending public notes in a meeting transcript, see Sending a meeting transcript to 

participants (on page 304). 

 

 

Providing closed captions 
If the meeting host has designated you as the closed captionist for a meeting, you can 

type captions on the Closed Captions panel in your Meeting window. To type 

captions, you can use either a standard keyboard, or a steno keyboard and machine 

translation software. 

Your captions are visible to other meeting participants in real-time, one line at a time. 

You can also send your captions in a meeting transcript to all participants. 

To transcribe closed captions: 

1 Open the Closed Caption panel. 

2 Type your captions in the box. 
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3 Once you type a line of captions, do either to publish your captions on each 

participant's Closed Caption panel: 

 Press the Enter key on your computer's keyboard. 

 Click Publish on the Closed Caption panel. 

  

Note:  

 If the Closed Captions panel is not selected on a participant's Meeting window once you 

publish a line of captions, the participant is alerted that captions are available. 

 You can save your captions to a text file on your computer. For details, see Saving notes to a 

file (on page 303). 

 For details about sending closed captions in a meeting transcript, see Sending a meeting 

transcript to participants. 

 

Saving notes to a file 
If you are taking personal or public notes (meeting minutes) or closed captions  during 

a meeting you can save your notes or closed captions  to a text file on your computer. 

You can also save any notes or closed captions  that another note taker or closed 

captionist publishes on your Notes or Closed Caption panel. 

Once you save new notes to a file, you can save changes to the notes or save a copy of 

the notes to another file. 

To save new notes: 

1 In the Meeting window, do either: 

 On the Notes or Closed Caption panel, click Save. 

 On the File menu, point to Save, and then choose Notes. 

The Save Notes As dialog box appears. 

2 Choose a location at which to save the file. 

3 Type a name for the file. 

4 Click Save. 

Meeting Manager saves the file at the location you chose. Its file name has a .txt 

extension. 

To save changes to notes: 

In the Meeting window, do either: 
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 On the Notes or Closed Caption panel, click Save. 

 On the File menu, point to Save, and then choose Notes. 

Meeting Manager saves the file at the location you chose. Its file name has a .txt 

extension. 

To save a copy of notes to another file: 

1 In the Meeting window, on the File menu, point to Save As, and then choose 

Notes. 

The Save Notes As dialog box appears. 

2 Do either or both: 

 Type a new name for the file. 

 Choose a new location at which to save the file. 

3 Click Save. 

Meeting Manager saves the file at the location you chose. The file name is saved with 

a .txt extension. 
 

  

Tip:  

Alternatively, you can save all of the following meeting information to files at once: 

 Shared presentations or documents 

 Chat messages 

 Notes 

 Poll questionnaire 

 Poll results 

To save all information at once, on the File menu, choose Save All. In this case, the files are 

saved under their default file names. Thus, if you have already saved a file using another name, it 

is not overwritten. 

 
 

 

Sending a meeting transcript to participants 
You can send a transcript of a meeting to all participants at any time during the 

meeting. The transcript is an email message that contains general information, such 

as: 

 Meeting topic 
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 Meeting number 

 Meeting starting and ending times 

 URL for the Meeting Information page for the meeting on your meeting service 

Web site 

 List of participants who joined the meeting (audio-only participants are not listed) 

 Meeting agenda 

 Any public notes that you took during the meeting 

Optionally, you can attach any of these files to the transcript, if you saved them 

during the meeting: 

 Shared documents 

 Chat 

 Public notes that you took or that the note taker published during the meeting 

 Poll questionnaire 

 Poll results 

To send a meeting transcript to participants: 

1 In the Meeting window, on the File menu, choose Send Transcript. 

If you have saved any files during the meeting, the Send Transcript dialog box 

appears, allowing you to attach the files to the transcript email message. 

If you have not saved any files during the meeting, a transcript email message 

opens. 

2 If the Send Transcript dialog box appears, select the check box for each file that 

you want to attach to the transcript, and then click OK. 

The transcript email message opens. 

3 Review the email message and make any changes that you want. 

4 Send the email message. 

  

Note:  

 The transcript is sent to all participants who provided their email addresses when joining the 

meeting, whether or not they are still attending the meeting when you send the transcript. 

Audio-only participants will not be listed in the transcript. 

 For security purposes, a participant who receives a transcript email message cannot see the 

email addresses for the other participants. 

 The transcript contains notes only if you are the meeting host, the public note taker, or the 
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closed captionist, and you have saved the notes to a file. If all participants can take private 

notes, the transcript email message does not include your private notes, and the option to 

attach your notes in a file is not available. 

 If you saved notes or closed captions  to a file, the transcript email message and the attached 

notes file contain the latest version of notes that you saved. 

 If you are the meeting host and end the meeting-and you have not sent a transcript-a message 

appears, asking you if you want to send a transcript. 
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Chapter 19  

  

If you want to… See… 

get an overview of My WebEx About My WebEx (on page 308) 

set up a user account on your WebEx service 

Web site 

Obtaining a user account (on page 309) 

log in to or out from My WebEx Logging in to and out of the WebEx service 

site (on page 310) 

use your list of meetings Using your list of meetings (on page 311) 

install WebEx Productivity Tools, which let 

you start One-Click meetings, start instant 

meetings from applications on your desktop, 

or schedule meetings from Microsoft Outlook 

or IBM Lotus Notes 

Installing WebEx Productivity Tools (on page 

199) 

set up a One-Click Meeting Setting Up a One-Click Meeting (on page 

195) 

view or set options for your Personal Meeting 

Room page 

Maintaining Your Personal Meeting Room 

Page (on page 322) 

set up or access remote computers, using 

Access Anywhere 

Using Access Anywhere (My Computers) (on 

page 326) 

add, edit, or delete files in your personal 

storage space for files 

Maintaining files in your personal folders (on 

page 327) 

add, edit, or delete information about your 

contacts in your online address book 

Maintaining contact information (on page 

349) 

change information or settings in your user 

profile, including personal information and 

preferences 

Maintaining your user profile (on page 364) 

Using My WebEx 
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If you want to… See… 

manage the scheduling templates you saved Managing scheduling templates (on page 

372) 

 

set up your Personal Conference number 

(PCN) accounts, which you can use for the 

audio portion of Personal Conference 

meetings 

Maintaining Personal Conference numbers 

(on page 374) 

generate reports about online sessions Generating Reports (on page 383) 

 

 

About My WebEx 
My WebEx is an area on your WebEx service Web site in which you can access your 

user account and personal productivity features. The following features are available, 

depending on the configuration of your site and user account: 

 Personal list of meetings: Provides a list of all the online meetings that you are 

hosting and attending. You can view the meetings by day, week, or month, or you 

can view all meetings. 

 Productivity Tools Setup: Optional feature. Lets you set up options for instant or 

scheduled meetings that you can start from applications on your desktop. If you 

install WebEx Productivity Tools, you can start or join meetings, sales meetings, 

training sessions, and support sessions instantly from One-Click or from other 

applications on your desktop, such as Microsoft Office, Web browsers, Microsoft 

Outlook, IBM Lotus Notes, and instant messengers. You can also schedule 

meetings, sales meetings, events, and training sessions using Microsoft Outlook or 

IBM Lotus Notes without going to your WebEx service site. 

 Personal Meeting Room: Optional feature. A page on your WebEx service Web 

site on which visitors can view a list of meetings that you are hosting and join a 

meeting in progress. Visitors can also access and download files that you share.  

 Access Anywhere: Optional feature. Lets you access and control a remote 

computer from anywhere in the world. For more information about Access 

Anywhere, refer to the guide Getting Started with Access Anywhere, which is 

available on your WebEx service Web site. 

 File storage: Lets you store files in personal folders on your WebEx service Web 

site, where you can access them on any computer that has access to the Internet. 
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Also lets you make specific files available on your Personal Meeting Room page, 

so visitors to your page can access them. 
 

MC_About My WebEx2 

 Address book: Lets you keep information about your personal contacts on your 

WebEx service Web site. Using your address book, you can quickly access 

contacts when inviting them to a meeting. 

 User profile: Lets you maintain your account information, such as your 

username, password, and contact information. Also lets you specify another user 

who can schedule meetings on your behalf, set options for your Personal Meeting 

Room page, and manage scheduling templates. 

 Personal Conference numbers: Optional feature. Lets you create Personal 

Conference number (PCN) accounts, which you can use to set up the audio 

portion of your Personal Conference meetings.  

 Web site preferences: Lets you specify the home page for your WebEx service 

Web site—that is, the page that appears first whenever you access your site. If 

your site provides multiple languages, you can also choose a language and locale 

in which to display text on your site. 

 Usage reports: Optional feature. Lets you obtain information about meetings that 

you hosted. If you use the Access Anywhere option, you can also obtain 

information about computers that you access remotely. 
 

Obtaining a user account 
Once you obtain a user account, you can use My WebEx features and host s on the 

Web. 

You can obtain a user account in one of two ways: 

 The site administrator for your WebEx service Web site can create a user account 

for you. In this case, you need not sign up for an account on your site, and you can 

begin hosting s immediately. 

 If your site administrator has made the self-registration feature available, you can 

sign up for an account on your WebEx service Web site at any time. 

To obtain a user account using the self-registration feature: 

1 Go to your WebEx service Web site. 
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2 On the navigation bar, click Set Up > New Account. 

The Sign Up page appears. 

3 Provide the required information. 

4 Click Sign Up Now. 

You receive an email message, confirming that you have signed up for a user 

account. 

Once your site administrator approves your new user account, you receive another 

email message containing your username and password. 

  

Note: Once you obtain a user account, you can edit your user profile to change your password 

and provide additional personal information. You can also specify site preferences, such as your 

default home page and time zone. For details, see Maintaining your user profile (on page 364). 

 

Logging in to and out of the WebEx service site 
To manage your online meetings and maintain your user account, you must log in to 

your WebEx service Web site. If you do not yet have a user account, see Obtaining a 

user account (on page 309). 

To log in to your WebEx service site: 

1 Go to your WebEx service Web site. 

2 In the upper-right corner of the page, click Log In. 

The Log In page appears. 

3 Enter your username and password. 

Passwords are case-sensitive, so you must type your password exactly as you 

specified it in your user profile. 

4 Click Log In. 

  

Tip: If you have forgotten your username or password, click Forgot your password. Provide 

your email address, type verification characters, and then click Submit. You will receive an email 

message containing your username and password. 

To log out from your WebEx service site: 

In the upper-right corner of the page, click Log Out. 
 



 Chapter 19: Using My WebEx 

 

311 

 

Using your list of meetings 
  

If you want to… See… 

get an overview of your list of meetings About your list of meetings (on page 311) 

open your list of meetings Opening your meetings list (on page 311) 

maintain your list of meetings Maintaining your scheduled meetings list (on 

page 313) 

 

About your list of meetings 

On your WebEx service Web site, your My Meetings page in My WebEx includes: 
 

 A list of all the online meetings that you have scheduled, including both listed and 

unlisted meetings. 

 A list of meetings on your site to which you are invited. 
 

 An option to start a One-Click meeting (not available for Event Center). 

 Any Personal Conference meetings that you scheduled (if your site and account 

have the Personal Conferencing feature turned on). 

  

Tip: You can specify that your My WebEx meetings page is the home page that appears once you 

log in to your WebEx service Web site. For details, see Maintaining your user profile (on page 

364). 

 

Opening your meetings list 

You can open your personal list of scheduled meetings on your WebEx service Web 

site to: 

 Start a meeting 

 Modify a meeting 

 Cancel a meeting 

You can open your personal list of meetings to which you are invited: 

 Obtain information about a meeting 
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 Join a meeting in progress 

To open your meetings list: 

1 Log in to your WebEx service Web site, and then click My WebEx. 

The My Meetings page appears, showing your list of scheduled meetings. 

  

 

 

2 Click one of the tabs to navigate to different views of the My Meetings page: 

You can choose Daily, Weekly, Monthly, or All Meetings. 

3 Optional. Do either of the following: 

 To view the list of meetings to which you are invited, select The meetings 

you are invited to from the list. 

 To include s in the view that have already occurred, turn on Show past 

meetings. 

4 (Optional) Select options to control the view: 

 To view the list of meetings to which you are invited, select The meetings 

you are invited to from the list. 

 To include meetings in the view that have already occurred, turn on Show 

past meetings. 

  

Tip: You can specify that your My WebEx Meetings page is the home page that appears once you 

log in to your WebEx service Web site. For details, see Maintaining your user profile (on page 

364). 
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Maintaining your scheduled meetings list 

Once you schedule a meeting, it appears in your meetings list on your My Meetings 

page. For more information, see Opening your meetings list (on page 311). 

An online meeting remains on your My Meetings page until you delete it. When 

scheduling a meeting, you can choose to automatically delete the meeting from your 

list of meetings once both of these conditions occur: 

 You start and end the meeting. 

 The scheduled time for the meeting has passed. 

However, if you required registration for a scheduled meeting, the meeting remains in 

your list until you remove it. That way, you can still view information about attendees 

who registered for the meeting at any time after you host the meeting. 

To remove a meeting from your list of meetings on your My Meetings page, you must 

cancel the meeting by deleting it on this page. 

For details about the options on the My WebEx Meetings page, see About the My 

WebEx Meetings page (on page 313). 
 

 

About the My WebEx Meetings page 

How to access this tab 

On your WebEx service Web site, click the My WebEx tab. 

What you can do here 

Access these features: 

 A link to your personal meeting room 

 A list of meetings you are hosting or are invited to for the specified day, week, or 

month 

 A list of all meetings you are hosting or are invited to 
 

 A link to start a One-Click meeting 
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Options on this page 

  

Use this option… To… 

Go To My Personal 

Meeting Room 

Go to your Personal Meeting Room page. 

Your Personal Meeting Room page lists any meetings that you 

scheduled and any in-progress meetings that you are currently 

hosting. 

Users to whom you provide your personal URL can use this 

page to join any meeting that you are hosting. They can also 

download files in any folders that you share. 

Start a One-Click 

Meeting 

Start a One-Click Meeting based on settings you have specified 

in One-Click Setup. For details, see Setting Up a One-Click 

Meeting (on page 195). 

Daily View a list all of the meetings for the specified day. For details, 

see About the My WebEx Meetings - Daily tab (on page 314). 

Weekly View a list all of the meetings for the specified week. For details, 

see About the My WebEx Meetings - Weekly tab (on page 316). 

Monthly View a list all of the meetings for the specified month. For 

details, see About the My WebEx Meetings - Monthly tab (on 

page 319) 

All Meetings View a list all meetings, or search for meetings by date, host, 

topic, or words in the agenda. For details, see About the My 

WebEx Meetings - All Meetings tab (on page 320) 

Refresh 

 

Refresh the information in the meeting list. 

 

About the My WebEx Meetings page - Daily tab 

How to access this tab 

On your WebEx service Web site, click My WebEx > My Meetings > Daily tab. 
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Options on this tab 

  

Option Description 

 
Click the Refresh icon at any time to display the most current 

list of meetings. 

Language link 

Click to open the Preferences page, where you can select the 

language setting for your WebEx service Web site. 

Time zone link 
Click to open the Preferences page, where you can select the 

time zone setting for your WebEx service Web site. 

Date 
The date for the daily list of meetings. The default is the 

current date. 

 
Click the Previous Day icon to display a list of meetings for 

the previous day. 

 
Click the Next Day icon to display a list of meetings for the 

next day. 

The meetings you host 
Shows a list all of the online meetings or Personal Conference 

meetings that you are hosting. 

The meetings you are 

invited to 

Shows a list all of the meetings or Personal Conference 

meetings to which you have been invited. 

Show past meetings Select to include concluded meetings in the list of meetings. 

 

The Ascending Sort indicator appears next to a column 

heading, and the meetings are sorted by the column, in 

ascending order. 

 

The Descending Sort indicator appears next to a column 

heading, and the meetings are sorted by the column, in 

descending order. 

Time 

The starting time for each scheduled meeting. Click the box 

next to a meeting start time to select that meeting. Click the 

box next to the Time column heading to select or clear all 

meetings in the list. 

Topic 

The topic for a meeting that you are hosting. Click the topic 

name to get information about that meeting. If you are the 

alternate host for a Meeting, the topic appears in italics. 

Type 

Indicates the type of online meeting that you are hosting. 

Available meeting types depend on the configuration of your 

WebEx service Web site. 
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Option Description 

Assist 

If an Assist has been requested for this meeting, indicates the 

type of Assist: 

 None 

 Dry Run 

 Consult 

 Live Event Support 

 Audio Streaming 

 Video 

 
Indicates that the live meeting is in process. 

Status The status of the meeting. 

 Start: You can start this meeting that you are hosting at 

any time by clicking the link. 

 Join | End: (for hosts) For a meeting in progress that you 

are hosting, you can join or end the meeting. Appears if 

you left a meeting, or you allowed participants to join the 

meeting before its starting time and participants have 

already joined the meeting. 

 Join: Lets you join the meeting in progress. 

 End: Ends the meeting. 

 Join: (for attendees) The meeting that you are invited to 

has started, and you can now join the meeting. 

 Registration: (for attendees) The meeting that you are 

invited to requires registration. To display a page on which 

you can register to attend the meeting, click the link. 

(Does not apply to sales meetings or support sessions.) 

Delete Cancels any meetingsthat are currently selected in the list. If 

you click this link, a message appears, allowing you to confirm 

that you want to cancel the meeting. Another message 

appears, allowing you to inform any invited attendees that you 

canceled the meeting. (Does not apply to support sessions.) 

 

About the My WebEx Meetings page - Weekly tab 

How to access this tab 

On your WebEx service Web site, click My WebEx > My Meetings > Weekly tab. 



 Chapter 19: Using My WebEx 

 

317 

 

Options on this tab 

  

Option Description 

 
Click the Refresh icon at any time to display the most current 

list of meetings. 

Language link 

Click to open the Preferences page, where you can select the 

language setting for your WebEx service Web site. 

Time zone link 
Click to open the Preferences page, where you can select the 

time zone setting for your WebEx service Web site. 

Week link The beginning and ending date for the weekly list of meetings. 

 
Click the Previous Week icon to display a list of meetings for 

the previous week. 

 
Click the Next Week icon to display a list of meetings for the 

next week. 

 

Click the Calendar icon to open the Calendar window for the 

current month. Click on any date to open its schedule in the 

Daily view. 

The meetings you host 
Shows a list all of the online meetings or Personal Conference 

meetings that you are hosting. 

The meetings you are 

invited to 

Shows a list all of the meetings or Personal Conference 

meetings to which you have been invited. 

Show past meetings Select to include concluded meetings in the list of meetings. 

Day link 

 

Opens the Daily view, which shows the scheduled meetings for 

the selected day. 

 

The Ascending Sort indicator appears next to a column 

heading, and the meetings are sorted by the column, in 

ascending order. 

 

The Descending Sort indicator appears next to a column 

heading, and the meetings are sorted by the column, in 

descending order. 

 
The Expand button appears next to a Day link. Click this 

button to expand and display the list of meetings for that day. 

 
The Collapse button appears next to a Day link. Click this 

button to collapse and hide the list of meetings for that day. 
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Option Description 

Time 

The starting time for each scheduled meeting. Click the box 

next to a meeting start time to select that meeting. Click the 

box next to the Time column heading to select or clear all 

meetings in the list. 

Topic 

The topic for a meeting that you are hosting. Click the topic 

name to get information about that meeting. If you are the 

alternate host for a Meeting, the topic appears in italics. 

Type 

Indicates the type of online meeting that you are hosting. 

Available meeting types depend on the configuration of your 

WebEx service Web site. 

Assist 

If an Assist has been requested for this meeting, indicates the 

type of Assist: 

 None 

 Dry Run 

 Consult 

 Live Event Support 

 Audio Streaming 

 Video 

 
Indicates that the live meeting is in process. 

Status The status of the meeting. 

 Start: You can start this meeting that you are hosting at 

any time by clicking the link. 

 Join | End: (for hosts) For a meeting in progress that you 

are hosting, you can join or end the meeting. Appears if 

you left a meeting, or you allowed participants to join the 

meeting before its starting time and participants have 

already joined the meeting. 

 Join: Lets you join the meeting in progress. 

 End: Ends the meeting. 

 Join: (for attendees) The meeting that you are invited to 

has started, and you can now join the meeting. 

 Registration: (for attendees) The meeting that you are 

invited to requires registration. To display a page on which 

you can register to attend the meeting, click the link. 

(Does not apply to sales meetings or support sessions.) 

Delete Cancels any meetingsthat are currently selected in the list. If 

you click this link, a message appears, allowing you to confirm 

that you want to cancel the meeting. Another message 

appears, allowing you to inform any invited attendees that you 
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Option Description 

canceled the meeting. (Does not apply to support sessions.) 

 

About the My WebEx Meetings page - Monthly tab 

How to access this tab 

On your WebEx service Web site, click My WebEx > My Meetings > Monthly tab. 

Options on this tab 

  

Option Description 

 
Click the Refresh icon at any time to display the most current 

list of meetings. 

Language link 

Click to open the Preferences page, where you can select the 

language setting for your WebEx service Web site. 

Time zone link 
Click to open the Preferences page, where you can select the 

time zone setting for your WebEx service Web site. 

Month 
The month for the monthly calendar of meetings. The default is 

the current month. 

 
Click the Previous Month icon to display a list of meetings for 

the previous month. 

 
Click the Next Month icon to display a list of meetings for the 

next month. 

 

Click the Calendar icon to open the Calendar window for the 

current month. Click on any date to open its schedule in the 

Daily view. 

Week Number link 

 

Opens the Weekly view, which shows the scheduled meetings 

for each day of the selected week. 

Day link 

 

Opens the Daily view, which shows the scheduled meetings 

for the selected day. 
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Option Description 

The meetings you host 
Shows a list all of the online meetings or Personal Conference 

meetings that you are hosting. 

The meetings you are 

invited to 

Shows a list all of the meetings or Personal Conference 

meetings to which you have been invited. 

Show past meetings Select to include concluded meetings in the list of meetings. 

Topic 

The topic for a meeting that you are hosting. Click the topic 

name to get information about that meeting. If you are the 

alternate host for a Meeting, the topic appears in italics. 

 
Indicates that the live meeting is in process. 

 

About the My WebEx Meetings page - All Meetings tab 

How to access this tab 

On your WebEx service Web site, click My WebEx > My Meetings > All Meetings 

tab. 

Options on this tab 

  

Option Description 

 
Click the Refresh icon at any time to display the most current 

list of meetings. 

Language link 

Click to open the Preferences page, where you can select the 

language setting for your WebEx service Web site. 

Time zone link 
Click to open the Preferences page, where you can select the 

time zone setting for your WebEx service Web site. 

Date 
The date for the daily list of meetings. The default is the 

current date. 

 
Click the Previous Day icon to display a list of meetings for 

the previous day. 

 
Click the Next Day icon to display a list of meetings for the 

next day. 
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Option Description 

Search for meetings by 

date, host, topic, or words 

in the agenda 

Allows you type or select a date range to search for meetings, 

or allows you to type text to search in host names, topics, or 

agendas. Click Search to start the search. 

 
Click the Calendar icon to open the Calendar window. Click on 

any date to select that date as part of your search criteria. 

The meetings you host 
Shows a list all of the online meetings or Personal Conference 

meetings that you are hosting. 

The meetings you are 

invited to 

Shows a list all of the meetings or Personal Conference 

meetings to which you have been invited. 

Show past meetings Select to include concluded meetings in the list of meetings. 

 

The Ascending Sort indicator appears next to a column 

heading, and the meetings are sorted by the column, in 

ascending order. 

 

The Descending Sort indicator appears next to a column 

heading, and the meetings are sorted by the column, in 

descending order. 

Time 

The starting time for each scheduled meeting. Click the box 

next to a meeting start time to select that meeting. Click the 

box next to the Time column heading to select or clear all 

meetings in the list. 

Topic 

The topic for a meeting that you are hosting. Click the topic 

name to get information about that meeting. If you are the 

alternate host for a Meeting, the topic appears in italics. 

Type 

Indicates the type of online meeting that you are hosting. 

Available meeting types depend on the configuration of your 

WebEx service Web site. 

Assist 

If an Assist has been requested for this meeting, indicates the 

type of Assist: 

 None 

 Dry Run 

 Consult 

 Live Event Support 

 Audio Streaming 

 Video 

 
Indicates that the live meeting is in process. 
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Option Description 

Status The status of the meeting. 

 Start: You can start this meeting that you are hosting at 

any time by clicking the link. 

 Join | End: (for hosts) For a meeting in progress that you 

are hosting, you can join or end the meeting. Appears if 

you left a meeting, or you allowed participants to join the 

meeting before its starting time and participants have 

already joined the meeting. 

 Join: Lets you join the meeting in progress. 

 End: Ends the meeting. 

 Join: (for attendees) The meeting that you are invited to 

has started, and you can now join the meeting. 

 Registration: (for attendees) The meeting that you are 

invited to requires registration. To display a page on which 

you can register to attend the meeting, click the link. 

(Does not apply to sales meetings or support sessions.) 

Delete Cancels any meetingsthat are currently selected in the list. If 

you click this link, a message appears, allowing you to confirm 

that you want to cancel the meeting. Another message 

appears, allowing you to inform any invited attendees that you 

canceled the meeting. (Does not apply to support sessions.) 

 

Maintaining Your Personal Meeting Room Page 
  

If you want to… See… 

get an overview of your Personal Meeting 

Room page 

About your Personal Meeting Room (on page 

323) 

access your Personal Meeting Room page Viewing your Personal Meeting Room (on 

page 323) 

add images and text to your Personal 

Meeting Room page 

Setting options for your Personal Meeting 

Room (on page 324) 

share files on your Personal Meeting Room 

page 

Sharing files on your Personal Meeting Room 

(on page 325) 
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About your Personal Meeting Room page 

Your user account includes a Personal Meeting Room page on your WebEx service 

Web site. Users who visit your page can: 

 View a list of online meetings that you are hosting, either scheduled or in 

progress. 

 Join a meeting in progress. 

 View your personal folders and upload or download files to or from your folders, 

depending on the settings you specify for your folders. 

You can customize your Personal Meeting Room page by adding images and text to 

it. 

To provide users with access to your Personal Meeting Room page, you must provide 

them with your Personal Meeting Room URL. For more information, see Viewing 

your Personal Meeting Room page (on page 323). 

  

Tip: Add your Personal Meeting Room URL to your business cards, your email signature, and so 

on. 

 

 

Viewing your Personal Meeting Room page 

You can view your Personal Meeting Room page at any time, by going to the link for 

the page. The link for your Personal Meeting Room page is available on your: 

 My WebEx Meetings page 

 My WebEx Profile page 

To view your Personal Meeting Room page: 

1 Log in to your WebEx service Web site, and then click My WebEx. 

The My WebEx Meetings page appears. 

2 Click the Go to My Personal Meeting Room link. 

Alternatively, in My WebEx, click My Profile, and then click the Personal 

Meeting Room URL link in the Personal Meeting Room section. 

Your Personal Meeting Room page appears. The following is an example of a 

Personal Meeting Room page. 
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Tip: Add your Personal Meeting Room URL to your business cards, your email signature, and so 

on. 

  

 

Setting options for your Personal Meeting Room page 

You can add the following to your Personal Meeting Room page: 

 An image (for example, you can add a picture of yourself or your company's 

product). 

 A custom banner image to the header area of your Personal Meeting Room page, 

if your user account has the “branding” option. For example, you can add your 

company's logo. 

 A welcome message. For example, you can provide a greeting; instructions on 

joining an online session; information about yourself, your product, or your 

company. 

At any time, you can replace or delete images and text that you add. 

To add an image to your Personal Meeting Room page: 

1 If you have not already done so, log in to your WebEx service Web site. For 

details, see Logging in to and out of the WebEx service site (on page 310). 

2 On the navigation bar at the top of the page, click My WebEx. 

3 Click My Profile. 

The My WebEx Profile page appears. 

4 Under Personal Meeting Room, specify options for your page. 

5 At the bottom of the My WebEx Profile page, click Update. 
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6 For details about the options for your Personal Meeting Room page, see About 

your Personal Meeting Room page (on page 323) . 
 

Sharing files on your Personal Meeting Room page 

You can share folders on your My WebEx Files: Folders page so that they appear on 

the Files tab on your Personal Meeting Room page. For any folder that you share, you 

can specify whether users can download files from or upload files to the folder. 

For more information about your Personal Meeting Room page, see About your 

Personal Meeting Room page (on page 323). 

To share files on your Personal Meeting Room page: 

1 Open the My WebEx Files page. For details, see Opening your personal folders, 

documents, and files (on page 329). 

2 Under Name, locate the folder in which you want to share files. 

3 If the file or folder is in a closed folder, click the folder to open it. 

4 Click the Properties icon for the folder in which you want to share files. 

  

 
 

The Edit Folder Properties window appears. 
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5 Specify sharing options for the folder. 

6 Click Update. 

For details about sharing options, see About the Edit Folder Properties page (on page 

336). 
 

Using Access Anywhere (My Computers) 
For information about and instructions for using Access Anywhere to set up and 

access a remote computer, please refer to the guide Getting Started with WebEx 

Access Anywhere. This guide is available on the Support page on your WebEx service 

Web site. 
 

About the My Computers page 

How to access this page 

On your WebEx service Web site, click My WebEx Files > My Computers. 
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What you can do here 

Set up and access remote computers using Access Anywhere. 

Options on this page 

  

Link or option Description 

Computer The name you have assigned to your remote computer. 

Status 

The status of your remote computer: 

 Available—the computer is available for remote access. 

 Offline—the computer is offline and is not available for 

remote access. 

Application 

The application on your remote computer that you have 

allowed to access, based on what you specified during set up. 

It may be Desktop, if you set up your desktop for access, or it 

may be a specific application name. 

Status 
If the computer is available for access, you can click the 

Connect link to connect to your remote computer. 

 
Removes the selected computer from the list of remote 

computers. 

 

Sets up the current computer for Access Anywhere and adds 

it to the list of remote computers. 

Download manual installer 
Downloads the manual installer for the Access Anywhere 

software. 

 

 

Maintaining files in your personal folders 
  

If you want to… See… 

get an overview of your personal storage 

space for files 

About maintaining files in your folders (on 

page 328) 

open your personal storage space for files Opening your personal folders, documents, 

and files (on page 329) 
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If you want to… See… 

create new folders to organize your files Adding new folders to your personal folders 

(on page 330) 

upload files to your personal folders Uploading files to your personal folders (on 

page 330) 

move or copy files or an entire folder to 

another folder 

Moving or copying files or folders in your 

personal folders (on page 331) 

change information about files or folders, 

including their names or descriptions 

Editing information about files or folders in 

your personal folders (on page 332) 

search for files or folders in your personal 

storage space for files 

Searching for files or folders in your personal 

folders (on page 333) 

download files in your personal storage space 

to your computer 

Downloading files in your personal folders (on 

page 334) 

share, or publish, files in your personal 

folders on your Personal Meeting Room, so 

others can access them 

Sharing files on your Personal Meeting Room 

page (on page 325) 

remove files or folders from your personal 

folders 

Deleting files or folders in your personal 

folders (on page 334) 

 

About maintaining files in your folders 

Your user account includes personal storage space for files on your WebEx service 

Web site. 

In your personal storage space, you can: 

 Create folders to organize your files. 

 Edit information about any file or folder in your personal folders. 

 Move or copy a file or folder to a different folder. 

 Share a folder so it appears on your Personal Meeting Room page. 

  

Tip:  

 You can use this storage space to access important information when you are away from the 

office. For example, if you are on a business trip and want to share a file during an online 

session, you can download the file in your personal folders to a computer, and then share the 

file with attendees. 

 If you share a folder, visitors to your Personal Meeting Room page can upload files to or 

download them from the folder. For example, you can use your personal folders to exchange 
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documents that you share in your sessions, archive recorded meetings, and so on. For more 

information about your Personal Meeting Room, see About your Personal Meeting Room (on 

page 323). 

 

Opening your personal folders, documents, and files 

To store files on your WebEx service Web site, or to access files that you stored, you 

must open your personal folders. 

To open your personal folders: 

1 Log in to your WebEx service Web site, and then click My WebEx. 

2 Click My Files. 

The My WebEx Files page appears, showing your personal folders and files. 

Depending on the settings for your WebEx Service Web site, you may see 

different categories of folders and files, and you can click on the heading links to 

see each category: 

 My Documents 

 My Recordings 

 My Event Recordings (available only in Event Center) 

 My Training Recordings (available only in Training Center)  

  

 

 

For details about the My WebEx Files page, see About the My WebEx Files > My 

Documents page (on page 334) and About the My WebEx Files > My Recordings page 

(on page 345). 
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Adding new folders to your personal folders 

To organize your files on your WebEx service Web site, you can create folders in 

your personal storage space for files. 

To create a new folder: 

1 Open the My Documents page. For details, see Opening your personal folders, 

documents, and files (on page 329). 

2 Under Action, click the Create Folder button for the folder in which you want a 

new folder. 

  

 
 

The Create Folder window appears. 

3 In the Folder Name box, type a name for the folder. 

4 Optional. In the Description box, type a description to help you to identify the 

folder's contents. 

5 Click OK. 
 

Uploading files to your personal folders 

To store files in your personal folders on your WebEx service Web site, you must 

upload them from your computer or a local server. 

You can upload up to three files at once. The is no limit to the size of the files, as long 

as you have available storage space. The amount of space available for storing files is 

determined by your site administrator. If you require more disk space, contact your 

site administrator. 

To upload files to your personal folders: 

1 Open the My Documents page. For details, see Opening your personal folders, 

documents, and files (on page 329). 

2 Locate the folder in which you want to store the file. 

3 Under Action for the folder, click the Upload button for the folder in which you 

want to store the file. 

  

 
 



 Chapter 19: Using My WebEx 

 

331 

 

The Upload File window appears. 

4 Click Browse. 

The Choose File dialog box appears. 

5 Select the file that you want to upload to your folder. 

6 Click Open. 

The file appears in the File name box. 

7 Optional. In the Description box, type a description to help you to identify the 

file. 

8 Optional. Select up to two additional files to upload. 

9 Click Upload. 

The files are uploaded to the folder that you selected. 

10 Once you are finished uploading files, click Finish. 

  
 

Moving or copying files or folders in your personal folders 

You can move one or more files or folders to another folder on your WebEx service 

Web site. 

To move or copy a file or folder: 

1 Open the My Documents page. For details, see Opening your personal folders, 

documents, and files (on page 329). 

2 Locate the file or folder that you want to move. 

3 Select the check box for the file or folder that you want move. 

You can select multiple files or folders. 

4 Click Move or Copy. 

The Move/Copy File or Folder window appears, showing a list of your folders. 

5 Select the option button for the folder in which you want to move or copy the file 

or folder. 

6 Click OK. 
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Editing information about files or folders in your personal 
folders 

You can edit the following information about a file or folder in your personal folders 

on your WebEx service Web site: 

 Name 

 Description 

You can also specify sharing options for folders that appear on your Personal Meeting 

Room page. For more information, see Sharing files on your Personal Meeting Room 

page (on page 325). 

To edit information about a file or folder: 

1 Open the My Documents page. For details, see Opening your personal folders, 

documents, and files (on page 329). 

2 Locate the file or folder for which you want to edit information. 

3 Click the Properties icon for the file or folder for which you want to edit 

information. 

  

 
 

The Edit File Properties or Edit Folder Properties window appears. 
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 In the Description box, type a new name for the file or folder. 

 In the Name box, type a new name for the file or folder. 

4 Click Update. 
 

Searching for files or folders in your personal folders 

In your personal folders on your WebEx service Web site, you can quickly locate a 

file or folder by searching for it. You can search for a file or folder by text that 

appears in either its name or description. 

To search for a file or folder: 

1 Open the My Documents page. For details, see Opening your personal folders, 

documents, and files (on page 329). 

2 In the Search For box type all or part of the file's name or description. 

3 Click Search. 

A list of any files or folders that contain the search text appears. 
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Downloading files in your personal folders 

In your personal folders on your WebEx service Web site, you can download any files 

to your computer or a local server. 

1 Open the My Documents page. For details, see Opening your personal folders, 

documents, and files (on page 329). 

2 Locate the file that you want to download. 

3 Under Action, click the Download button for the file that you want to download. 

  

 
 

The File Download dialog box appears. 

4 Follow any instructions that your Web browser or operating system provides to 

download the file. 
 

Deleting files or folders in your personal folders 

You can delete files or folders in your personal folders on your WebEx service Web 

site. 

To delete a file or folder: 

1 Open the My Documents page. For details, see Opening your personal folders, 

documents, and files (on page 329). 

2 Under Name, locate the file or folder that you want to delete. 

3 Select the check box for the file or folder that you want delete. 

You can select multiple files or folders. 

4 Click Delete. 
 

About the My WebEx Files > My Documents page 

How to access this page 

On your WebEx service Web site, click My WebEx Files > My Documents. 
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What you can do here 

 Store files that you use in your online sessions or that you want to access when 

away from your office. 

 Specify in which folders that visitors to your Personal Meeting Room can 

download or upload files. 

Options on this page 

  

Link or option Description 

Capacity The storage space available for your files, in megabytes (MB). 

Used 

The amount of storage space that your files occupy, in megabytes 

(MB). Once this value exceeds your capacity, you can no longer store 

files until you remove existing files from your folders. 

Search for 

Lets you locate a file or folder by searching for it. You can search for a 

file or folder by text that appears in either its name or description. To 

search for a file or folder, type all or part of its name or description in 

the box, and then click Search. 

 
Click this button to refresh the information on the page. 

Name 

The name of the folder or file. Click a folder or file name to open the 

Folder Information page or File Information page. From the 

Information page, you can access the properties of a folder or file. 

  
Indicates that the item is a folder. Click the image to display 

the contents of the folder. 

  
Indicates that the item is a file. 

Path 
The folder hierarchy for the folder or file. The Root folder is the top-

most folder in which all other folders and files reside. 

Size The size of the folder or file, in kilobytes (KB). 

Actions 

Click the icons to perform an action on the folder or file that is 

associated with it. 

 Upload file: Available only for files. Click this icon to open 

the File Upload page, on which you can select up to three 

files at a time to upload to a specified folder. 

 
Download file: Available only for files. Click this icon to 

download the file associated with it. 
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Link or option Description 

 Edit File Properties or Edit Folder Properties: Click this 

icon to open the Edit File Properties page or Edit Folder 

Properties page, on which you can edit information about 

the file or folder, respectively. 

 Create Folder: Available for folders only. Click this icon to 

open the Create Folder page on which you can create a new 

folder in your personal storage space. 

Shared 

 

Specifies the sharing settings for a folder; that is, how others who visit 

your Personal Meetings Room can access your folder and its files. 

R Read only: Visitors to your Personal Meeting Room can 

view the list of files in the folder and download the files. 

W Write only: Visitors to your Personal Meeting Room can 

upload files to the folder, but they cannot view the files in it. 

R/W Read and write: Users can view files in the folder, 

download files from the folder, and upload files to the folder. 

 Password Protected: Indicates that the folder is password 

protected. Visitors to your Personal Meeting Room must 

provide the password you specify to access the folder. 

Select All 

Selects the check boxes for all the folders and files that are visible in 

the list. You can then click the Copy or Move button or click the 

Delete link to perform an action on the selected folders or files. 

Clear All 
Clears the check boxes for all the folders and files that are selected in 

the list. 

Delete Deletes the selected folders and files from the list. 

Copy 
Opens a page on which you can copy the selected folder or file to 

another folder. 

Move 
Opens a page on which you can move the selected folder or file to 

another folder. 

 

About the Edit Folder Properties page 

How to access this page 

On your WebEx service Web site, click My WebEx > My Files > Properties icon 

for folder. 
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What you can do here 

Specify a name, a description, and sharing options for a folder that you created in 

your personal folders. 

Options on this page 

  

Use this option… To… 

Name Enter the name of the folder. 

Description Enter the description of the folder. 

Share Specify who can access this folder. 

 Do not share this folder: This folder does not appear on your 

Personal Meeting Room page. Thus, visitors to your page 

cannot view the folder or access any files in it. 

 Share this folder: This folder appears on your Personal 

Meeting Room. 

The drop-down list specifies which users can access the folder, 

as follows: 

 With all: All visitors to your Personal Meeting Room can 

access this folder. 

 With users with host or attendee accounts: Only visitors 

to your Personal Meeting Room who have either a host 

account or an attendee account on your WebEx service 

Web site can access this folder. 

 With users with host accounts only: Only visitors to your 

Personal Meeting Room who have a host account on your 

WebEx service Web site can access this folder. 

Share as Enter the name for the folder that will appear on your Personal 

Meeting Room page. 

Read Let visitors to your Personal Meeting Room view the list of files in the 

folder and download the files. 

Write Let visitors to your Personal Meeting Room upload files to the folder 

but does not allow them to view the files in it. 

Read & write Let users view files in the folder, download files from the folder, and 

upload files to the folder. 

Allow files to be 

overwritten 

Let users upload a file with the same name as an existing file in the 

folder and replace the existing file. If this option is not selected, users 

cannot overwrite any files in the folder. 



Chapter 19: Using My WebEx 

 

338 

 

Use this option… To… 

Password protected Let only visitors to your Personal Meeting Room who know the 

password view the list of files in the folder, download files from the 

folder, or upload files to the folder, depending on the read/write 

settings for the folder. 

Password: The password that visitors to your Personal Meeting 

Room must provide to access the folder. 

Confirm: If you specified a password, type it again to verify that you 

typed it correctly. 

Update Save any changes that you made to folder's properties, and then 

closes the Edit Folder Properties window. 

Cancel Close the Edit Folder Properties window, without saving any of the 

changes that you made. 

  
 

Opening the My Recordings Page 

To upload or maintain recordings, you must do so from the My Recordings page on 

your WebEx service Web site. 

To open the My Recordings page: 

1 Log in to your WebEx service Web site, and then click My WebEx. 

2 Click My Files > My Recordings. 

The My Recordings page appears, showing your recording files. 

For details about the My Recordings page, see About the My WebEx Files > My 

Recordings page (on page 345). 
 

Uploading a recording file 

If you recorded a meeting using the integrated or standalone WebEx Recorder, you 

can upload the recording file, with a .wrf extension, from your local computer to the 

My Recordings page. 

For instructions on editing a recording, see Editing information about a recording (on 

page 339). 
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Note: If you recorded a meeting using the WebEx Network-Based Recorder (NBR), the WebEx 

server automatically uploads the recording file, with an .arf extension, to the appropriate tab on 

the My Recordings page once you stop the Recorder. You do not need to upload it yourself. 

To upload a recording file: 

1 Go to the My Recordings page. For details, see Opening the My Recordings page 

(on page 338). 

2 Click Add Recording. 

3 On the Add Recording page, enter information and specify options. 

For details about what you can do with each option on the Add/Edit Recordings 

page, see About the My WebEx Files > My Recordings page (on page 345).  

4 Click Save. 
 

Editing information about a recording 

You can edit information about a recording at any time. 

To edit information about a recording: 

1 Go to the My Recordings page. For details, see Opening the My Recordings page 

(on page 338). 

2 Click the following icon for the recording that you want to edit. 

  

 
 

The Edit Recording page appears. 

3 Make your changes. 

For details about what you can do with each option on the Edit Recording page, 

see About the My WebEx Files > My Recordings page (on page 345).  

4 Click Save. 
 

Sending an email to share a recording 

You can send an email one or more people to share your recording with them.  
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To send an email to share a recording with others: 

1 Go to the My Recordings page. For details, see Opening the My Recordings page 

(on page 338). 

2 Click the appropriate link for your recording type: 

 Meetings 

 Events 

 Sales Meetings 

 Training Sessions 

 Miscellaneous 

3 Open the Share My Recording window: 

 Click the following icon for the recording that you want to share with others. 

  

 
 

 Click the linked name of the recording you want to share. On the Recording 

Information page, click Send Email. 

  

 
 

The Share My Recording window appears. 
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4 Select recipients for your email: 

 Click Select Recipients to select contacts from your Contacts list 

 Type email addresses in the Send to list, separated by commas. 

5 (Optional) Type a message in the Your message box. 

6 Click Send. 

Your email message will be sent to the selected recipients, and will include 

information about the recording and a link to play it. 
 

About the Add/Edit Recording page 

How to access this page 

If you are adding a recording... 

1 On your WebEx service Web site, click My WebEx > My Files > My 

Recordings. 

2 Click Add Recording. 

If you are editing information about a recording... 

1 On your WebEx service Web site, click My WebEx > My Files > My 

Recordings. 

2 Click the More button in the row of the recording that you want to edit. 

  

 
 

3 Click Modify. 

  

 

 

What you can do here 

 Edit general information about a recording, including the topic and description. 
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 Require a password to play or download the recording. 

Options on this page 

  

Use this option.... To.... 

Topic Specify the topic of the recording. 

Description Provide a description of this recording. 

Recording file Click Browse to select the recording file that resides on your 

local computer. 

Duration Specify the duration of the recording. 

File size Displays the size of the recording file. (Available only when 

editing recording information.) 

Set password Set an optional password that users must provide to view the 

recording. 

Confirm password Confirm the password that users must provide to view the 

recording. 

Playback control options 

  

Use this option.... To.... 

Panel Display Options Determines which panels are displayed in the recording when it 

is played back. You can select any of the following panels to be 

included the recording playback: 

 Chat 

 Q & A 

 Video 

 Polling 

 Notes 

 File Transfer 

 Participants 

 Table of Contents 

Panel display options do not modify the panel display in the 

actual recording that is stored on the WebEx network. 
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Use this option.... To.... 

Recording Playback 

Range 

Determines how much of the recording is actually played back. 

You can select either of the following: 

 Full playback: Plays back the full length of the recording. 

This option is selected by default. 

 Partial playback: Plays back only part of the recording 

based on your settings for the following options: 

 Start: X min X sec of the recording: Specifies the 

time to start playback; for example, you can use this 

option if you would like to omit the "dead time" at the 

beginning of the recording, or if you would like to show 

only a portion of the recording. 

 End: X min X sec of the recording: Specifies the 

time to end playback; for example, you can use this 

option if you would like to omit the "dead time" at the 

end of the recording. You can not specify an end time 

greater than the length of the actual recording. 

The partial playback range you specify does not modify the 

actual recording that is stored on the server. 

Include NBR player 

controls 

Includes full Network Recording Player controls, such as stop, 

pause, resume, fast forward, and rewind. This option is selected 

by default. If you would like to prevent viewers from skipping 

portions of the recording, you can turn off this option to omit 

Network Recording Player controls from the playback. 

 

 

About the Recording Information page 

How to access this page 

On your WebEx service Web site, click My WebEx > My Files > My Recordings > 

[recording type] > [topic of a recording]. 

What you can do here 

 View information about the recording. 

 Play back the recording. 
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 Send an email to share the recording with others. 

 Download the recording. 

 Enable or disable the recording 

 Open the Edit Recording page on which you can edit information about a 

recording. 

Options on this page 

  

Option Description 

Topic The name of the recording. You can edit the topic at any time. 

Create time The time and date the recording was created. 

Duration The length of the recording. 

Description A description of the recording. 

File size The file size of the recording. 

Create time The date and time at which the recording was created. 

Status 
The status of the recording. The possible options are Enable or 

Disable.  

Password 
Indicates whether a user must provide a password to view the 

recording. 

Stream recording link 

Clicking the link lets you play the recording (available only for 

recording files with the .arf extension that were recorded by 

NBR). 

Download recording link Clicking the link lets you download the recording. 

 

Clicking the button lets you play the recording (available only for 

recording files with the .arf extension that were recorded by 

NBR). 

If you want to download the recording, you can also click the 

link for downloading under Play Recorded a meeting Now. 

 

Clicking the button opens the Share My Recording window, 

which allows you to send an email message to selected 

recipients, inviting them to play your recording. 

If you want to send the email with your local email client 

instead, click the link for using the email client under Share My 

Recording. 
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Option Description 

 Clicking the button opens the Edit Recording page. 

 Clicking the button deletes the recording. 

 

Clicking the button disables the recording everywhere it is 

published on your WebEx Service Web site. (Available only for 

enabled recordings.) 

 

Clicking the button enables the recording everywhere it is 

published on your WebEx Service Web site. (Available only for 

disabled recordings.) 

 Clicking the button returns you to the recording list. 

 

 

About the My WebEx Files > My Recordings page 

How to access this page 

Log in to your WebEx service Web site, and then click My WebEx. From the left 

navigation bar, click My Files > My Recordings. 

What you can do here 

Manage, upload, and maintain your recording files. 

Options on this page 

View different categories of recordings: 

 Meetings 

 Events 

 Sales Meetings 

 Training Sessions 

 Miscellaneous 
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About the My WebEx Files > My Recordings > Meetings page 

How to access this page 

Log in to your WebEx service Web site, and then click My WebEx. From the left 

navigation bar, click My Files > My Recordings > Meetings. 
 

What you can do here 

Manage, upload, and maintain recording files of meetings you host. 

Options on this page 

  

Option Description 

 
Refreshes the information on the page. 

Search 
Allows you type text to search for within recording names. Click 

Search to start the search. 

You are currently using X 

% of Y GB 

The percentage of available personal storage space on your 

WebEx Service Web site that is being used by your recordings. 

This field appears only if your site administrator has turned on 

the option to show personal recording storage allocation usage. 

If this field does appear, and you exceed your personal storage 

allocation, you will not be able to record meetings until some 

recordings are deleted or the storage allocation is increased by 

your system administrator. 

Site storage X % of Y GB 

The percentage of total available storage space on your WebEx 

Service Web site that is being used by all recordings on your 

site. If your site exceeds its storage allocation, users will not be 

able to record meetings until recordings are deleted or the 

storage allocation is increased by your system administrator. 

 
Indicates a disabled recording. 

Topic 

The name of the recording. If you record a meeting on the 

server, the WebEx server automatically uploads the recording to 

this page. In this case, the topic of the recording is the topic of 

the meeting. You can edit the topic at any time. 

Size The size of the recording. 

Create Time/Date The date and time the recording was created. 
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Option Description 

Duration The length of the recording. 

Format 

The format of the recording file. 

A recording file can be in WebEx Advanced Recording Format 

(ARF) or WebEx Recording Format (WRF). You can also store 

recording files that are in Windows Media Audio/Video (WMV) 

format. For Event Center and Training Center, you can also 

store Shockwave Flash Object (SWF) format files. 

 

Lets you play the recording (available only for recording files 

with an .arf extension that were recorded by the Network-Based 

Recorder). 

If playback of the file requires a password, you must provide the 

password. 

 
Lets you send an email to share this recording with others. 

 

Displays a menu with more options for your recording: 

  Download: Lets you download the recording to your 

local computer. 

If downloading the file requires a password, you must 

provide the password. 

  Modify: Lets you edit information of the recording. For 

details, see About the Add/Edit Recordings page (on page 

341). 

  Disable: Lets you disable the recording in all locations. 

  Delete: Lets you delete the recording from this page. 

 

Lets you upload a new recording. 

For details, see Uploading a recording file (on page 338) and 

About the Add/Edit Recordings page (on page 341). 

 Indicates that a recording is password-protected. 

 

About the My WebEx Files > My Recordings > Miscellaneous 
page 

How to access this page 

Log in to your WebEx service Web site, and then click My WebEx. From the left 

navigation bar, click My Files > My Recordings > Miscellaneous. 
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What you can do here 

Manage, upload, and maintain recording files of meetings you host. 

Options on this page 

  

Option Description 

 
Refreshes the information on the page. 

Search 
Allows you type text to search for within recording names. Click 

Search to start the search. 

You are currently using X 

% of Y GB 

The percentage of available personal storage space on your 

WebEx Service Web site that is being used by your recordings. 

This field appears only if your site administrator has turned on 

the option to show personal recording storage allocation usage. 

If this field does appear, and you exceed your personal storage 

allocation, you will not be able to record meetings until some 

recordings are deleted or the storage allocation is increased by 

your system administrator. 

Site storage X % of Y GB 

The percentage of total available storage space on your WebEx 

Service Web site that is being used by all recordings on your 

site. If your site exceeds its storage allocation, users will not be 

able to record meetings until recordings are deleted or the 

storage allocation is increased by your system administrator. 

 
Indicates a disabled recording. 

Topic 

The name of the recording. If you record a meeting on the 

server, the WebEx server automatically uploads the recording to 

this page. In this case, the topic of the recording is the topic of 

the meeting. You can edit the topic at any time. 

Size The size of the recording. 

Create Time/Date The date and time the recording was created. 

Duration The length of the recording. 

Format 

The format of the recording file. 

A recording file can be in WebEx Advanced Recording Format 

(ARF) or WebEx Recording Format (WRF). You can also store 

recording files that are in Windows Media Audio/Video (WMV) 

format. For Event Center and Training Center, you can also 

store Shockwave Flash Object (SWF) format files. 
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Option Description 

 

Lets you play the recording (available only for recording files 

with an .arf extension that were recorded by the Network-Based 

Recorder). 

If playback of the file requires a password, you must provide the 

password. 

 
Lets you send an email to share this recording with others. 

 

Displays a menu with more options for your recording: 

  Download: Lets you download the recording to your 

local computer. 

If downloading the file requires a password, you must 

provide the password. 

  Modify: Lets you edit information of the recording. For 

details, see About the Add/Edit Recordings page (on page 

341). 

  Disable: Lets you disable the recording in all locations. 

  Delete: Lets you delete the recording from this page. 

 Indicates that a recording is password-protected. 

 

Maintaining contact information 
  

If you want to… See… 

get an overview of your personal address 

book 

About maintaining contact information (on 

page 350) 

open your personal address book Opening your address book (on page 350) 

add a new contact to your personal address 

book 

Adding a contact to your address book (on 

page 351) 

add multiple contacts to your address book at 

once 

Importing contact information in a file to your 

address book (on page 354) 

add contacts in Microsoft Outlook to your 

personal address book 

Importing contact information from Outlook to 

your address book (on page 357) 

view or change information about contacts in 

your personal address book 

Viewing and editing contact information in 

your address book (on page 358) 
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If you want to… See… 

find a contact in your personal address book Finding a contact in your personal address 

book (on page 358) 

combine multiple contacts into a single 

distribution list 

Creating a distribution list in your address 

book (on page 359) 

edit information about a distribution list Editing a distribution list in your address book 

(on page 361) 

delete a contact or distribution list Deleting contact information in your address 

book (on page 363) 

 

About maintaining contact information 

You can maintain a personal online address book, in which you can add information 

about contacts and create distribution lists. When scheduling a meeting or starting an 

instant meeting, you can quickly invite any contacts or distribution lists in your 

personal address book. You can also invite contacts in the Company Address Book 

for your WebEx service Web site, if one is available.  

You can add contacts to your personal address book in any of the following ways: 

 Specify information about contacts one at a time. 

 Import contact information from your Microsoft Outlook contacts. 

 Import contact information from a comma-separated/comma-delimited values 

(CSV) file. 

You can also edit or delete the information about any contact or distribution list in 

your personal address book. 
 

Opening your address book 

You can open your personal address book on your WebEx service Web site, to view 

or maintain information about your contacts. 

To open your address book: 

1 Log in to your WebEx service Web site. For details, see Logging in to and out of 

the WebEx service site (on page 310). 

2 On the navigation bar at the top of the page, click My WebEx. 

3 Click My Contacts. 
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The My WebEx Contacts page appears. 

  

 

 

4 In the View drop-down list, select one of the following contact lists: 

 Personal Contacts: Includes any individual contacts or distribution lists that 

you added to your personal address book. If you have a Microsoft Outlook 

address book or contacts folder, you can import its contacts to this list of 

contacts. 

 Company Address Book: Your organization's address book, which includes 

any contacts that your site administrator has added to it. If your organization 

uses a Microsoft Exchange Global Address List, your site administrator can 

import its contacts to this address book. 
 

Adding a contact to your address book 

You can add contacts to your personal address book, one at a time. 

To add a contact to your personal address book: 

1 Open your personal address book. For details, see Opening your address book (on 

page 350). 

2 In the View drop-down list, select Personal Contacts. 
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A list of contacts in your Personal Contacts list appears. 

3 Click Add Contact. 

The Add Contact page appears. 

  

 

 

4 Provide information about the contact.  

5 Click Add. 

For descriptions of the information and options on the New Contact page, see About 

the New/Edit Contact page (on page 353). 

  

Note:  

 You cannot add contacts to your Company Address Book. 

 If you want to add multiple contacts, you can them all at once, instead of adding one contact 
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at a time. For details, see Importing contact information in a file to your address book (on 

page 354). 

 

About the New/Edit Contact page 

How to access this page 

On your WebEx service Web site, click My WebEx > My Contacts > Add Contact 

or [check box for contact] > Edit. 

What you can do here 

Enter information about a new or existing contact for your personal address book. 

Options on this page 

  

Use this option… To… 

Full name Enter the contact's first and last name. 

Email address Enter the contact's email address. 

Language Set the language in which any email messages that you send to 

the contact using your WebEx service site appear. 

Available only if your WebEx service Web site can be displayed in 

two or more languages. 

Company Enter the company or organization for which the contact works. 

Job title Enter the contact's position in a company or organization. 

URL Enter the URL, or Web address, for the contact's company or 

organization. 

Phone number/Phone 

number for mobile 

device/Fax number 

Enter the contact's phone numbers. For each number, you can 

specify the following: 

Country Code Specify the number that you must dial if the contact resides in 

another country. To select a different country code, click the link to 

display the display the Country Code window. From the drop-

down list, select the country in which the contact resides. 

Area or city code Enter the area or city code for the contact's phone number. 

Number Enter the phone number. 
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Use this option… To… 

Extension Enter the extension for the phone number, if any. 

Address 1 Enter the contact's street address. 

Address 2 Enter additional address information, if necessary. 

State/Province Enter the contact's state or province. 

ZIP/Postal code Enter the contact's ZIP or postal code. 

Country Enter the country in which the contact resides. 

Username Enter the username with which the user logs in to your WebEx 

service Web site, if the contact has a user account. 

Notes Enter any additional information about the contact. 

 

Importing contact information in a file to your address book 

You can add information about multiple contacts simultaneously to your personal 

address book, by importing a comma-separated values (CSV) file. A CSV file has the 

.csv file extension; you can export information from many spreadsheet and email 

programs in CSV format. 

To create a CSV file: 

1 Open your address book. For details, see Opening your address book (on page 

350). 

2 In the View drop-down list, ensure that Personal Address Book is selected. 

3 Click Export. 

4 Save the .csv file to your computer. 

5 Open the .csv file that you saved in a spreadsheet program, such as Microsoft 

Excel. 

6 Optional. If contact information exists in the file, you can delete it. 

7 Specify information about the new contacts in the .csv file. 

  

 
Important: If you add a new contact, ensure that the UID field is blank. For information 

about the fields in the .csv file, see About the Contact Information CSV template (on page 

355). 

 

8 Save the .csv file. Ensure that you save it as a .csv file. 
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To import a CSV file containing new contact information: 

1 Open your address book. For details, see Opening your address book (on page 

350). 

2 In the View drop-down list, ensure that Personal Contacts is selected. 

3 In the Import From drop-down list, select Comma Delimited Files. 

4 Click Import. 

5 Select the .csv file in which you added new contact information. 

6 Click Open. 

7 Click Upload File. 

The View Personal Contacts page appears, allowing you to review the contact 

information you are importing. 

8 Click Submit. 

A confirmation message appears. 

9 Click Yes. 

  

Note: If an error exists in any new or updated contact information, a message appears, informing 

you that no contact information was imported. 

 

 

About the Contact Information CSV template 

How to access this template 

On your WebEx service Web site, click My WebEx > My Contacts > View > 

Personal Address Book > Export. 

What you can do here 

Specify information about multiple contacts, which you can then import to your 

personal address book. 
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Fields in this template 

  

Option Description 

UUID A number that your WebEx service site creates to identify the contact. If 

you add a new contact to the CSV file, you must leave this field blank. 

Name Required. The contact's first and last name. 

Email Required. The contact's email address. The email address must be in 

the following format: 

name@company.com 

Company The company or organization for which the contact works. 

JobTitle The contact's position in a company or organization. 

URL The URL, or Web address, for the contact's company or organization. 

OffCntry The country code for the contact's office phone-that is, the number that 

you must dial if the contact resides in another country. 

OffArea The area or city code for the contact's office phone number. 

OffLoc The contact's office phone number. 

OffExt The extension for the contact's office phone number, if any. 

CellCntry The country code for the contact's cellular or mobile phone-that is, the 

number that you must dial if the contact resides in another country. 

CellArea The area or city code for the contact's cellular or mobile phone number. 

CellLoc The contact's cellular or mobile phone number. 

CellExt The extension for the contact's cellular or mobile phone number, if any. 

FaxCntry The country code for the contact's fax number-that is, the number that 

you must dial if the contact resides in another country. 

FaxArea The area or city code for the contact's fax number. 

FaxLoc The contact's fax number. 

FaxExt The extension for the contact's fax machine, if any. 

Address 1 The contact's street address. 

Address 2 The additional address information, if necessary. 

State/Province The contact's state or province. 
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Option Description 

ZIP/Postal The contact's ZIP or postal code. 

Country The country in which the contact resides. 

Username The user name with which the user logs in to your WebEx service Web 

site, if the contact has a user account. 

Notes Any additional information about the contact. 

 

Importing contact information from Outlook to your address 
book 

If you use Microsoft Outlook, you can import the contacts that you maintain in your 

Microsoft Outlook address book or folder to your personal address book on your 

WebEx service Web site. 

To import contacts from Outlook to your personal address book: 

1 Open your address book. For details, see Opening your address book (on page 

350). 

2 In the View drop-down list, select Personal Contacts. 

3 In the Import from drop-down list, select Microsoft Outlook. 

4 Click Import. 

The Choose Profile dialog box appears. 

5 In the Profile Name drop-down list, select the Outlook user profile that includes 

the contact information that you want to import. 

6 Click OK. 

  

Note:  

 When you import contacts in Outlook, your WebEx service Web site retrieves contact 

information from the Outlook address book or folder in which you have chosen to keep 

personal addresses. For information about keeping personal addresses in Outlook, refer to 

Microsoft Outlook Help. 

 If your personal address book already includes a contact who is also in your Outlook contacts 

list, the contact is not imported. However, if you change the contact's email address in your 

personal address book, importing the contact from Outlook creates a new contact in your 

personal address book. 
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Viewing and editing contact information in your address 
book 

In your personal address book, you can view and edit information about individual 

contacts in your Personal Contacts list. You can view, but not edit, information about 

contacts in your Company Address Book. 

To view or edit contact information: 

1 Open your address book. For details, see Opening your address book (on page 

350). 

2 In the View drop-down list, select one of the following: 

 Personal Contacts 

 Company Address Book 

A list of contacts appears. 

3 Locate the contact whose information you want to view or edit. For details about 

locating a contact, see Finding a contact in your personal address book (on page 

358). 

4 Under Name, select the contact whose information you want to view or edit. 

5 Do one of the following: 

 If the contact is in your Personal Contacts list, click Edit. 

 If the contact is in your Company Address Book, click View Info. 

Information about the contact appears. 

6 Optional. If the contact is in your Personal Contacts list, edit the information that 

you want to change on the Edit Contact's Information page. 

For descriptions of the information and options of the Edit Contact's Information 

page, see About the New/Edit Contact page (on page 353). 

7 Click OK. 
 

Finding a contact in your personal address book 

You can quickly locate a contact in your personal address book, using one of several 

methods. 



 Chapter 19: Using My WebEx 

 

359 

 

To search for a contact in your address book: 

1 Open your address book. For details, see Opening your address book (on page 

350). 

2 In the View drop-down list, select a contacts list. 

3 Do any of the following: 

 In the Index, click a letter of the alphabet to display a list of contacts whose 

names begin with that letter. For example, the name Susan Jones appears 

under S. 

 To search for a contact in the list you are currently viewing, type text that 

appears in either the contact's name or email address in the Search for box, 

and then click Search. 

 If the entire list of contacts does not fit on a single page, view another page by 

clicking the links for the page numbers. 

 Sort your personal contacts or company address book by name, email address, 

or phone number by clicking the column headings. 
 

Creating a distribution list in your address book 

You can create distribution lists for your personal address book. A distribution list 

includes two or more contacts for which you provide a common name and appears in 

your Personal Contacts list. For example, you can create a distribution list named 

Sales Department, which includes contacts who are members of your Sales 

Department. If you want to invite members of the department to a meeting, you can 

select the group rather than each member individually. 

To create a distribution list: 

1 Open your address book. For details, see Opening your address book (on page 

350). 

2 Click Add Distribution List. 

The Add Distribution List page appears. 
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3 In the Name box, type the name of the group. 

4 Optional. In the Description box, type descriptive information about the group. 

5 Under Members, locate the contacts that you want to add to the distribution list, 

by doing any of the following: 

 Search for a contact, by typing all or part of the contact's first or last name in 

the Search box. 

 Click the letter that corresponds to the first letter of the contact's first name. 

 Click All to list all contacts in your Personal Contacts list. 

6 Optional. To add a new contact to your Personal Contacts list, under Members, 

click Add Contact. 

7 In the box on the left, select the contacts that you want to add to the distribution 

list. 

8 Click Add to move contacts you selected to the box on the right. 

9 After you finish adding contacts to the distribution list, click Add to create the 

list. 

In your Personal Contacts list, the Distribution List indicator appears to the left 

of the new distribution list: 
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For descriptions of the information and options on the Add Distribution List page, see 

About the Add/Edit Distribution List page (on page 362). 
 

Editing a distribution list in your address book 

You can add or remove contacts from any distribution list that you have created for 

your personal address book. You can also change a group's name or descriptive 

information. 

To edit a distribution list: 

1 Open your address book. For details, see Opening your address book (on page 

350). 

2 In the View drop-down list, select Personal Contacts. 

A list of the contacts in your Personal Contacts list appears, including any 

distribution lists that you have created. The Distribution List indicator appears to 

the left of a distribution list: 

  

 
 

Under Name, select the name of the distribution list. The Edit Distribution List 

page appears. 
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3 Edit information about the distribution list.  

4 Click Update. 

For descriptions of the information and options on the Edit Distribution List page, see 

About the Add/Edit Distribution List (on page 362). 
 

About the Add/Edit Distribution List page 

How to access this page 

On your WebEx service Web site, click My WebEx > My Contacts > Add 

Distribution List. Or, select distribution list in Personal Contacts list. 
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What you can do here 

Add contacts to your distribution list or remove contacts from your distribution list. 

Options on this page 

  

Use this option… To… 

Name Enter the name of the distribution list. For example, if you want to 

add a distribution list that includes members of your company's 

sales department, you might name the list Sales Department. 

Description Optionally enter descriptive information about the distribution list, 

to help you identify it later. 

Search Find a contact, by typing all or part of the contact's first or last 

name. 

Index Find a contact, by clicking the letter that corresponds to the first 

letter of the contact's first name. To list contacts for which you 

identified with a number, click #. To list all contacts in your 

Personal Contacts list, click All. 

Add> Add a one or more selected contacts to your distribution list. 

<Remove Remove one or more selected contacts from your distribution list. 

Add Contact Add a new contact to your Personal Contacts list and add the 

contact to your distribution list. 

Add Add a new distribution list to your Personal Contacts list. 

Update Update an existing distribution list that you have edited. 

 

Deleting contact information in your address book 

You can delete any contact or distribution lists that you have added to your personal 

address book. 

To delete a contact or contact group: 

1 Open your address book. For details, see Opening your address book (on page 

350). 

2 In the View drop-down list, select Personal Contacts. 
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3 In the list that appears, select the check box for the contact or distribution list that 

you want to delete. 

4 Click Delete. 

A message appears, asking you to confirm the deletion. 

5 Click OK. 
 

Maintaining your user profile 
  

If you want to… See… 

get an overview of maintaining your user 

profile 

About maintaining your user profile (on page 

364) 

edit your user profile Editing your user profile (on page 371) 

 

About maintaining your user profile 

Once you obtain a user account, you can edit your user profile at any time to do the 

following: 

 Maintain personal information, including your 

 Full name 

 Username (if your site administrator provides this option) 

 Password 

 Contact information (including your street address, email address, and phone 

numbers) 

 Tracking codes that your organization uses to keep records of your meetings 

(such as project, department, and division numbers) 

 Specify whether to display links to your company's partner sites in the My WebEx 

navigation bar, if your site administrator set up partner links 

 Manage any scheduling templates that you saved 

 Set options for your Personal Meeting Room options, including the images and 

welcome message that appear on the page 

 Set default options for your online sessions, including 
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 The default session type that you want to use, if your account includes 

multiple session types 

 Whether your scheduled meetings are automatically removed from your list of 

meetings once the meeting ends 

 Whether the Quick Start page appears in the content viewer once you start a 

meeting 

 The users who can schedule meetings on your behalf 

 Set Web site preferences, including: 

 The home page that appears when you access your WebEx service Web site 

 The time zone in which meeting times appear 

 The language in which your Web site displays text, if your site includes 

multiple languages 

 The locale (the format in which your Web site displays dates, times, currency 

values, and numbers) 
 

 

About the My WebEx Profile page 

How to access this template 

On your WebEx service Web site, click My WebEx > My Profile. 

What you can do here 

Manage the following: 

 Account information 

 Personal information 

 Partner integration options 

 Scheduling templates (does not apply to Support Center) 

 Personal Meeting Room information 

 Meeting options 

 Web page preferences, including your home page and language 

 Support Center CSR Dashboard options (Support Center only) 
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Personal Information options 

  

Use this option… To… 

Username Specify the username for your account. You can change this 

name only if the administrator for your WebEx service Web site 

provides this option. 

Tip: If you need to change your username, but cannot edit it on 

this page, ask your site administrator to change your username 

or create a new account for you. 

Change Password  Old password: Type the old password for your account. 

 New password: Specify the new password for your 

account. A password: 

 Must contain at least four characters 

 Can consist of a maximum of 32 characters 

 Can include any letters, numbers, or special 

characters, but not spaces 

 Is case sensitive 

 Retype New password: Verify that you typed your 

password correctly in the New password box. 

Call-in authentication If enabled by your site administrator, allows you to be 

authenticated and placed into the correct teleconference without 

needing to enter a meeting number whenever you dial into any 

CLI (caller line identification) or ANI (automatic number 

identification) enabled teleconference. Selecting this option for a 

phone number in your user profile maps your email address to 

that phone number. Caller authentication is available only if you 

have been invited to a CLI/ANI enabled teleconference by email 

during the meeting scheduling process. Caller authentication is 

not available if you are dialing in to a CLI/ANI enabled 

teleconference. 

Call-back When selected for a phone number in your user profile, allows 

you to receive a call from the teleconferencing service if it is 

using an integrated call-back feature. If your site includes the 

international call-back option, participants in other countries 

receive a call back. For more information about this option, ask 

your site administrator. 

PIN If enabled by your site administrator, allows you specify a call-in 

authentication PIN to prevent “spoofers” from using your 

number to dial into a teleconference. If your site administrator 

sets the authentication PIN as mandatory for all accounts using 

call-in authentication on your site, you must specify a PIN 

number or caller authentication will be disabled for your 

account. This option is available only if you have selected the 

Call-in authentication option for at least one of the phone 
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Use this option… To… 

numbers in your profile. The PIN can also be used to provide a 

secondary level of authentication for calls where the host is 

using the phone and may need to invite additional attendees. 

Other personal 

information options 

Enter any personal information that you want to maintain in your 

profile. 

Partner integration options 

Your site administrator can set up custom links to the Web sites of your company's 

partners, and then display the links on the My WebEx navigation bar. For example, if 

your company uses another company's Web site to provide a service, your site 

administrator can provide a link to that company's site in your My WebEx navigation 

bar. You can then show or hide that link. 

  

Use this option.... To.... 

Display partner links in 

My WebEx 

Shows or hides partner site links in the My WebEx navigation 

bar. 
 

Calendar Work Hours options 

Use these options to specify working hours to use with scheduling calendars. 

  

Use this option… To… 

Start time Select the start time for your daily work calendar. 

End time Select the end time for your daily work calendar. 

 

Scheduling template options  

Use these options to manage scheduling templates that you set up using the 

scheduling options on your site. 

  

Use this option… To… 

Get Info Shows the settings you set for the selected template. 
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Use this option… To… 

Edit Opens the scheduling options on your site for the selected 

template. 

Delete Removes the selected template from your profile. 

Select All Selects all the scheduling templates, allowing you to delete 

them all at once. 
 

Personal Meeting Room options 

  

Use this option… To… 

Personal Meeting Room 

URL 

Go to your Personal Meeting Room page. You can click the 

URL from the My Profile page to preview your current Personal 

Meeting Room page. 

Your Personal Meeting Room page shows online sessions that 

you scheduled and any in-progress sessions that you are 

currently hosting. 

Users to whom you provide your personal URL can use this 

page to join any meeting that you are hosting. They can also 

download files in any folders that you share. 

Welcome Message Enter the message that appears on your Personal Meeting 

Room page. A message can be a maximum of 128 characters, 

including spaces and punctuation. 

To specify a message, type it in the box, and then click Update. 

Upload Image Upload an image file from your computer or another computer 

on your network to your Personal Meeting Room page. For 

example, you can upload a picture of yourself, your company's 

logo, or a picture of your company's product. Visitors to your 

page can see the image that you upload. 

The image can be an maximum of 160 pixels wide. If you 

upload a larger image, its width is automatically reduced to 160 

pixels. However, the image's aspect ratio is maintained. 

Browse: Lets you locate an image. 

Upload: Uploads the image that you selected. 

Current Image: Displays the image that currently appears on 

your Personal Meeting Room page. 

Delete: Removes the current image from your Personal 

Meeting Room page. This button is available only if you have 

uploaded an image for the page. 

Customize branding of Upload a banner image to the non-scrolling header area for 

your Personal Meeting Room page. For example, you can 
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Use this option… To… 

header area upload your company's logo or an advertisement. Visitors to 

your page can see the image that you upload. Available only if 

your site administrator has turned on this option for your 

account. 

The image can be an maximum of 75 pixels high. If you upload 

a larger image, its height is automatically reduced to 75 pixels. 

However, the image's aspect ratio is maintained. 

Browse: Lets you locate a banner image. 

Upload: Uploads the banner image that you selected. 

Current Image: Displays the banner image that currently 

appears on your Personal Meeting Room page. 

Delete: Removes the current banner image from your Personal 

Meeting Room page. This button is available only if you have 

uploaded an image for the page. 

Productivity Tools Options 

  

Use this option.... To.... 

Automatically download 

Productivity Tools when 

logging in to the WebEx 

service site 

Specify that WebEx Productivity Tools should be downloaded 

automatically when you log in to the WebEx service site. If this 

option is turned off, you can still download Productivity Tools 

manually. 

 

Session Options 

  

Use this option… To… 

Automatically delete 

meetings from My 

Meetings when 

completed 

Specify that once a scheduled meeting ends, the meeting is 

automatically removed from your list of scheduled meetings on 

the My Meetings page, if the scheduled starting time has 

passed. If you do not select this option, the meeting remains on 

your list of meetings until you delete it. 

You can change this default setting when scheduling a meeting. 

Applies only to meetings and sales meeting. Does not apply to 

events, support sessions, or training sessions. 
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Use this option… To… 

Default session type Specify the default session type that you host, if your user 

account lets you host different types of online sessions. 

For more information about session types, ask the site 

administrator for your WebEx service. 

You can change this default setting when scheduling a meeting. 

Quick Start Specify whether the Quick Start page appears in the content 

viewer once you start a meeting. The Quick Start lets you start 

sharing activities quickly, as an alternative to starting them from 

a menu or toolbar. 

 Show Quick Start to host and presenter: The Quick Start 

appears in the content viewer for the host and presenter. 

 Show Quick Start to attendees: The Quick Start appears 

in the content viewer for attendees. Select this option only if 

you intend to let attendees share information during your 

meetings. 

You can change this default setting when scheduling a meeting. 

Scheduling permission Type the email addresses for any users whom you want to let 

schedule meetings for you. Separate email addresses with 

either a comma or a semicolon. 

Select From Host List: Open the Select Host page, which 

contains a list of all users who have accounts on your WebEx 

service Web site. On this page, you can select users whom you 

want to let schedule meetings for you. 

 

Web page preferences options 

  

Use this option… To… 

Home page Set the first page that appears when you access your WebEx service 

Web site. 
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Use this option… To… 

Time zone Set the time zone in which you reside. 

If you select a time zone for which daylight saving time (DST) is in 

effect, your WebEx service Web site automatically adjusts its clock for 

daylight saving time 

Note: The selected time zone appears: 

 Only on your view of your WebEx service Web site, not other 

users' views 

 In all meeting invitations that you send using your WebEx service 

Web site 

Language Set the language in which your WebEx service Web site displays text. 

Note: The languages that appear in this list are limited to the languages 

that have been set up for your Web site. 

Locale Set the format in which your Web site displays dates, times, currency 

values, and numbers. 

 

Editing your user profile 

Once you obtain a user account, you can edit your user profile at any time to change 

account login information, contact information, and other options available for your 

account. 

To edit your user profile: 

1 Log in to your WebEx service Web site. For details, see Logging in to and out of 

the WebEx service site (on page 310). 

2 On the navigation bar, click My WebEx. 

3 Click My Profile. 

4 Edit the information on the page. 

5 When you are finished editing your user profile, click Update. 

For descriptions of the information and options on the My Profile page, see About the 

My WebEx Profile page (on page 365). 
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Managing scheduling templates 
  

If you want to… See… 

get an overview of managing your scheduling 

templates 

About managing scheduling templates (on 

page 372) 

view, edit, or delete a scheduling template Managing scheduling templates (on page 

372) 

 

About managing scheduling templates 

Scheduling templates let you save the options you set for a meeting for later use. Once 

you save a scheduling template, you can use it to quickly schedule another meeting, 

instead of setting the same options again. If you saved a scheduling template using the 

Save As Template option when scheduling a meeting, you can manage the template, 

as follows: 

 View the options you set in the template. 

 Edit the options you set in the template. 

 Delete the template. 
 

Managing scheduling templates 

You can view, edit, or delete any scheduling templates that you saved. 

To manage scheduling templates: 

1 Log in to your WebEx service Web site. For details, see Logging in to and out of 

the WebEx service site (on page 310). 

2 On the navigation bar, click My WebEx. 

3 Click My Profile. 

The My Profile page appears. 

4 Under Scheduling Templates, select a template in the list. 
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Option Description 

Topic The name of the recording. You can edit the topic at any time. 

Create time The time and date the recording was created. 

Duration The length of the recording. 

Description A description of the recording. 

File size The file size of the recording. 

Create time The date and time at which the recording was created. 

Status 
The status of the recording. The possible options are Enable or 

Disable.  

Password 
Indicates whether a user must provide a password to view the 

recording. 

Stream recording link 

Clicking the link lets you play the recording (available only for 

recording files with the .arf extension that were recorded by 

NBR). 

Download recording link Clicking the link lets you download the recording. 

 

Clicking the button lets you play the recording (available only for 

recording files with the .arf extension that were recorded by 

NBR). 

If you want to download the recording, you can also click the 

link for downloading under Play Recorded a meeting Now. 
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Option Description 

 

Clicking the button opens the Share My Recording window, 

which allows you to send an email message to selected 

recipients, inviting them to play your recording. 

If you want to send the email with your local email client 

instead, click the link for using the email client under Share My 

Recording. 

 Clicking the button opens the Edit Recording page. 

 Clicking the button deletes the recording. 

 

Clicking the button disables the recording everywhere it is 

published on your WebEx Service Web site. (Available only for 

enabled recordings.) 

 

Clicking the button enables the recording everywhere it is 

published on your WebEx Service Web site. (Available only for 

disabled recordings.) 

 Clicking the button returns you to the recording list. 

 

 

Maintaining your Personal Conference number 
accounts or Cisco Unified MeetingPlace audio 
conferencing account 

  

If you want to… See… 

get an overview of maintaining your Personal 

Conference number (PCN) accounts  

About maintaining Personal Conference 

number accounts (on page 375) 

add or edit a PCN account to obtain audio 

conferencing numbers or specify access 

codes 

Adding or editing a Personal Conference 

number account (on page 376) 

use your PCN account Using your Personal Conference numbers 

(on page 380) 

delete a PCN account Deleting a Personal Conference number 
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If you want to… See… 

account (on page 381) 

get an overview of maintaining Cisco Unified 

MeetingPlace audio conferencing account 

numbers 

About maintaining Cisco Unified 

MeetingPlace audio conferencing account 

numbers (on page 375) 

reset the profile PIN for your Cisco Unified 

MeetingPlace audio conferencing account 

Resetting the password for your Cisco Unified 

MeetingPlace audio conferencing account 

number (on page 382) 

 

About maintaining Personal Conference number accounts 

If your WebEx service website includes the Personal Conferencing feature and the 

Personal Conference number option, you can create up to three Personal Conference 

number accounts. When scheduling a Personal Conference meeting, you can select a 

Personal Conference number account to use for your the audio portion of the Personal 

Conference meeting. You can also use your Personal Conference number account to 

start an instant audio conference from any phone, without scheduling it first. 

Your Personal Conference number account also specifies the access code that you 

want to use to start the audio portion of the Personal Conference meeting, and the 

access codes that you want attendees to use to join the audio portion of the Personal 

Conference meeting. 

You can delete a personal audio conferencing account at any time. 
 

About maintaining Cisco Unified MeetingPlace audio 
conferencing account numbers 

If your site includes support for Cisco Unified MeetingPlace audio conferencing, you 

should already have a Cisco Unified MeetingPlace audio conferencing account 

assigned to you. With your account, you can use Cisco Unified MeetingPlace audio in 

your meetings and in MeetingPlace Personal Conference meetings. 

Your account number includes a toll number to call as well as a Cisco Unified 

MeetingPlace profile number. For additional security, you can specify or reset a 

profile PIN that can be used to authenticate your account. You can also synchronize 

your account settings for your WebEx and Cisco Unified MeetingPlace accounts. 
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Adding or editing a Personal Conference number account 

You can add up to three Personal Conference number accounts. You can edit a 

Personal Conference number account at any time to change the following: 

 The access code that you want to use to start the audio portion of the Personal 

Conference meeting 

 The access codes that you want participants to use to join the audio portion of the 

Personal Conference meeting 

To add or edit a Personal Conference number account: 

1 Log in to your WebEx service Web website, and then select My WebEx. 

2 Select Personal Conferencing. 

The Personal Conferencing page appears. 

  

 

 

3 Select Add Account or, if you have already added an account, Select Edit by that 

account. 

The Add/Edit Personal Conference Number page appears. 
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4 Edit the information on the page. 

5 When you are finished add or editing the account, select Close. 

For descriptions of the information and options on the Personal Conferencing page, 

see the topic About the Personal Conferencing page (on page 377). 

For descriptions of the information and options on the Add/Edit Personal Conference 

Number page, see the topic About the Add/Edit Personal Conference Number page 

(on page 379). 
 

About the Personal Conferencing page 

How to access this page 

On your WebEx service Web site, click My WebEx > Personal Conferencing. 

What you can do here 

 Add, edit, or delete a Personal Conference number account. 

 View information about your existing Personal Conference number accounts. 

 If you are a MeetingPlace user, view information about your Cisco Unified 

MeetingPlace Audio Conferencing account and change your profile PIN. 
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Options on this page for Personal Conference number accounts only 

  

Option Description 

Personal Conference 

number 

Shows the numbers for your Personal Conference number accounts.  

With a Personal Conference number ccount, you can use the same 

conference numbers for all your meetings, including Personal 

Conference meetings that you schedule on your WebEx service Web 

site or that you start instantly from a phone. 

A Personal Conference number account also lets you specify the 

access codes that you want to use to start the audio portion of the 

Personal Conference meeting, and the access codes that you want 

attendees to use to join the audio portion. 

For details about the information in a Personal Conference number 

account, see About the Add/Edit Personal Conference Number page 

(on page 379). 

Account [x] Allows you to add a new Personal Conference number accounts or 

view and edit information about each of your Personal Conference 

number accounts.  

Add account: Opens the Create Personal Conference Number page, 

on which you can obtain a Personal Conference number (PCN) 

account. Appears only if you have not yet added the maximum of 

three accounts. 

Default account: Indicates that the PCN account is the default 

account that is selected when you schedule a Personal Conference 

meeting. 

Set as default: If you set up more than one PCN account, you can 

click this link to specify which account is your default account. 

Edit Opens the Edit Personal Conference Number page, on which you can 

change the access codes for your PCN account. 

For details about the information in a PCN account, see About the 

Create/Edit Personal Conference Number (on page 379). 

Delete Deletes the Personal Conference number (PCN) account from your 

user profile. 

Important: If you delete a PCN account that you have already 

selected for a scheduled a meeting, you must edit the meeting to 

select another PCN account or voice-conferencing option. 
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Options on this page for MeetingPlace users only 

  

Option Description 

Toll Number Shows the toll telephone number for your Cisco Unified MeetingPlace 

audio conferencing account. 

Cisco Unified 

MeetingPlace profile 

number 

Shows your Cisco Unified MeetingPlace audio conferencing account 

profile number. 

New profile PIN Allows you to reset your Cisco Unified MeetingPlace audio conferencing 

account profile personal identification number (PIN) in order to provide an 

additional level of security to your audio account. 

 

About the Add/Edit Personal Conference Number page 

How to access this page 

On your WebEx service website, click My WebEx > Personal Conferencing > Add 

Account or Edit. 

What you can do here 

Specify the audio conference access codes that you must provide to start the audio 

portion of a Personal Conference meeting or that attendees must provide to join the 

audio portion of a Personal Conference meeting. 

  

Use this option… To… 

Access code   Specify the the access code.: 

 Host access code: Specify the access code that you must 

enter when you start a Personal Conference meeting. This 

code must be 8 digits in length. 

 Attendee access code: Specify the access code that 

attendees must enter to join the audio portion of a Personal 

Conference meeting. This code must be 8 digits in length. 

Allow attendee to join 

before host 

Allows attendees to join a Personal Conference meeting before 

the host starts it. 
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Using your Personal Conference numbers 

Once you add a Personal Conference number account, the account information 

provides the call-in numbers and access codes that you and attendees use to 

participate in the audio portion of a Personal Conference meeting. 

To use your Personal Conference number account for a scheduled Personal 

Conference meeting: 

1 When scheduling your meeting, on the Required Information page of the 

Advanced Scheduler, select the Personal Conference meeting type. 

2 On the Audio Conference page, select a Personal Conference number account 

when setting audio conference options for the meeting. 

3 At the scheduled time, dial the call-in number for your Personal Conference 

number account. 

4 Follow the voice instructions to provide your access code. 

Each invited attendee receives an email message containing the call-in number and 

the attendee access code that you assigned to him or her. 

 
 

Controlling the audio portion of a Personal Conference 
meeting 

If you use your Personal Conference number account to start the audio portion of a 

Personal Conference meeting, you and the participants can use the following keypad 

commands: 

Host commands 

  

To… Enter… 

Dial the phone number of a participant whom you 

want to add to the audio conference 

*1 

Lock the audio conference, preventing anyone else 

from joining it 

*5 

Unlock the audio conference *5 
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To… Enter… 

Mute your microphone *6 

Unmute your microphone *6 

Let participants continue the audio conference 

without the host 

*8 

Then hang up your phone. 

Mute all attendees ## 

Unmute all attendees 99 

Play the participant count *# 

Hear all keypad commands that you can use ** 

Attendee commands 

  

To… Enter… 

Mute your microphone *6 

Unmute your microphone *6 

Play the participant count *# 

Hear all keypad commands that you can use ** 

 

 

Deleting a Personal Conference number account 

You can delete a Personal Conference number account at any time. 

To delete a Personal Conference number account: 

1 Log in to your WebEx service Web site, and then select My WebEx. 

2 Select Personal Conferencing. 

The Personal Conferencing page appears, showing your Personal Conference 

number accounts. 

3 Under the account that you want to delete, select Delete. 

A confirmation message appears. 
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4 Click OK. 
 

Resetting the profile PIN for your Cisco Unified MeetingPlace 
audio conferencing account number 

If your site includes support for Cisco Unified MeetingPlace audio conferencing, you 

should already have a Cisco Unified MeetingPlace audio conferencing account 

assigned to you. You can change the personal identification number (PIN) for your 

Cisco Unified MeetingPlace audio conferencing account. 

To add or edit a Personal Conference number account: 

1 Log in to your WebEx service Web website, and then select My WebEx. 

2 Select Personal Conferencing. 

The Personal Conferencing page appears. 

  

 

 

3 Under Change Profile PIN, in the New profile PIN and Confirm profile PIN 

boxes, type new a new personal password that contains only numbers and is 

between 5 and 24 digits in length. 

4 To synchronize your account settings for your WebEx and Cisco Unified 

MeetingPlace accounts, select Sync. 
 



 Chapter 19: Using My WebEx 

 

383 

 

Generating Reports 
  

If you want to… See… 

get an overview of what reports you can 

generate from your WebEx service Web site 

About generating reports (on page 383) 

generate usage reports that provide 

information about each session that you have 

hosted on your site 

Generating reports (on page 384) 

 

About generating reports 

If your user account includes the reports option, you can view the following reports: 

  

 Note:   

 
 For some reports, if you click on the report link within 15 minutes after the meeting 

ends, you will see a preliminary version of that report. The preliminary report provides 

quick access to data before the final, more accurate data is available. The preliminary 

report contains only a subset of the information that is available in the final report. 

 When the final, more accurate data is available, which is usually 24 hours after the 

meeting ends, the preliminary report is replaced by the final report. 

 You can download both preliminary reports and final reports as comma-separated 

values (CSV) files. 

 

General Meeting Usage reports 

These reports contains information about each online session that you host. You can 

view the following reports: 

 Summary Usage report: Contains summary information about each meeting 

including topic, date, start and end time, duration, number of attendees you 

invited, number of invited attendees who attended, and type of voice conference 

you used.  

  

 
Note: Initially, this report appears as a Preliminary Usage Summary Report, but after the 

final, more accurate usage data is available, it is replaced by the Final Usage Summary 

Report. 
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 Summary Usage report CSV (comma-separated values) file: Contains 

additional details about each meeting, including the minutes that all participants 

were connected to the meeting and tracking codes. 

 Session Detail report: Contains detailed information about each participant in a 

meeting, including the time the participant joined and left the meeting, the 

attentiveness during the meeting, and any information that the attendee provided.  

  

 
Note: Initially, this report appears as a Preliminary Session Detail Report, but after the 

final, more accurate session detail data is available, it is replaced by the Final Session Detail 

Report. 

 

Access Anywhere usage report 

This report shows information about the computers that you access remotely, 

including the date and start and end times for each session. 
 

 

Generating reports 

You can generate usage reports that provide information about each online meeting 

that you have hosted on your site. 

You can export or download the data to a comma-separated values (CSV) file which 

you can then open in a spreadsheet program such as Microsoft Excel. You can also 

print reports in a printer-friendly format. 

To generate a report: 

1 Log in to your WebEx service Web site, and then click My WebEx. 

2 Click My Reports. 

The My Reports page appears. 

3 Choose the type of report you want to generate. 

4 Specify your search criteria, such as a date range for which you want to view 

report data. 

5 Click Display Report. 

6 To change the order in which report data is sorted, click the column headings. 

The report data is sorted by the column that has an arrow next to the column 

heading. To reverse the sort order, click the column heading. To sort using 

another column, click that column's heading. 

7 Do one of the following, as appropriate: 



 Chapter 19: Using My WebEx 

 

385 

 

 If you are viewing a general meeting usage report and want to display the 

report in a format that is suitable for printing, click Printer-Friendly Format. 

8 If you are viewing the usage report for a meeting and want to view the content in 

the report, click the link for the meeting name. 

9 To export the report data in comma-separated values (CSV) format, click Export 

Report or Export. 

10 If available, click links on the report to display more details. 
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